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Document Control 

The following table describes the changes made in the document for the corresponding release versions. 

Table 1: Document Control 

Version Number Revision Date Change Log 
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section. 

• Added Appendix G: JMS Cluster Environment 

Creation section. 

• Update to the Configuration Admin Menu:  
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batch. For more information, see ISO20022 

Configuration Admin Menu. 

8.0.8.1.12 

 

May 2021 • BIC is replaced with Identifier Screening field in the 

Subfield Level Configuration Window. 

• A new Audit User and Transaction Filtering Audit 

Group is added. For more information, see Mapping a 

User with a User Group. 

• Added JMS Correlation ID section. 

8.0.8.1.10 

 

April 2021 • New screens for cut-off and SLA in the Transaction 

Filtering Admin menu. For more information, see 

General Configurations.  

• New email templates for SLAs. For more information, 

see Generating Email for Different Statuses. 

8.0.8.1.5 December 2020 • Configurations steps to automatically release 

transactions: 

▪ Steps to configure transactions for the Auto 

Release status. For information on the steps, 

see Configurations to Automatically Release 

Transactions. 
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Version Number Revision Date Change Log 
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Parameters. 
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Message Parameters. 

▪ US NACHA message category. For more 

information on the configurations you can 

do, see Configurations for the US NACHA 

Batch Process. 

• Updates to the SWIFT Message Category: 

▪ A sequence shows the order of the fields in a 

message. For more information on how to 

repeat a sequence, see Repeating Sequences. 

▪ You can now add custom message types 

which are UTF-8 enabled. For more 

information on how to add a custom format, 

see Message Type Configuration Window. 

• New Message Types: 

▪ Message Types describe the structure of a 

message. For more information on the 

message types available, see Appendix F: 

Message Categories and Message Types. 

• Version Control: 

▪ Version control allows you to view the 

changes between two files. For more 

information on version control for SWIFT, 

ISO20022, and EDQ, see Version Control. 
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1 About This Guide 

This guide provides comprehensive instructions for system administration and the daily operations and 

maintenance of Oracle Financial Services Transaction Filtering. The logical architecture provides details of 

the Transaction Filtering process for a better understanding of the pre-configured application, which 

allows you to make site-specific enhancements using OFSAAI. 

1.1 Intended Audience 

This Administration Guide is designed for use by the Implementation Consultants and System 

Administrators. Their roles and responsibilities, as they operate within Oracle Financial Services 

Transaction Filtering, include the following: 

• Implementation Consultant: Installs and configures Oracle Financial Services Transaction Filtering 

at a specific deployment site. The Implementation Consultant also installs and upgrades any 

additional Oracle Financial Services solution sets and requires access to deployment-specific 

configuration information (For example, machine names and port numbers). 

• System Administrator: Configures, maintains, and adjusts the system, and is usually an employee 

of a specific Oracle customer. The System Administrator maintains user accounts and roles, 

configures the EDQ, archives data, loads data feeds, and performs post-processing tasks. 

1.2 Access to Oracle Support 

Oracle customers have access to electronic support through My Oracle Support (MOS). For 

information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info 

Or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing-impaired. 

1.3 How This Guide is Organized 

The Oracle Financial Services Transaction Filtering Administration Guide includes the following chapters: 

• About Oracle Financial Services Transaction Filtering provides a brief overview of the Oracle 

Financial Services Transaction Filtering application. 

• Getting Started explains common elements of the interface, includes instructions on how to 

configure your system, access Transaction Filtering, and exit the application. 

• Managing User Administration explains the user administration of the Oracle Financial Services 

(OFS) Transaction Filtering application. 

• General Configurations describes how to configure the SWIFT (Society for Worldwide Interbank 

Financial Telecommunication) message and screening parameters, run the migration utility, run the 

Purge utility, and do Version Control for messages in the Oracle Financial Services Transaction 

Filtering application. 

• Configuring the SWIFT Message Parameters describes how to configure the SWIFT message 

parameters. 

https://support.oracle.com/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.fcc.gov/consumers/guides/telecommunications-relay-service-trs
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• Configuring the Fedwire Message Parameters describes how to configure the Fedwire message 

parameters. 

• Configurations for the ISO20022 Message Parameters describe how to configure the ISO20022 

message parameters and run the ISO20022 batch. 

• Configurations for the US NACHA Batch Process describes how to configure the US NACHA batch. 

• Enterprise Data Quality (EDQ) Configurations describes how to configure the EDQ parameters. 

• Configuring Risk Scoring Rules describes how to configure business rules in the Inline Processing 

Engine (IPE). 

• Creating a JSON describes how to create a JavaScript Object Notation (JSON) for SWIFT messages 

with sequences and SWIFT messages without sequences. 

• Appendix A: Watch Lists explains the details of each of the pre-configured watch lists that can be 

used by Oracle Transaction Filtering. 

• Appendix B: System Audit Logging Information contains information on the logs related to the 

Debug and Info log files. 

• Appendix C: Process Modeller Framework (PMF) Configurability describes how to configure the 

Process Monitor Facility (PMF) workflow. 

• Appendix D: Time Zone Configuration describes how to set the time zone for a user. 

• Appendix E: Delta Watch List Configurations describes how to run and download the delta updates. 

• Appendix F: Message Categories and Message Types shows the different message types available 

for the SWIFT, Fedwire, ISO 20022, and US NACHA message types. 

1.4 What's New in This Release 

You can use the following new features: 

1.4.1 Performance Improvements for EDQ 

• Added recommendations to improve performance in the EDQ server in the EDQ Configurations 

chapter. 

1.4.2 For 8.0.8.1.1 

• Updated the screens in the Transaction Filtering Admin menu. 

• Added a section for SLA in the Transaction Filtering Admin menu.  

• Added the new email templates in the Tasks Emails section. 

1.4.3 For 8.0.8.1.5 

• Updated the steps to configure transactions for the Auto Release status. 

1.4.4 For 8.0.8.1.0 

• Updated the steps to configure full and delta watch list data for the Dow Jones watch list. 
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• Added the message types for US NACHA and Fedwire in the Message Categories and Message 

Types appendix. 

• Added a section for configuring Fedwire message parameters in the Configuring the Fedwire 

Message Parameters chapter. 

• Added the message types for SWIFT in the Message Categories and Message Types appendix. 

• Added values to be updated for the V_ATTRIBUTE_VALUE1 value in the Configuring the Host Port 

and Context Name section in the General Configurations chapter. 

• Added the message types for ISO20022 in the Message Categories and Message Types appendix. 

• Added information on the transaction-screening.properties and transaction-

screening-batch.properties files in the Transaction Screening Setup section in the Enterprise 

Data Quality (EDQ) chapter. 

• Added a section, Version Control, in the General Configurations chapter.  

• Added a section on how to assign a message automatically to a user in the General Configurations 

chapter. 

• Added a section for setting the message cut-off time in the General Configurations chapter. 

• Added a section for setting the priority for a message category in the General Configurations 

chapter. 

• Added a chapter for configuring ISO20022 message parameters. 

• Updated steps for running the SWIFT migration utility in the General Configurations chapter. 

• Added information for the 3xx, 5xx, and 6xx Message Types section in the Creating a JSON chapter. 

• Added information on how to create custom message types that support UTF-8 characters in the 

Configuring the SWIFT Message Parameters chapter. 

• Added a note to explain how to repeat sequences in the Adding or Updating a New Message Type 

section in the Configuring the SWIFT Message Parameters chapter. 

• Updated the description for the Generic Business Data field to include information for the new 

sequences added in the Configuring the SWIFT Message Parameters chapter. 

• Added information for the Jurisdiction field in the Message and Screening Configurations window 

in the Configuring the SWIFT Message Parameters chapter. 

1.4.5 For 8.0.8.0.0 

• Added an Appendix, Time Zone Configuration, which contains information on the time zone 

configurations required for each country. 

1.5 Where to Find More Information 

For more information about Oracle Financial Services Transaction Filtering, see the following Transaction 

Filtering application documents, which can be found on the Oracle Help Center page: 

• User Guide 

• Installation and Configuration Guide 

https://docs.oracle.com/cd/E91256_01/tf.htm
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• Matching Guide 

• Reporting Guide 

To find additional information about how Oracle Financial Services solves real business problems, see our 

website at Oracle for Financial Services home page. 

1.6 Conventions Used in this Guide 

The following table mentions the conventions used in this guide. 

Table 2: Conventions Used 

Conventions Meaning 

Italics • Names of books as references 

• Emphasis 

• Substitute input values 

Bold • Menu names, field names, options, button names 

• Commands typed at a prompt 

• User input 

Monospace • Directories and subdirectories 

• File names and extensions 

• Code sample, including keywords and variables within text and as separate 

paragraphs, and user-defined program elements within text 

Hyperlink Hyperlink type indicates the links to external websites, internal document links to 

sections. 

Asterisk (*) Mandatory fields in User Interface 

<Variable> Substitute input value 

https://www.oracle.com/industries/financial-services/
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2 About Oracle Financial Services Transaction 
Filtering 

Oracle Financial Services Transaction Filtering is a Sanctions screening system that identifies Individuals, 

entities, cities, countries, goods, ports, BICs, and Stop keywords that may either be suspicious, restricted, 

or sanctioned with relation to a financial transaction that is processed through the Transaction Filtering 

application. The application enables you to integrate with any clearing or payment system, accept 

messages from the source system, and scans them against different watch lists maintained within the 

application to identify any suspicious data present within the message. The Transaction Filtering 

application can scan messages which are in the SWIFT, ISO20022, Fedwire, or NACHA category, or any 

custom format. 

The OFS Transaction Filtering application is built using components of the Oracle Financial Services 

Analytical Applications (OFSAA) product suite. These components are Oracle Enterprise Data Quality 

(OEDQ) and Inline Processing Engine (IPE). 

Financial Institutions are required to comply with regulations from different authorities. Some of them are 

as follows: 

• USA PATRIOT Act 

• U.S. Treasury's Office of Foreign Assets Control (OFAC), USA 

• Office of the Superintendent of Financial Institutions (OSFI), Canada 

• Financial Action Task Force (on Money Laundering) (FATF/GAFI) 

• EU Commission 

• Country-specific authorities 

While the regulations can differ between countries, the spirit of regulatory intervention is uniform, and 

that is to hold financial institutions responsible and accountable if they have been a party, intentionally or 

unintentionally, to a criminal or terrorist-related transaction. 

Sanctions include the withholding of diplomatic recognition, the boycotting of athletic and cultural events, 

and the sequestering of the property of citizens of the sanctioned country. However, the forms of 

sanctions that attract the most attention and are likely to have the greatest impact are composed of 

various restrictions on international trade, financial flows, or the movement of people. 

Transaction Filtering against government-regulated watch lists and internal watch lists is a key compliance 

requirement for financial institutions across the globe. At the turn of the century, Financial Institutions 

(FIs) were expected to identify customers who were either sanctioned or who lived in sanctioned countries 

and identify any transactions which were associated with these customers. FIs are now expected to also 

identify any suspicious dealings and parties involved in the transaction, and more recently identify 

information that is deliberately hidden or removed.  

The Transaction Filtering application delivers a strong, effective filter that identifies all sanctioned 

individuals or entities with true positives and exploits all available information (internal and external) to 

reduce false positives and therefore minimizes the operational impact on FIs. 

2.1 Transaction Filtering Workflow 

The following image describes the Transaction Filtering workflow. 
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Figure 1: Transaction Filtering Workflow 

 

 

The application first receives a message from the payment system and scans it against the watch lists, 

then provides a risk score for the message. If no suspicious data is found during screening, then the 

Transaction Filtering application sends a feedback message with the status CLEAN back to the payment 

system through the message queue. If suspicious data is found during screening, then the message is 

sent to an Analyst who investigates it using the Transaction Filtering User Interface. Feedback is sent to 

the payment system through a message queue, which indicates that the message is on hold. The Analyst 

reviews the message, which is the first level of review and decides to release, block, or escalate the 

message. Based on the decision, the system sends a feedback message, either CLEAN or BLOCKED, to the 

payment system for the reviewed message. 

If the four-eyes workflow is enabled, then the Analyst can additionally Recommend to Release, 

Recommend to Block, or escalate the message to the Supervisor. If the Analyst escalates the message, 

then the message is sent to the Supervisor, which is the second level of review. The Supervisor can block 

or release the message and add comments. For a four-eyes workflow, the Supervisor can Release, Block, 

or Reject the message. You can view the associated matched data of a message from the Match Summary 

section. You can also view the risk score details from the Risk Summary section. Both these sections are 

present in the Investigation User Interface. 



GETTING STARTED 

ACCESSING THE ORACLE FINANCIAL SERVICES ANALYTICAL APPLICATIONS (OFSAA) PAGE 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  19 

3 Getting Started 

This chapter provides step-by-step instructions to log in to the Transaction Filtering System and different 

features of the Oracle Financial Services Analytical Applications (OFSAA) Application page. 

3.1 Accessing the Oracle Financial Services Analytical 
Applications (OFSAA) Page 

Access to the Oracle Financial Services Transaction Filtering application depends on the Internet or 

Intranet environment. The system administrator provides the intranet address uniform resource locator 

(URL), User ID, and Password. 

 

NOTE After the first login, you will be prompted to change your 
password. 

 

To access the Oracle Financial Services Analytical Applications page, follow these steps: 

1. Enter the URL into your browser using the following format: 

<scheme/ protocol>://<ip address/ hostname>:<port>/<context-

name>/login.jsp  

For example: https://myserver:9080/ofsaaapp/login.jsp 

The Oracle Financial Services Analytical Applications login page is displayed. 

Figure 2: Oracle Financial Services Analytical Applications Login Page 

 
 

2. Select the language from the Language drop-down list. This allows you to use the application in the 

language of your selection.  

3. Enter your User ID and Password in the respective fields. 

https://myserver:9080/ofsaaapp/login.jsp
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4. Click Login. The Financial Services Analytical Applications Transactions Filtering landing page 

is displayed. 

Figure 3: Financial Services Analytical Applications Transactions Filtering Landing Page 

 
 

To view the Financial Services Analytical Applications Transactions Filtering landing page, click 

Calendar . 

3.2 Managing the Oracle Financial Services Analytical 
Applications (OFSAA) Page 

From the Oracle Financial Services Analytical Applications page, you can access the menus for the 

different message configurations. You can change the default transaction currency from USD to another 

currency in the Process Modeller page and view the Good Guy Summary page, which has details related 

to the records added in the good guy list. 

3.2.1 Transaction Filtering Admin Menu 

The Transaction Filtering Admin menu allows the system administrator to configure the application-

level parameters, good guy matching parameters, the cut-off time for messages, and assignment type for 

a message (manual or automatic). For more information, see General Configurations. 

To view the menu, follow these steps: 

1. Click Financial Services Sanctions Pack. 
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Figure 4: Financial Services Sanctions Pack Menu 

 
 

2. Click Transaction Filtering Admin. The Configuration Screen displays. 

Figure 5: Transaction Filtering Admin Sub-menu 

 
 

3.2.2 ISO20022 Configuration Admin Menu 

The ISO20022/XML Configuration Admin menu allows the system administrator to configure the 

ISO20022 parser parameters. For more information, see Configurations for the ISO20022 Message 

Parameters. The same configurations are used for the Real Time and Batch. 

To view the menu, follow these steps: 

1. Click Financial Services Sanctions Pack. 
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Figure 6: Financial Services Sanctions Pack Menu 

 
 

2. Click ISO20022/XML Configuration Admin. The Configuration Screen displays. 

Figure 7: ISO20022/XML Configuration Admin Sub-menu 

 
 

3.2.3 SWIFT Configuration Admin Menu 

The SWIFT Configuration Admin menu allows the system administrator to configure the SWIFT parser 

parameters. For more information, see General Configurations. 

To view the menu, follow these steps: 

1. Click Financial Services Sanctions Pack. 
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Figure 8: Financial Services Sanctions Pack Menu 

 
 

2. Click SWIFT Configuration Admin. The Configuration Screen displays. 

Figure 9: SWIFT Configuration Admin Sub-menu 

 
 

3.2.4 Process Modeller Menu 

The Process Modeller menu allows the System Administrator to provide the security and operational 

framework required for the Infrastructure. 

You can view the PMF process flow for the standard, four-eyes, and good guy workflows. For more 

information on the workflows, see the Transaction Filtering WorkFlows section in the Oracle Financial 

Services Transaction Filtering User Guide.  

To view the ready-to-use PMF flows, click Process Modeller. The Process Modeller page is displayed. 

https://docs.oracle.com/cd/E91256_01/tf.htm
https://docs.oracle.com/cd/E91256_01/tf.htm
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Figure 10: Process Modeller Page 

 
 

To expand the window, click Navigation Menu . 

3.2.4.1 Configuring the Transaction Currency 

You can change the default transaction currency (USD) to another currency. To configure the currency, 

follow these steps: 

1. On the Process Modeller page, click the Application Rule subtab. 
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Figure 11: Application Rule Subtab 

 
 

2. To change the currency for a released transaction, select R_to_Release_Outcome. To change the 

currency for a blocked transaction, select R_to_Block_Outcome. 

3. Click Edit. 

4. Click inside the TF_Currency drop-down list and select the required currency. 

5. Click Save. 

3.2.5 FEDWIRE Configuration Admin Menu 

The FEDWIRE Configuration Admin menu allows the system administrator to configure the Fedwire 

parser parameters. For more information, see General Configurations. 

To view the menu, follow these steps: 

1. Click Financial Services Sanctions Pack. 
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Figure 12: Financial Services Sanctions Pack Menu 

 
 

2. Click FEDWIRE Configuration Admin. The Configuration Screen is displayed. 

Figure 13: FEDWIRE Configuration Admin Sub-menu 

 
 

3.2.6 Process Monitor Menu 

The Process Monitor menu allows the System Administrator to configure the workflow for a process. To 

do this, click Process Monitor. The Process Monitor page is displayed. 



GETTING STARTED 

MANAGING THE ORACLE FINANCIAL SERVICES ANALYTICAL APPLICATIONS (OFSAA) PAGE 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  27 

Figure 14: Process Monitor Menu Page 

 
 

To expand the window, click Navigation Menu . 

3.2.7 Run Definition Menu 

The Run Definition menu allows the system administrator to run the batches for the message categories.  

To run the batches, follow these steps: 

1. Click Financial Services Sanctions Pack. 



GETTING STARTED 

MANAGING THE ORACLE FINANCIAL SERVICES ANALYTICAL APPLICATIONS (OFSAA) PAGE 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  28 

Figure 15: Financial Services Sanctions Pack Menu 

 
 

2. Click Run Definition. The Run page is displayed. 

Figure 16: Transaction Filtering Admin Sub-menu 

 
 

3.2.8 List Management Menu 

The List Management menu allows the system administrator to view the Good Guy Summary page. For 

more information on the Good Guy Summary page, see the Good Guy Summary section in the Oracle 

Financial Services Transaction Filtering User Guide. 

To view the page, follow these steps: 

1. Click Financial Services Sanctions Pack. 

https://docs.oracle.com/cd/E91256_01/tf.htm
https://docs.oracle.com/cd/E91256_01/tf.htm
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Figure 17: Financial Services Sanctions Pack Menu 

 
 

2. Click List Management. The Good Guy Summary page is displayed. 

Figure 18: List Management Sub-menu 

 
 

3.2.9 Inline Processing Menu 

The Inline Processing menu allows the System Administrator to view and configure the details related to 

Inline Processing Engine (IPE). For more information, see Configuring Risk Scoring Rules. 

To view the Inline Processing page, follow these steps: 

1. Click Financial Services Sanctions Pack. 
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Figure 19: Financial Services Sanctions Pack Menu 

 
 

2. Click Inline Processing. The Inline Processing page is displayed. 

Figure 20: Inline Processing Sub-menu 

 
 

3.3 Troubleshooting Your Display 

If you experience problems logging into Oracle Financial Services Transaction Filtering or with your 

display, the browser settings may be incompatible with running OFSAA applications. The following 

sections provide instructions for setting your Web display options for OFSAA applications 

3.3.1 Enabling JavaScript 

This section describes how to enable JavaScript.  
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To enable JavaScript, follow these steps: 

1. Navigate to the Tools menu. 

2. Click Internet Options. The Internet Options dialog box is displayed. 

3. Click the Security tab and then click Local Intranet. 

4. Click Custom Level. The Security Settings dialog box is displayed. 

5. In the Settings list and under the Scripting setting, select all options. 

6. Click OK, then click OK again to exit the Internet Options dialog box. 

3.3.2 Enabling Cookies 

Cookies must be enabled. If you have problems troubleshooting your display, contact your System 

Administrator. 

3.3.3 Enabling Temporary Internet Files 

Temporary Internet files are pages that you view on the Internet and store in a folder for quick viewing 

later. You must adjust this setting to always check for new versions of a stored page.  

To adjust your Temporary Internet File settings, follow these steps: 

1. Navigate to the Tools menu. 

2. Click Internet Options. The Internet Options dialog box is displayed. 

3. On the General tab, click Settings. The Settings dialog box is displayed. 

4. Click Every visit to the page. 

5. Click OK, then click OK again to exit the Internet Options dialog box. 

3.3.4 Enabling File Downloads 

This section describes how to enable file downloads. 

To enable file downloads, follow these steps: 

1. Navigate to the Tools menu. 

2. Click Internet Options. The Internet Options dialog box is displayed. 

3. Click the Security tab and then click Local Intranet. 

4. Click Custom Level. The Security Settings dialog box is displayed. 

5. Under the Downloads section, ensure that Enable is selected for all options. 

6. Click OK, then click OK again to exit the Internet Options dialog box. 

3.3.5 Setting Printing Options 

This section explains how to enable printing background colors and images.  

To enable this option, follow these steps:  
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1. Navigate to the Tools menu. 

2. Click Internet Options. The Internet Options dialog box is displayed. 

3. Click the Advanced tab. In the Settings list. 

4. Under the Printing setting, click Print background colors and images. 

5. Click OK to exit the Internet Options dialog box. 

 

NOTE For best display results, use the default font settings in your 
browser. 

 

3.3.6 Enabling the Pop-Up Blocker 

You may have trouble running the Oracle Financial Services Transaction Filtering application when the IE 

Pop-up Blocker is enabled. It is recommended to add the URL of the application to the Allowed Sites in 

the Pop-up Blocker Settings in the IE Internet Options menu. 

To enable the Pop-up Blocker, follow these steps: 

1. Navigate to the Tools menu. 

2. Click Internet Options. The Internet Options dialog box is displayed. 

3. Click the Privacy tab. In the Pop-up Blocker setting, select Turn on Pop-up Blocker. The Settings 

are enabled. 

4. Click Settings to open the Pop-up Blocker Settings dialog box. 

5. In the Pop-up Blocker Settings dialog box, enter the URL of the application in the text area. 

6. Click Add. The URL appears in the Allowed Sites list. 

7. Click Close, then click Apply to save the settings. 

8. Click OK to exit the Internet Options dialog box. 

3.3.7 Setting Preferences 

Use the Preferences section to enable you to set your OFSAA home page.  

To access this section, follow these steps: 

1. In the Financial Services Analytical Applications Transactions Filtering landing page, select 

Preferences from the user name drop-down list. The Preferences page is displayed. 

Figure 21: Preferences Page 
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2. In the Set My Home Page drop-down list, select the window that you want to view when you log in. 

When a new application is installed, the related window for that application is found in the drop-

down list. 

3. In the Date Format drop-down list, select the date format that you want to see. The options 

available are dd/MM/yyyy or M/dd/yyyy. 

4. Click Save to save your preferences. 
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4 Managing User Administration 

This chapter provides instructions for performing the user administration of Oracle Financial Services 

(OFS) Transaction Filtering. 

4.1 About User Administration 

User administration involves creating and managing users and providing access rights based on their 

roles. This section discusses the following: 

• Administrator permissions 

• Creating roles and granting and authorizing a user 

4.2 Managing User Administration 

The following sections provide information on how to create and authorize a user and map the users to 

user groups in the Transaction Filtering application. 

The following table lists the various actions and associated descriptions of the user administration process 

flow: 

Table 3: User Administration 

Action Description 

Creating and Authorizing a User Create a user. This involves providing a user name, user designation, and 

the dates between which the user is active in the system. 

Mapping a User with a User Group Map a user to a user group. This enables the user to have certain privileges 

that the mapped user group has. 

 

4.2.1.1 Creating and Authorizing a User 

The sysadmn user creates a user and the sysauth user authorizes a user in the Transaction Filtering 

application. For more information on creating and authorizing a user, see the Oracle Financial Services 

Analytical Applications Infrastructure User Guide. 

4.2.1.2 Mapping a User with a User Group 

This section explains how to map Users and User Groups. The user has access to privileges as per the role. 

The sysadm user maps a user to a user group in the Transaction Filtering application. The following table 

describes the predefined User Roles and corresponding User Groups.  

Table 4: User Group-Role Mapping 

Role Group Name  User Group Code 

Administrator Transaction Filtering Analyst Group TFLTADMINISTATORGRP 

Analyst  Transaction Filtering Supervisor Group TFLTANALYSTGRP 

https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
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Role Group Name  User Group Code 

Supervisor Transaction Filtering Administrator Group TFLTSUPERVISORGRP 

Audit Transaction Filtering Audit Group TFAUDITGRP 

 

For each role, you can configure the time zones that apply to them. For information on the time zone 

values, see Time Zone Configuration.  



GENERAL CONFIGURATIONS 

CONFIGURING THE APPLICATION LEVEL PARAMETERS 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  36 

5 General Configurations 

The following sections provide information on how to configure the application and message and 

screening parameters, configure the transaction workflow to accommodate the four-eyes principle and 

the good guy component, define the cut-off time for the message workflow (including investigations), set 

a priority for a message category, define the assignment type for messages (manual or automatic), define 

the SLAs and cut-off times for alerts, run the purge and migration utilities, add a good guy record, view 

the different emails generated based on the transaction status, segregate the alerts based on jurisdictions 

and business domains, and do version control for SWIFT messages, ISO20022 messages, and IPE. 

5.1 Configuring the Application Level Parameters 

Use the Application Level Parameter Configuration tab to configure the parameters for the Transaction 

Filtering application, such as enabling or disabling the four-eyes workflow, define the parameters that 

must be matched during the good guy workflow, define the cut-off time required to complete the entire 

transaction workflow, and assign messages manually or automatically. 

To configure the parameters, follow these steps: 

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. 

2. Click Transaction Filtering Admin. The Application Level Parameter Configuration is displayed. 

Figure 22: Application Level Parameter Configuration Tab 

 

 

3. In the Audit section, select Yes to view the Debug details or select No to view the Info details. 

If you select Yes, then all the steps are logged in the system irrespective of the value in the Status 

column. If you select No, then only those steps for which the value is Y in the Status column are 

logged in the system. 

 

NOTE For more information on the values in the Status column, see 
System Audit Logging Information. 
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4. In the 4 Eyes section, select Yes to enable the four-eyes workflow and select No to disable the four-

eyes workflow.  

5. In the EDQ section, provide the following values: 

▪ EDQ URL in the following format: 

<http>: <Hostname of the server in which EDQ is installed>: Port Number 

▪ EDQ user name: The default username is displayed. You can update the username if 

required. 

▪ EDQ password: The default password is displayed. You can update the password if 

required. 

▪ EDQ webservice status username 

▪ EDQ webservice status password 

6. In the FEEDBACK section, enter the URL where we need to post messages for HOLD, RELEASE, 

CLEAN, BLOCK in the feedback queue in the FEEDBACK URL field. 

7. In the UI section, provide the time period after which the system refreshes the notification (false 

positive) count in the Transaction Filtering window. 

 

NOTE • The time period is in milliseconds. 

• The notification count is reset to zero every day at 
midnight. 

 

8. Click Save. The following confirmation message is displayed: Records Updated Successfully. 

5.2 Configuring the Good Guy Matching Parameters   

The parameters shown here are applicable only when the good guy workflow is enabled. The Transaction 

Filtering application checks if there is a match or not for every parameter which is enabled, and if there is a 

match, the record is added to the good guy list. For more information on the good guy workflow, see the 

Managing Transaction Filtering chapter in the Oracle Financial Services Transaction Filtering User 

Guide. 

To enable or disable the good guy parameters, follow these steps: 

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. 

2. Click Transaction Filtering Admin and then click the Good Guy Matching Configuration tab. 

https://docs.oracle.com/cd/E91256_01/tf.htm
https://docs.oracle.com/cd/E91256_01/tf.htm
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Figure 23: Good Guy Matching Configuration Tab 

 
 

The record name must be matched, so it is mandatory to set the value in the Record Name to Yes. If you 

do not set it to Yes, an error message, “The record name should be set as Yes mandatorily.” is 

displayed. 

5.3 Configuring the SLA Parameters 

Banks or FIs want alerts to be closed within a specified time in order to settle payments within a specified 

date. The specified time is cut-off time defined for the alert from the time the Analyst starts working on 

the alert till the time the alert is closed, and the specified date is the SLA defined for the alert from the time 

the alert is created or reopened. You must define the cut-off time and SLA. 

Use the SLA Configuration window to define an SLA for a combination of message category, message 

type, currency, jurisdiction, business domain, message direction, transaction amount range, and message 

priority.  

 

NOTE The SLA time must be defined in HH:MM:SS format. 

 

You can set an automatic action to be taken by the system if the alert is not investigated within the 

defined SLA using the Auto Action Parameter field (this is an optional step). For example, if you select 

Escalate, then the alert is escalated to the Supervisor after the SLA time is passed. You can also set a 

notification to be sent for overdue alerts as soon as the cut-off time is passed for an alert to any user role, 

for example, to a supervisor. For more information, see the Generating Email for Different Statuses 

section. 

To set the SLA time, follow these steps: 

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. 

2. Click Transaction Filtering Admin and then click the SLA Configuration tab. 

 



GENERAL CONFIGURATIONS 

CONFIGURING THE SLA PARAMETERS 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  39 

Figure 24: SLA Configuration Tab 

 
 

3. Enter the SLA time in HH:MM:SS format.  

4. Select an automatic action for an alert that is overdue. You can do one of the following: 

▪ Recommend to block the transaction 

▪ Block the transaction 

▪ Recommend to release the transaction 

▪ Release the transaction 

▪ Escalate the transaction 

5. Select Yes to enable a specific combination, else select No. 

6. To create a combination, use the following conditions. This is an optional step. 

▪ Message Category: Select the message category used for the transaction. You can also 

select Any to indicate that regardless of the message category, the SLA time is enabled for 

the combination. If you select Any, you cannot select a message type. 

▪ Message Types: Select a message type for the message category. You can also select All to 

indicate that the SLA time is enabled for all message types. 

▪ Currency: Enter the ISO currency code of the currency used for the transaction. 

▪ Jurisdiction: Select the jurisdiction/geography if the defined SLA time must apply to only 

this jurisdiction. You can also select All to select all jurisdictions/geographies. 

▪ Business Domain: Select the business domain if the defined SLA time must apply to only 

this business domain. You can also select All to select all business domains. 

▪ Message Direction: Select INBOUND for transactions that are coming into your account 

and select OUTBOUND for transactions that are going out of your account. You can also 

select Any to select any message direction. 

▪ Amount: Select the amount range used in the transaction. 

▪ Priority: Set a specific alert priority or select Any to indicate that the alert can have any 

priority. 

After you select the values in the required fields, you can do the following: 
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Table 5: General Actions 

To... Do this... 

Add a configuration Click Add. The values appear in a tabular format. 

Update a configuration Select the configuration you want to update, update the value of one or 

more fields, and click Update. The updated value is displayed in the 

table. 

Remove a configuration Select the configuration you want to remove and click Remove. The 

selected configuration is removed from the table. 

Clear the values of some of 

the fields in a configuration 

Click Clear. You can only clear the values of the Cut-Off Time, Currency, 

and Amount fields. 

Enable all configurations Click Enable All. 

Disable all configurations Click Disable All. 

 

NOTE After you remove a configuration, you must restart all web 
services.  

 

5.4 Automatic Assignments of Alerts 

The Transaction Filtering application provides two options for assigning alerts: 

• Manual assignment: Here the user must manually assign alerts one by one using the lock button in 

the Investigation Use Interface.  

When you manually assign an alert, then all alerts which belong to the selected 

jurisdiction/business domain are displayed. You can manually assign an alert if, for example, the 

Analyst to whom the alert is assigned is on leave. In this case, the Supervisor moves the status of 

the alert from ASSIGNED to HOLD in the Investigation User Interface. The Analyst can self-assign 

the alert using the lock/unlock feature. For more information on the Investigation User Interface, 

see the Managing Transaction Filtering chapter in the Oracle Financial Services Transaction 

Filtering User Guide. 

• Automatic assignment: Alerts are automatically assigned to the selected user role and respective 

user IDs. When you auto-assign an alert, the alert is automatically assigned to all users who belong 

to the selected role. You can use two options: load balancing or load balancing along with specific 

criteria, to assign the alert. 

 

NOTE • The Transaction Filtering application assigns all new 
alerts to the Analyst by default. 

• Alerts cannot be assigned to a user who is mapped to 
the Admin role. 

 

 

https://docs.oracle.com/cd/E91256_01/tf.htm
https://docs.oracle.com/cd/E91256_01/tf.htm
https://docs.oracle.com/cd/E91256_01/tf.htm
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NOTE You cannot change the mode of assignment from automatic to 
manual for an alert that is already assigned. You can only 
select a mode of assignment for new alerts. 

 

To configure an alert to be assigned manually or automatically, follow these steps: 

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. 

2. Click Transaction Filtering Admin and then click the Auto Assignment Configuration tab. 

3. Select Automatic to auto-assign the alert to the selected role. Select Manual to manually assign an 

alert to the selected user. 

If you select Automatic, you can choose between Based On Load Balancing to select a user role or 

Custom Criteria With Combination Of Load Balancing to select a user role along with the 

following conditions.  

If you select Based On Load Balancing, all users who belong to the role are assigned the alert and 

the maximum capacity for each user role must be defined.  

 

Figure 25: Auto Assignment Configuration Tab with Based on Load Balancing Selection 

 
 

If you select Custom Criteria With Combination Of Load Balancing, you can select a user role and 

a specific combination of conditions. The system then applies load balancing along with these 

conditions, while also applying the maximum capacity defined for the users. 
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 Figure 26: Auto Assignment Configuration Tab with Custom Criteria with Combination of Load 

Balancing Selected 

 
 

The following conditions must be defined: 

▪ User Role: Select the role to whom you want to automatically assign alerts. When you select 

the role, all users who belong to that role are displayed in the User ID field. You can assign 

an alert to any user except the Admin user. 

▪ User ID: Select the user to whom you want to automatically assign alerts. 

▪ Jurisdiction: Select the jurisdiction applicable to the combination, or select All to indicate 

that for all jurisdictions, the alert auto-assignment is enabled for the combination. 

▪ Business Domain: Select the business domain applicable to the combination or select All. 

▪ Max Capacity: Select the maximum number of alerts that can be investigated by the 

selected user. 

▪ Enable Flag: Select Yes to enable the combination. 

The following additional fields can be used to create a combination when you select Custom 

Criteria With Combination Of Load Balancing: 

▪ Message Category: Select the message category used for the combination or select Any to 

indicate that regardless of the message category, the alert auto-assignment is enabled for 

the combination. 

▪ Message Types: Select a message type for the message category or select None. 

▪ Match Score: Select the match score range. If the match score is between this range, then 

the alert is assigned to the selected user based on the configuration. 

▪ Priority: Set the message priority or select Any. 

▪ Currency: Enter the ISO currency code of the currency used during the transaction. 

▪ Amount: Select the amount range used in the transaction. 

After you select the values in the required fields, you can do the following: 
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Table 6: General Actions 

To... Do this... 

Add a configuration Click Add. The values appear in a tabular format. 

Update a configuration Select the configuration you want to update, update the value of one or 

more fields, and click Update. The updated value is displayed in the 

table. 

Remove a configuration Select the configuration you want to remove and click Remove. The 

selected configuration is removed from the table. 

Clear the values of some of 

the fields in a configuration 

Click Clear. You can only clear the values of the Currency and 

Amount fields. 

Enable all configurations Click Enable All. 

Disable all configurations Click Disable All. 

 

5.5 Configuring the Cut-Off Parameters for Alerts 

Banks or FIs want alerts to be closed within a specified time in order to settle payments within a specified 

date. The specified time is cut-off time defined for the alert from the time the Analyst starts working on 

the alert till the time the alert is closed, and the specified date is the SLA defined for the alert from the time 

the alert is created or reopened. You must define the cut-off time and SLA. 

Use the Cut-Off Configuration window to set a cut-off time for the investigator to complete the alert 

investigation. You can either set a single cut-off time for all alerts or set different cut-off times for each 

alert based on multiple conditions such as message category, message type, jurisdiction, business 

domain, currency, amount range, message priority, and message direction.  

 

NOTE The cut-off time must be defined in HH:MM:SS format and will 
be based on your locale.  

 

To set a single cut-off time for all alerts, define the cut-off time in the Cut-Off Time field and then select 

Any in the condition fields which have drop-down values. Do not enter a value in the Currency and 

Amount fields. 

To set different cut-off times based on specific values, define the cut-off time in the Cut-Off Time field 

and then select one or more values in the condition fields. Here, you can enter a value in the Currency and 

Amount fields. For more information, see step 6. 

 

NOTE If you set different cut-off times, ensure that you define the 
conditions in such a way that the cut-off time defined for a 
specific set of conditions does not overwrite the cut-off time 
defined for another set of conditions.  
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When the cut-off time is set for an alert, the alert displays the time in green in the Investigation User 

Interface until the cut-off time is passed. After the cut-off time is passed, that is, the alert becomes 

overdue and is not investigated within the defined cut-off time, then the alert displays the time in red in 

the Investigation User Interface. For information on the Investigation User Interface, see the Oracle 

Financial Services Transaction Filtering User Guide. 

You can set an automatic action to be taken by the system if the alert is not investigated within the 

defined cut-off time using the Auto Action Parameter field (this is an optional step). For example, if you 

select Escalate, then the alert is escalated to the Supervisor after the cut-off time is passed. You can also 

set a notification to be sent for overdue alerts as soon as the cut-off time is passed for an alert to any user 

role, for example, to a supervisor. For more information, see the Generating Email for Different Statuses 

section. 

To set the cut-off time, follow these steps: 

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. 

2. Click Transaction Filtering Admin and then click the Cut-Off Configuration tab. 

 

Figure 27: Cut-Off Configuration Tab 

 
 

3. Enter the cut-off time in HH:MM:SS format. This is the time period by when the alert must be closed 

by the investigator. 

4. Enter the locale. The cut-off time is displayed based on your selection. 

5. Select Yes to enable a specific combination, else select No. 

6. To create a combination, use the following conditions. This is an optional step. 

▪ Message Category: Select the message category used for the transaction. You can also 

select Any to indicate that regardless of the message category, the cut-off time is enabled 

for the combination. If you select Any, you cannot select a message type. 

▪ Message Types: Select a message type for the message category. You can also select All to 

indicate that the cut-off time is enabled for all message types. 

▪ Jurisdiction: Select the jurisdiction/geography if the defined cut-off time must apply to 

only this jurisdiction. You can also select All to select all jurisdictions/geographies. 

▪ Business Domain: Select the business domain if the defined cut-off time must apply to only 

this business domain. You can also select All to select all business domains. 

▪ Currency: Enter the ISO currency code of the currency used for the transaction. 

▪ Amount: Select the amount range used in the transaction. 

https://docs.oracle.com/cd/E91256_01/tf.htm
https://docs.oracle.com/cd/E91256_01/tf.htm
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▪ Priority: Set a specific alert priority or select Any to indicate that the alert can have any 

priority. 

▪ Message Direction: Select INBOUND for transactions that are coming into your account 

and select OUTBOUND for transactions that are going out of your account. You can also 

select Any to select any message direction. 

After you select the values in the required fields, you can do the following: 

 

Table 7: General Actions 

To... Do this... 

Add a configuration Click Add. The values appear in a tabular format. 

Update a configuration Select the configuration you want to update, update the value of one or 

more fields, and click Update. The updated value is displayed in the 

table. 

Remove a configuration Select the configuration you want to remove and click Remove. The 

selected configuration is removed from the table. 

Clear the values of some of 

the fields in a configuration 

Click Clear. You can only clear the values of the Cut-Off Time, Currency, 

and Amount fields. 

Enable all configurations Click Enable All. 

Disable all configurations Click Disable All. 

 

NOTE After you remove a configuration, you must restart all web 
services.  

 

5.6 Setting the Priority for Messages 

You can set the priority for a specific message category as High, Medium, and Low based on certain 

criteria such as the message jurisdiction, message type, and amount. The seeded message categories are 

High, Medium, and Low. To add other priority types, add the required priority type in the 

DIM_ALERT_PRIORITY_TYPE table. 

 

NOTE The ready-to-use application extracts some of the key fields of 
the message into the FSI_RT_MSG_TAG table. 

 

If you want to use any field to define the priority, write an SQL query in the V_ATTRIBUTE_VALUE1 

column of the SETUP_RT_PARAMS table. At the end of the query, add the following where clause: 

where t.n_grp_msg_id = [GRP_MSG_ID] and rownum = 1 

To define the priority for a message category, follow these steps: 

1. Run the following query to view the SETUP_RT_PARAMS table: 
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select * from SETUP_RT_PARAMS; 

2. Search for the MESSAGE_PRIORITY value in the V_PARAM_NAME column. 

3. In the V_ATTRIBUTE_VALUE1 column, write the query or function to define the priority. 

You can write functions or queries based on your criteria.  

5.7 Running the Purge Utility 

Use the purge utility to maintain all data such as alerts, transactions, and reference data for a specific 

archival period for all involved jurisdictions. The archival period can be configured by users who have the 

required permissions under each legal entity policy or local data protection requirements. 

To run the purge utility, follow these steps: 

1. Go to the purgeTF.sh file in the <installed area>/ficdb/bin/ directory and replace the 

##Infodom## placeholder with the name of your Infodom. 

2. Run the purge utility from the <installed area>/ficdb/bin/ directory using the following 

command: 

./purgeTF.sh <from date in mm/dd/yyyy> <to date in mm/dd/yyyy> S/H 

S stands for soft delete and H stands for hard delete. 

For example, ./purgeTF.sh 11/11/2019 11/12/2019 S 

3. Verify the purge logs in the following directory: 

<installed area>/ficdb/log/TFpurge/ path 

5.8 Adding, Editing or Deleting Good Guy Records 

You can add, edit or delete a Good Guy record from the Good Guy List Details page.  

5.8.1 Adding a Good Guy Record 

Apart from adding a good guy record using the process mentioned in the Good Guy/White List 

Matching section in the Oracle Financial Services Transaction Filtering User Guide, you can also manually 

add a record to the FCC_WHITELIST table, for example, if the record is a trusted customer.  

To add a record, follow these steps: 

1. Click List Management on the Financial Services Analytical Applications Transactions Filtering 

landing page.  

2. In the Good Guy Summary section, click Plus . A pop-up window is displayed. 

 

https://docs.oracle.com/cd/E91256_01/tf.htm
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Figure 28: Good Guy Summary Pop-up Window 

 
 

3. Enter the required details. 

4. Click Save.  

5.8.2 Editing a Good Guy Record 

After you add a record, you can change the jurisdiction or expiry date of the record by editing the record. 

To edit the good guy record, follow these steps: 

1. In the Good Guy Summary section, click Actions. 

2. From the drop-down list, click Edit. 

3. Make the necessary changes to the record. 

4. Enter your reasons for editing the record. 

5. Click Save. 

5.8.2.1 Updating the Status of an Expired Alert 

If the Supervisor has not worked on the alert and it is past the expiry date, you must move it to the expiry 

status. To do this, run the Good Guy Expiry Check batch in the Run page. 



GENERAL CONFIGURATIONS 

GENERATING EMAIL FOR DIFFERENT STATUSES 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  48 

5.8.3 Deleting a Good Guy Record 

You can delete a record, for example, if the record was added in error or the record must no longer be in 

the Good Guy table. 

To delete the good guy record, follow these steps: 

1. In the Good Guy Summary section, click Actions. 

2. From the drop-down list, click Delete. 

3. Enter your reasons for deleting the record. 

4. Click Save. 

The following columns in the FCC_WHITELIST table are used for matching. This match can be against a 

single column or column combinations: 

• V_ORIGIN: This column contains the watch list name. 

• V_WHITE_ENTITY_NAME: This column contains the watch list record name. 

• V_WHITE_NAME: This column contains the input message name. 

• V_IDENTIFIER_CODE: This column contains the ID of the party name present in the 

V_WHITE_NAME column and comes from the input message. 

• N_RECORD_ID: This column contains the watch list record ID. 

• V_JURISDICTION: This column contains the watch list jurisdiction. 

• D_EXPIRE_ON: This column contains the date after which the record is no longer checked against 

the records in the FCC_WHITELIST table. 

5.9 Generating Email for Different Statuses 

An email is generated for a transaction depending on its status. The following types of emails are 

generated: 

• Notification Email 

• Task Email 

5.9.1 Notification Email 

A notification email is generated for Blocked and Released transactions and the template is as follows: 

Subject: Notification-<id>-Issue Identified - New issue assigned to you 

 

Hi TFSUPERVISOR,  

This is to inform you that a Notification is generated for you in your inbox 

for 

Notification ID: <id> 

Transaction Type: <Message Type>  

Message Reference: <Message Reference> 
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Status: <Blocked/Released> 

User Comments: <User comments> 

Received On: 2017-07-25 12:03:19.0 

 

Please access the below link to logon to Transaction Filtering System.  

<Application URL> 

 

Regards,  

Admin  

A notification email is generated for nearing cut-off/nearing SLA to supervisor and the template is as 

follows. Two different emails are sent for cut-off and SLA. 

 

Subject: Notification-<id>-Issue Identified - New issue assigned to you 

 

Hi TFSUPERVISOR/TFANALYST, 

This is to inform you that a Notification is generated for you in your inbox 

for 

Notification ID   :  <id> 

Message Category: <Message Category> 

Transaction Type : <Message Type> 

Message Reference: <Message Reference> 

Batch Reference: <Batch Reference> 

Transaction Reference: <Transaction Reference> 

Status   : <HOLD/ASSIGNED/ESCALATED/BLOCK RECOMMENDED/RELEASE RECOMMENDED > 

User Comments: <User comments> 

Received On      : <2017-07-25 12:03:19.0> 

Please access the below link to logon to Transaction Filtering System. 

<Application URL> 

Regards, 

Admin 

5.9.2 Task Email 

A task email is generated for Hold and Escalated transactions and the template is as follows: 

Subject: Taskid-<id>-Issue Identified - New issue assigned to you 

 

Hi TFSUPERVISOR/TFANALYST,   

This is to inform you that a Notification is generated for you in your inbox 

for 
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Task ID: <id> 

Transaction Type: <Message Type>  

Message Reference: <Message Reference> 

Status: <Hold/Escalated> 

User Comments: <User comments>       applicable to escalated only 

Received On: 2017-07-25 12:03:19.0 

 

Please access the below link to logon to Transaction Filtering System.  

<Application URL> 

 

Regards, 

Admin  

A task email is generated for nearing cut-off/nearing SLA to supervisor and the template is as follows. 

Two different emails are sent for cut-off and SLA. 

 

Subject: Taskid-<id>-Issue Identified - New issue assigned to you 

 

Hi TFSUPERVISOR/TFANALYST,   

This is to inform you that a Notification has been generated for you in your 

inbox for 

Task ID :  <id> 

Message Category: <Message Category> 

Transaction Type : <Message Type> 

Message Reference: <Message Reference> 

Batch Reference: <Batch Reference> 

Transaction Reference: <Transaction Reference> 

Status   : <Overdue Cut-off/ Overdue SLA>         Note: not sure exact status 

name so use exact status which are used for cut-off overdue and SLA overdue. 

User Comments: <User comments>       applicable to escalated only 

Received On      : 2017-07-25 12:03:19.0 

Please access the below link to logon to Transaction Filtering System. 

<Application URL> 

Regards, 

Admin 
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5.10 Configuring Alerts in Multiple Jurisdictions and Business 
Domains 

Alerts are segregated based on jurisdiction and business unit or line of business. You can also configure 

the alerts that are assigned to the users in the tfanalytgroup and tfsupervisorgrp groups. 

Jurisdictions are used to limit user access to data in the database. The user must load all jurisdictions and 

associate user groups to jurisdictions in the tables as specified in Configuring Jurisdictions and Business 

Domains. User groups can be associated with one or more jurisdictions. 

 

NOTE All jurisdictions in the system reside in the 
FCC_SWIFT_JSRDSN_MAP table. 

 

In the Investigation User interface system, users can view only data or alerts associated with jurisdictions 

to which they have access. You can use jurisdiction to divide data in the database. For example: 

• Geographical: Division of data based on geographical boundaries, such as countries, states, and so 

on. 

• Organizational: Division of data based on different legal entities that compose the client’s business. 

• Other: Combination of geographic and organizational definitions. Also, it can be customized. 

The definition of jurisdiction varies from between users. For example, a user can refer to a branch BIC as 

jurisdiction and another user can refer to a customer ID as jurisdiction. 

Business domains are used to limit data access. Although the purpose is like jurisdiction, they have a 

different objective. The business domain is used to identify records of different business types such as 

Private Client versus Retail customer, or to provide more granular restrictions to data such as employee 

data.  

If a user has access to any of the business domains that are on a business record, the user can view that 

record. 

 

NOTE All business domains in the system reside in the 
FCC_SWIFT_BUS_DMN_MAP table. 

 

5.10.1 Steps 

The default Sanctions groups are tfanalytgroup and tfsupervisorgrp. According to the ready-to-

use product, these groups get all alerts and notifications for all jurisdictions and business domains. To 

configure the alerts, follow these steps: 

1. Load all the jurisdictions. To do this, run the query SELECT * FROM FCC_SWIFT_JSRDSN_MAP 

and load the jurisdictions in the V_JRSDCN_CD column in the FCC_SWIFT_JSRDSN_MAP table.  

The following columns are provided to populate any additional information: 
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Table 8: Columns used to provide additional information for Jurisdictions 

Column Data Type and Length 

V_EXTRACTED_SWIFT_FIELD VARCHAR2(100 CHAR) 

V_JRSDCN_CD VARCHAR2(40 CHAR) 

V_CUST_COLUMN_1 VARCHAR2(4000 CHAR) 

V_CUST_COLUMN_2 VARCHAR2(4000 CHAR) 

V_CUST_COLUMN_3 VARCHAR2(4000 CHAR) 

V_CUST_COLUMN_4 VARCHAR2(4000 CHAR) 

N_CUST_COLUMN_1 NUMBER(20) 

N_CUST_COLUMN_2 NUMBER(20) 

N_CUST_COLUMN_3 NUMBER(20) 

N_CUST_COLUMN_4 NUMBER(20) 

 

2. Load all the business domains in the V_BUS_DMN_CD column in the FCC_SWIFT_BUS_DMN_MAP 

table. 

The following columns are provided to populate any additional information: 

 

Table 9: Columns used to provide additional information for Business Domains 

Column Data Type and Length 

V_EXTRACTED_SWIFT_FIELD VARCHAR2(100 CHAR) 

V_JRSDCN_CD VARCHAR2(40 CHAR) 

V_CUST_COLUMN_1 VARCHAR2(4000 CHAR) 

V_CUST_COLUMN_2 VARCHAR2(4000 CHAR) 

V_CUST_COLUMN_3 VARCHAR2(4000 CHAR) 

V_CUST_COLUMN_4 VARCHAR2(4000 CHAR) 

N_CUST_COLUMN_1 NUMBER(20) 

N_CUST_COLUMN_2 NUMBER(20) 

N_CUST_COLUMN_3 NUMBER(20) 

N_CUST_COLUMN_4 NUMBER(20) 

 

3. Map user groups to the appropriate jurisdiction and business domain. To do this, run the query 

SELECT * FROM DOMAIN_JUR_GRP_MAP and do the mapping in the DOMAIN_JUR_GRP_MAP 

table. 

In the case of multiple jurisdictions mapped to a single user group, create as many rows as the 

number of jurisdictions and add the new jurisdiction in each row for the same user group. 
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In the case of multiple business domains for the same user group and same jurisdiction, create as 

many rows as the number of business domains and add the new business domain in each row for 

the same user group and jurisdiction. 

4. Put the appropriate SQL query in the Message_jurisdiction and Message_Business_Domain 

rows to derive the jurisdiction and business domain respectively in the Setup_Rt_Params table.  

This step is required to define the source of jurisdiction and business domain from the message or 

an external source. 

The definition and source of jurisdiction and business domain are different for each customer. In 

this way, the Transaction Filtering application gives the flexibility to the user to pick any attribute of 

the message to define the jurisdiction and business domain. For example, jurisdiction can be the 

BIC present in block 1/block 2 of the SWIFT message or the branch ID present in the SWIFT GPI 

header. 

The ready-to-use application can extract some of the key fields of the message, which are available 

in the fsi_rt_al_msg_tag table. If the customer wants to use any field as a jurisdiction or 

business domain from this table, then an SQL query must be written in the Setup_Rt_Param table 

to extract the respective column. 

When a message is posted, the system updates the jurisdiction and business domains extracted in 

step 4 in the FSI_RT_RAW_DATA and FSI_RT_ALERTS tables. 

5.10.2 Configurations to Automatically Assign Transactions 

In the setup_rt_params table, set the V_ATTRIBUTE_VALUE1 value for HOST_NAME, PORT and 

SANC_CONTEXT_NAME corresponding to the N_PARAM_IDENTIFIER value as 55 and the 

V_PARAM_NAME value as XML_WEB_SERVICE_BASE_URL. It is in the following format: 

http://##HOST_NAME##:##PORT##/##SANC_CONTEXT_NAME##/SanctionsService 

Example: 

http://whf00bls:8930/SAN807SEPA/SanctionsService 

5.10.3 Configurations to Automatically Release Transactions 

To configure a transaction for the Auto Release status, run the following query: 

select * from fsi_rt_auto_release; 

By default, the configuration is empty, which means that no transactions can be auto released. You can 

set the following values in the fsi_rt_auto_release table: 

• Message category in the V_MSG_CATEGORY column. For example, a message category of 1 is 

mapped to the SWIFT message type by default. To see all default values, run the following query: 

select * from dim_message_category; 

• Message type in the N_SWIFT_MSG_ID column. For example, a message type of 1 is mapped to the 

MT101 message type by default. To see all default values, run the following query: 

select * from dim_sanctions_swift; 

• Jurisdiction in the V_JURISDICTION column. 

• Business Domain in the V_BUSINESS_DOMAIN column. 

http://whf00bls:8930/SAN807SEPA/SanctionsService
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• To see the default values for jurisdiction and business domain, run the following query: 

select v_attribute_value1 from setup_rt_params where V_PARAM_NAME in 

('MESSAGE_JURISDICTION','MESSAGE_BUSINESS_DOMAIN')  

• To enable the configuration, set the F_ENABLED column to Y. 

5.11 Version Control 

Version control for SWIFT messages, IPE, and ISO200222 is accomplished using the Import/export feature 

in Transaction Filtering. Say a file has been moved from one environment to another environment. Later, 

the file is updated. The import/export utility will create 2 separate files for each configuration. You can 

import both the files into the application and use a text file comparator such as beyond compare or a 

version control tool such as SVN to view the differences between the exported files. 

Version control for EDQ follows a different process. EDQ has an inbuilt version control feature available, so 

you will just need to compare the .dxi files to view the differences. 

5.11.1 Version Control for SWIFT Messages and IPE 

The steps involved for SWIFT messages and IPE are the same. These steps are explained here: 

1. Export the new file using the and save it in your local drive. 

2. Import the file into the Transaction Filtering application. 

You can now compare this file with another file. Ensure that you place these files in separate folders. 

5.11.2 Version Control for ISO20022 

The steps involved for ISO20022 are explained here: 

1. Export the new file and save it in your local drive. 

2. Import the file into the Transaction Filtering application. 

You can now compare this file with another file. Ensure that you place these files in separate folders. 

If you want to restore the current version to a previous version of the file, you can delete data from 

all the tables, import a previously exported file that has the date you want to restore into the 

application, and restart the webserver. This restores the configuration of the previous version. 

5.11.3 Version Control for EDQ 

To use the version control feature available within EDQ, follow these steps: 

1. In the EDQ application, copy the two different versions of the .dxi files into the EDQ Director 

menu. 

2. Click View and select Configuration Analysis in the EDQ Director menu. 

3. In the popup which appears, select the versions that you want to compare. 

4. Click Configuration. 

5. In the popup which appears, select the differences only and click OK. 
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6. In the same window, select Start Comparison. This gives all changes between the two files.  

For more information, see Oracle Enterprise Data Quality Documentation. 

5.12 Running the Migration Utility for SWIFT and Fedwire 

Use this migration utility to import and export the SWIFT and Fedwire message configurations. For 

information on configuring the SWIFT message parameters, see Configuring the SWIFT Message 

Parameters. For information on configuring the Fedwire message parameters, see Configuring the 

Fedwire Message Parameters. 

The message types provided in this utility are available in the 

TF_Swift_Migration_Utility/output/MSG_TYPES directory. 

 

To export the configurations, follow these steps: 

1. Navigate to the TF_Swift_Migration_Utility/config directory. 

2. Open the Dynamic.properties file and update the placeholders as shown: 

 

Table 10: Configurations required in the Dynamic.properties file when running the export file 

Placeholder Update with... 

##jdbcurl## Your JDBC URL. 

##username## The Atomic Schema user name using which you want to execute the 

files. 

##password## The Atomic Schema password for the user name. 

##infodom## Your Infodom name. 

##SWIFT_MSG_ID## Your SWIFT ID. This is available in the n_sanction_swift_msg_id 

column in the dim_sanctions_swift_details table. 

If you are providing multiple IDs, add the IDs separated by commas. For 

example, 1,2,3,4. 

 

3. Navigate to the TF_Swift_Migration_Utility/bin directory and run the export.sh 

SWIFTMSGEXPORT MSG_TYPES command.  

MSG_TYPES is the folder name of the folder to which you can export the configurations. Before you 

perform the export, change the folder name. For example, Exported.  

 

WARNING Do not change the folder name to MSG_TYPES. This will overwrite 

the ready-to-use message types provided with the utility. 

 

To import the configurations, follow these steps: 

https://docs.oracle.com/middleware/1213/edq/extend/ver_control.htm#DQEXT110
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1. Navigate to the 

FIC_HOME/Transaction_Processing/TF_Swift_Migration_Utlity/config directory. 

2. Open the SWIFT_MSG_TYPES.txt file and add the message types that you want to import to the 

Exported folder mentioned in the export configuration steps.  

3. Open the Dynamic.properties file and update the placeholders as shown: 

 

Table 11: Configurations required in the Dynamic.properties file when running the import file 

Placeholder Update with... 

##jdbcurl## Your JDBC URL. 

##username## The Atomic Schema user name using which you want to execute 

the files. 

##password## The Atomic Schema password for the user name. 

 

4. Navigate to the TF_Swift_Migration_Utlity/bin directory and run the import.sh 

SWIFTMSGIMPORT MSG_TYPES command.  

MSG_TYPES is the folder name of the folder from where you can import the configurations. Before 

you perform the import, change the folder name. For example, Imported.  

 

WARNING Do not change the folder name to MSG_TYPES. This will overwrite 

the ready-to-use message types provided with the utility. 

 

After you complete the export and import steps, restart the web server. To verify if the message types 

have been successfully imported or not, check if the message types are available in the Message Type 

Configuration field in the Message and Screening Configurations Window. 

5.12.1 Restoring a Previous Message Configuration  

To restore a configuration, you must first export and then import the configuration from that 

environment, and then restart the webserver. This restores the configuration of the previous version. 

Follow these steps to restore the configuration: 

1. Export the message configuration from the environment.   

 

NOTE Ensure that you save the configuration. 

 

2. To restore the previous version, Import the saved configuration.  
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When you import a message configuration, and the message already exists in the system, then the 

value of the F_LATEST_IDENTIFIER column is updated to Y in the FSI_RT_SWIFT_CONF_DTLS 

and DIM_SANCTIONS_SWIFT_DETAILS tables.  

The audit history is captured in the FSI_RT_SWIFT_CONF_DTLS_HIST table in the V_HIST_DESC 

column and will have the following remark: Configuration Updated Through Migration 

Utility.  

5.13 Running the Migration Utility for ISO20022 

Use this migration utility to import and export the ISO20022 message configurations from one 

environment to another, for example, from the development server to UAT, and subsequently to 

production. For information on configuring the ISO20022 message parameters, see Configurations for the 

ISO20022 Message Parameters. 

To use the utility, first export the configuration from the source environment and then import the file to 

the destination environment. To export the configuration, follow these steps: 

1. Navigate to the 

$FIC_HOME/Transaction_Processing/TF_Config_Migration_Utility/config directory. 

2. Open the Dynamic.properties file and update the placeholders as shown: 

 

Table 12: Configurations required in the Dynamic.properties file when running the export file 

Placeholder Update with... 

##jdbcurl## Your JDBC URL. 

##username## The Atomic Schema user name using which you want to execute the 

files. 

##password## The Atomic Schema password for the user name. 

##infodom## Your Infodom name. 

##N_XSD_CONF_ID## Your ISO20022 ID. This is available in the n_xsd_conf_id column in 

the fcc_tf_xml_xsd_conf table. 

If you are providing multiple IDs, add the IDs separated by commas. For 

example, 1,2,3,4. 

 

3. Navigate to the TF_Config_Migration_Utility/bin directory and run the required command.  

./export.sh SEPA 

To import the configuration, follow these steps: 

1. Navigate to the TF_Config_Migration_Utility/config directory. 

2. Open the Dynamic.properties file and update the placeholders as shown: 
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Table 13: Configurations required in the Dynamic.properties file when running the import file 

Placeholder Update with... 

##jdbcurl## Your JDBC URL. 

##username## The Atomic Schema user name using which you want to execute 

the files. 

##password## The Atomic Schema password for the user name. 

##infodom## Your Infodom name. 

##N_XSD_CONF_ID## Your ISO20022 ID. This is available in the n_xsd_conf_id column in 

the fcc_tf_xml_xsd_conf table. 

If you are providing multiple IDs, add the IDs separated by commas. For 

example, 1,2,3,4. 

 

3. Navigate to the TF_Config_Migration_Utility/bin directory and run the required command.  

./ import.sh SEPA 

•  

 

5.14 Configuring JMS Correlation ID 

JMS message has two properties (column) called Correlation ID and Message Identifier. 

To set the Correlation ID, use the following sample code: 

See Code for Adaptor for SWIFT section in Technical Integretion Guide. 

SourceEntity srcEntity = new SourceEntity(busName); // already there 

srcEntity.setCorrelationID("12345"); // corrid to be set (Optional) 

Both initial and final feedback are set with same correlation ID while sending response to output queue. 
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6 Configuring the SWIFT Message Parameters 

To configure the message and screening parameters, follow these steps: 

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. 

2. Click SWIFT Configuration Admin. The Message and Screening Configurations tab is displayed. 

 

NOTE The following screens are the same for the Fedwire and SWIFT 
message parameters. 

 

This tab has the following windows: Message Type Configurations window, <Message Type> Subfield 

Level Configuration Details window, <Message Type> Screening Configuration Window, and <Message 

Type> Other Field/Subfield Configuration Window. 

6.1 Message and Screening Configurations Window 

This window allows you to edit the status, field names, and expressions of the different JSON parameters 

in the message.  

In the Message Type Configuration field, select the SWIFT message category. All message definitions are 

SWIFT 2019 compliant. 

The following message types, MTC11, MTC22, MTC33, and MTC44, have been introduced for creating 

custom message categories, and they support UTF-8 characters. To add custom message categories, use 

the dim_sanc_swift_msg_details table. The new format must contain MTC and must be followed by 

a two-digit number.  

You can also add a single line or multiple lines for Chinese characters. To add a single line, use 100k for 

the expression in the configuration JSON. To add multiple lines, use 100*100k for the expression in the 

configuration JSON.  
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Figure 29: Sample format for MTC11/MTC22/MTC33/MTC44 SWIFT message type 

 
 

In this example, C11 can be either 11 or 11A and not 111. So, the tag can either start with two numbers or two 

numbers and one alphabet. The value in the 11A tag represents 100k in the JSON expression, and the 

value in the 15 tag represents 100*100k in the JSON expression. 

A sample JSON is shown: 

{ 

              "attr": { 

                "id": "t4:2:2", 

                "field": "12", 

                "status": "M", 

                "fieldName": "Entity Type", 

                "expression": "100k", 

                "regex": "", 

                "editable": "Y" 

              } 

            }, 

            { 

              "attr": { 

                "id": "t4:2:3", 

                "field": "13", 

                "status": "M", 
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                "fieldName": "Entity Relationship", 

                "expression": "100*100k", 

                "regex": "", 

                "editable": "Y" 

              } 

            }, 

Each message type has five blocks: Basic Header Block, Application Header Block, User Header Block, Text 

Block, and Trailer Block.  

 

Figure 30: Message and Screening Configurations Window for SWIFT  

 
 

In this figure, the first column lists all the SWIFT blocks and a list of fields within each block which follows 

SWIFT naming standards. In this field, if a part of the sequence has multiple formats, then while uploading 

the JSON for the message type, update the formats within [..] with unique identifiers. The other 

columns are: 

• Status: This column mentions whether the field is Mandatory (M) or Optional (O).  

• FieldName: This column describes the name of the given field as per SWIFT standards. 

• Expression: This column depicts the field structure in terms of expression. For example, if the field 

is a data type, then the maximum length of the field is displayed. 

To edit a parameter, click the parameter name. After you make the changes, click Save. 
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6.1.1 Adding or Updating a New Message Type 

To add or update an existing message type, follow these steps: 

1. Click the Add/Update button. The Attachment Details window is displayed. 

2. Select the type of message that you want to add or update from the drop-down list. 

 

Figure 31: Attachment Details Window 

 
 

3. To upload an attachment, click Choose File . You can upload only one attachment at a 

time. 

 

NOTE This file must be of the format .json or .txt. 

 

4. Click Upload. 

5. Click Submit. The message is displayed in the following table as <Message Type_draft>. 

For more information on the JSON format, see Structure of a JSON. 

6.1.2 Repeating Sequences 

If the SWIFT message contains sequences and the same tag repeats in both the sequences and the 

subsequences, then you must set the V_REPEAT_TYPE column to Y in the 

dim_sanc_swift_msg_details table before you upload a new message type. If a SWIFT message has 

already been uploaded, then after you set the V_REPEAT_TYPE column to Y in the 

dim_sanc_swift_msg_details table, you can click the Save button in the Message Type Configuration  
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6.1.3 Configuring Message and Transaction References 

Any message which contains message references or transaction references, or both, must be configured. 

To view and change the message reference or transaction reference, click Reference Configuration. 

 

Figure 32: Reference Configuration Window 

 
 

For the Message Reference field, a unique identifier must be configured at the message level for all 

message categories. For the Transaction Reference field, a unique identifier must be configured at the 

transaction level only if applicable for the specific message category. 

6.2 <Message Type> Subfield Level Configuration Window 

This window allows you to add a subfield to a field in the Message Type Configuration Window. 

 

Figure 33: <Message Type> Subfield Level Configuration Window 

 
 

1. To add a subfield, provide the required values in the fields shown in the window and click Add 

. Enter values in the following fields: 

 

Table 14: Fields in the <Message Type> Subfield Level Configuration Window 

Fields Field Description 

Expression Identifier Enter a unique identifier. It must begin with an alpha character and must 

not contain any spaces. This is a mandatory field. 

Expression Name Enter a name for the expression. The name must be in capital letters. 

This is a mandatory field. 
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Fields Field Description 

Expression Description Enter a description for the Expression. This is a mandatory field. 

Field This field displays a complete list of fields in the drop-down for the given 

message type. Select the field from this drop-down field to configure the 

expression. 

Field/Subfield Name This field displays the respective field name or subfield options for the 

field that was previously selected. Select the subfield from the drop-

down list. 

Subfield Expression 

Format & Occurrence 

This field is populated when the Field is selected. Select an expression as 

it as or an element from that expression. You can also enter the number 

of occurrences for the expression within that message. By default, it is 

always 1. 

Add button To add a subfield, provide the required values in the fields shown above 

and click Add . 

Update button To update an existing subfield, click the name of the subfield. After you 

make the changes, click Update . 

Remove button To remove an existing subfield, click the name of the subfield and click 

Remove . 

Clear button 
To clear the data in these fields, click Clear . 

 

2. To update an existing subfield, click the name of the subfield. After you make the changes, click 

Update. 

3. To remove an existing subfield, click the name of the subfield and click Remove. 

4. To clear the data in these fields, click Clear. 

You can configure the subfield in two ways: 

• By configuring the subfield level data within the option expression: Do this if you want to 

configure specific data within the expression. 

For example, if field 57 has four options A, B, C, and D in MT103 message but you want to 

configure BIC (Identifier Code) from option A: 

Option A:  

[/1!a][/34x]        (Party Identifier) 

4!a2!a2!c[3!c]      (Identifier Code) 

You must enter the names in the Subfield Expression Identifier, Subfield Name, and Subfield 

Description fields. 

• By configuring the element level data within the subfield expression: Do this if you want to further 

configure any data out of the subfield.  
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In this example, if you want to configure the country code for field 57, then you can configure 

2!a from Identifier Code expression as a country code by giving unique names in the Subfield 

Expression Identifier, Subfield Name, and Subfield Description fields. 

Option A: 

[/1!a][/34x]        (Party Identifier) 

4!a 2!a 2!c[3!c]      (Identifier Code) 

6.3 <Message Type> Screening Configuration Window 

This window allows you to add, update, remove, and enable or disable a web service.  

 

Figure 34: <Message Type> Screening Configuration Window 

 
 

To view a web service, enter values in the following fields: 
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Table 15: Fields in the <Message Type> Screening Configuration Window 

Fields Field Description 

Screening WebService Select a screening web service from the drop-down list. This field lists all 

the supported matching web services in the Transaction Filtering 

application. The following web services are available: 

• Identifier 

• Country and City 

• Goods Screening 

• Name and Address 

• Narrative or Free Text Information 

• Port Screening 

The fields for all web services except Goods Screening are as shown 

here. For information on the fields for Goods Screening, see Fields for 

Goods Web Services. 

Expression (ID-Name) Select an expression identifier. When you select an expression identifier, 

the values are populated in the Field and Field/Subfield Name fields. 

Field Select the field name. 

Field/Subfield Name Select the subfield name. This displays the expression. 

Enable Select Yes to enable the web service. Select No to disable the web 

service. 

Message Direction Select INBOUND(o) and OUTBOUND(i) based on the screening 

requirement from the drop-down list. If a field must be screened only for 

incoming messages, select inbound, else select outbound. If that field 

must be screened for both inbound and outbound, then select ANY. 

Jurisdiction Select All to apply the Webservice for all jurisdictions or select the 

specific jurisdiction to apply the webservice for a specific jurisdiction. 

Use the kdd_jrsdcn table to configure the jurisdiction values. It has 

the following columns: 

• JRSDCN_CD: Values must be unique. 

• JRSDCN_NM: Actual jurisdiction name. 

• JRSDCN_DSPLY_NM: Jurisdiction name displayed in the Message 

and Configurations screen. 

• JRSDCN_DESC_TX: Optional field to adbusinesd descriptions for the 

jurisdictions. 

Add button To add a web service, provide the required values in the fields shown 

above and click Add . 

Update button To update a web service, select the web service that you want to update 

and click Update . 

Remove button To remove a web service, select the web service that you want to remove 

and click Remove . 
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Fields Field Description 

Enable All button 
To enable all web services, click Enable All . 

Disable All button 
To disable all web services, click Disable All . 

 

The fields you can use to configure the Goods web service are different from the fields you can use to 

configure the other web services. These fields are as shown: 

 

Figure 35: Fields for Goods Web Services 

 
 

Table 16: Fields in the Goods Web Service Window 

Fields Field Description 

Expression Identifier Select the Expression for the good. 

Tag Select the tag related to the good. Based on the tag selected, the field 

name is populated. 

Field Name The field name is populated based on the tag selected. 

Message Direction Select INBOUND(o) and OUTBOUND(i) based on the screening 

requirement from the drop-down list. If a field must be screened only for 

incoming messages, select inbound, else select outbound. If that field 

must be screened for both inbound and outbound, then select ANY. 

Enable Select Yes to enable the message in a direction. Select No to disable the 

message in a direction. 

Add button To add a web service, provide the required values in the fields shown 

above and click Add . 

Update button To update a web service, select the web service that you want to update 

and click Update . 

Remove button To remove a web service, select the web service that you want to remove 

and click Remove . 
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Fields Field Description 

Enable All button 
To enable all web services, click Enable All . 

Disable All button 
To disable all web services, click Disable All . 

 

6.3.1 Enabling or Disabling a Web Service 

By default, every web service is enabled. You can change the message configuration by disabling a web 

service. When you do this, the selected web service is not evaluated.  

To enable or disable one or more web services, replace the [WEBSERVICE_IDS] placeholder with the 

corresponding web service ID. The web services and the corresponding IDs are shown here: 

 

Table 17: Web Services in Transaction Filtering 

Web Service Web Service ID 

Name and Address Name and Address 

BIC BIC 

Country and City Country and City 

Narrative or Free Text Information Narrative or Free Text Information 

Port Screening Port Screening 

Goods Screening Goods Screening 

 

To disable all the web services, replace the [WEBSERVICE_IDS] placeholder with 1, 2, 3, 4, 5, 6 in the 

following command: 

UPDATE FSI_RT_MATCH_SERVICE SET F_ENABLED = 'N' WHERE N_WEBSERVICE_ID IN 

([WEBSERVICE_IDS]) 

To enable all the web services, change N to Y. 

6.3.2 Updating and Removing a Web Service 

To update an existing web service, click the name of the web service. The fields are populated with the 

web service parameters. After you make the changes, click Update. 

To remove an existing web service, click the name of the web service and click Remove. 

6.3.3 Populating Data for the Trade Goods and Trade Port Web Services 

Data for the Trade goods and Trade port web services are taken from a reference table. To populate data 

for these web services, do this: 

1. In the EDQ Director menu, go to the Watch List Management project.  
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2. Right-click on the Reference Data Refresh job.  

3. Click Run. Provide a unique run label and run profile. 

4. When you run this job, the port and goods reference data are refreshed at the same time. 

5. Go to the Transaction Filtering project. 

6. Right-click on the MAIN-Shutdown Real-time Screening job to shut down all web services.  

7. Click Run. 

8. Right-click on the MAIN job to restart all web services. 

9. Click Run. 

6.4 <Message Type> Other Field/Subfield Configuration 
Window 

This window allows you to update the other fields which are required for the application. It displays the list 

of fixed business data/names for the required fields to run the system for any given message type. You 

can select a business data value to mention the source for a given message type. 

 

Figure 36: <Message Type> Other Field/Subfield Configuration Window 

 
 

To update the parameter, click the parameter name. The fields are populated with the field parameters. 

The following fields are displayed in this window: 

 

Table 18: Fields in the <Message Type> Other Field/Subfield Configuration Window 

Fields Field Description 

Generic Business Data This field displays the Business Name of the record that is selected. It is 

mandatory to configure this field. 

If the message contains one or more of the B, C, D, or E sequences, you 

must configure the field with the first tag of the sequence according to 

the SWIFT standard. 
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Fields Field Description 

Message Direction Select INBOUND(o) and OUTBOUND(i) based on the screening 

requirement from the drop-down list. If a field must be screened only for 

incoming messages, select inbound, else select outbound. If that field 

must be screened for both inbound and outbound, then select ANY. 

Expression (ID-Name) Select an expression identifier. When you select an expression identifier, 

the values are populated in the Field and Field/Subfield Name fields. 

Field Select the field name. 

Field/Subfield Name Select the Subfield Name. This displays the Expression. 

Add button To add a web service, provide the required values in the fields shown 

above and click Add . 

Update button To update a web service, select the web service that you want to update 

and click Update . 

Remove button To remove a web service, select the web service that you want to remove 

and click Remove . 

 

After you make the changes, click Update. 

 



CONFIGURING THE FEDWIRE MESSAGE PARAMETERS 

MESSAGE TYPE CONFIGURATION WINDOW 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  71 

7 Configuring the Fedwire Message Parameters 

To configure the message and screening parameters, follow these steps: 

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. 

2. Click FEDWIRE Configuration Admin. The Message and Screening Configurations tab is 

displayed. 

 

NOTE The following screens are the same for the Fedwire and SWIFT 
message parameters. 

 

Figure 37: Message and Screening Configurations tab for Fedwire 

 
 

This tab has the following windows: Message Type Configuration window, <Message Type> Subfield Level 

Configuration Details window, <Message Type> Screening Configuration Window, and <Message Type> 

Other Field/Subfield Configuration Window. 

7.1 Message Type Configuration Window 

This window allows you to edit the status, field names, and expressions of the different JSON parameters 

in the message.  

In the Message Type Configuration field, select the Fedwire message category.  

The following image shows a sample Fedwire message: 
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Figure 38: Sample Fedwire Message 

 
 

Each message type has a Text Block. The fields in the Text Block may change depending on the message 

type. 

 

Figure 39: Message and Screening Configurations tab for Fedwire 

 
 

In this figure, the first column lists all the message identifiers for the Fedwire message category. The other 

columns are: 

• Status: This column mentions whether the field is Mandatory (M) or Optional (O).  

• FieldName: This column describes the name of the given field as per Fedwire standards. 

• Expression: This column depicts the field structure in terms of expression. For example, if the field 

is a data type, then the maximum length of the field is displayed. 

To edit a parameter, click the parameter name. After you make the changes, click Save. 

7.1.1 Adding or Updating a New Message Type 

To add or update an existing message type, follow these steps: 

1. Click Add/Update. The Attachment Details window is displayed. 

2. Select the type of message that you want to add or update from the drop-down list. 
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Figure 40: Attachment Details Window 

 
 

3. To upload an attachment, click Choose File . You can upload only one attachment at a 

time. 

 

NOTE This file must be of the format .json or .txt. 

 

4. Click Upload. 

5. Click Submit. The message is displayed in the following table as <Message Type_draft>. 

For information on the JSON structure, see Structure of a JSON.  

7.1.2 Configuring Message and Transaction References 

Any message which contains message references or transaction references, or both, must be configured. 

To view and change the message reference or transaction reference, click Reference Configuration. 

 

Figure 41: Reference Configuration Window 

 
 

For the Message Reference field, a unique identifier must be configured at the message level for all 

message categories. For the Transaction Reference field, a unique identifier must be configured at the 

transaction level only if applicable for the specific message category. 
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7.2 <Message Type> Subfield Level Configuration Window 

This window allows you to add a subfield to a field in the Message Type Configuration Window. 

 

Figure 42: <Message Type> Subfield Level Configuration Window 

 
 

1. To add a subfield, provide the required values in the fields shown in the window and click Add 

. Enter values in the following fields: 

Table 19: Fields in the <Message Type> Subfield Level Configuration Window 

Fields Field Description 

Expression Identifier Enter a unique identifier. It must begin with an alpha character and must 

not contain any spaces. This is a mandatory field. 

Expression Name Enter a name for the expression. The name must be in capital letters. 

This is a mandatory field. 

Expression Description Enter a description for the Expression. This is a mandatory field. 

Field This field displays a complete list of fields in the drop-down for the given 

message type. Select the field from this drop-down field to configure the 

expression. 

Field/Subfield Name This field displays the respective field name or subfield options for the 

field that was previously selected. Select the subfield from the drop-

down list. 

Subfield Expression 

Format & Occurrence 

This field is populated when the Field is selected. Select an expression as 

it as or an element from that expression. You can also enter the number 

of occurrences for the expression within that message. By default, it is 

always 1. 

Add button To add a subfield, provide the required values in the fields shown above 

and click Add . 

Update button To update an existing subfield, click the name of the subfield. After you 

make the changes, click Update . 
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Fields Field Description 

Remove button To remove an existing subfield, click the name of the subfield and click 

Remove . 

Clear button 
To clear the data in these fields, click Clear . 

 

You can configure the subfield in two ways: 

• By configuring the subfield level data within the option expression: Do this if you want to 

configure specific data within the expression. 

For example, if 1100 has four options A, B, C, and D in the FDBTR1002 message but you want to 

configure BIC (Identifier Code) from option A: 

Option A:  

[/1!a][/34x]        (Party Identifier) 

4!a2!a2!c[3!c]      (Identifier Code) 

You must enter the names in the Subfield Expression Identifier, Subfield Name, and Subfield 

Description fields. 

• By configuring the element level data within the subfield expression: Do this if you want to further 

configure any data out of the subfield.  

In this example, if you want to configure the country code for field 57, then you can configure 

2!a from Identifier Code expression as a country code by giving unique names in the Subfield 

Expression Identifier, Subfield Name, and Subfield Description fields. 

Option A: 

[/1!a][/34x]        (Party Identifier) 

4!a 2!a 2!c[3!c]      (Identifier Code) 
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7.3 <Message Type> Screening Configuration Window 

This window allows you to add, update, remove, and enable or disable a web service.  

Figure 43: <Message Type> Screening Configuration Window 

 
 

To view a web service, enter values in the following fields: 

 

Table 20: Fields in the <Message Type> Screening Configuration Window 

Fields Field Description 

Screening WebService Select a screening web service from the drop-down list. This field lists all 

the supported matching web services in the Transaction Filtering 

application. The following web services are available: 

• BIC 

• Country and City 

• Goods Screening 

• Name and Address 

• Narrative or Free Text Information 

• Port Screening 

The fields for all web services except Goods Screening are as shown 

here. For information on the fields for Goods Screening, see Fields for 

Goods Web Services. 

Expression (ID-Name) Select an expression identifier. When you select an expression identifier, 

the values are populated in the Field and Field/Subfield Name fields. 

Field Select the field name. 

Field/Subfield Name Select the subfield name. This displays the expression. 

Enable Select Yes to enable the web service. Select No to disable the web 

service. 
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Fields Field Description 

Message Direction Select INBOUND(o) and OUTBOUND(i) based on the screening 

requirement from the drop-down list. If a field must be screened only for 

incoming messages, select inbound, else select outbound. If that field 

must be screened for both inbound and outbound, then select ANY. 

Jurisdiction Select All to apply the Webservice for all jurisdictions or select the 

specific jurisdiction to apply the webservice for a specific jurisdiction. 

Use the kdd_jrsdcn table to configure the jurisdiction values. It has 

the following columns: 

• JRSDCN_CD: Values must be unique. 

• JRSDCN_NM: Actual jurisdiction name. 

• JRSDCN_DSPLY_NM: Jurisdiction name displayed in the Message 

and Configurations screen. 

• JRSDCN_DESC_TX: Optional field to add descriptions for the 

jurisdictions. 

Add button To add a web service, provide the required values in the fields shown 

above and click Add . 

Update button To update a web service, select the web service that you want to update 

and click Update . 

Remove button To remove a web service, select the web service that you want to remove 

and click Remove . 

Enable All button 
To enable all web services, click Enable All . 

Disable All button 
To disable all web services, click Disable All . 

 

The fields you can use to configure the Goods web service are different from the fields you can use to 

configure the other web services. These fields are as shown: 

 

Figure 44: Fields for Goods Web Services 
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Table 21: Fields in the Goods Web Service Window 

Fields Field Description 

Expression Identifier Select the Expression for the good. 

Tag Select the tag related to the good. Based on the tag selected, the field 

name is populated. 

Field Name The field name is populated based on the tag selected. 

Message Direction Select INBOUND(o) and OUTBOUND(i) based on the screening 

requirement from the drop-down list. If a field must be screened only for 

incoming messages, select inbound, else select outbound. If that field 

must be screened for both inbound and outbound, then select ANY. 

Enable Select Yes to enable the message in a direction. Select No to disable the 

message in a direction. 

Add button To add a web service, provide the required values in the fields shown 

above and click Add . 

Update button To update a web service, select the web service that you want to update 

and click Update . 

Remove button To remove a web service, select the web service that you want to remove 

and click Remove . 

Enable All button 
To enable all web services, click Enable All . 

Disable All button 
To disable all web services, click Disable All . 

 

7.3.1 Enabling or Disabling a Web Service 

By default, every web service is enabled. You can change the message configuration by disabling a web 

service. When you do this, the selected web service is not evaluated.  

To enable or disable one or more web services, replace the [WEBSERVICE_IDS] placeholder with the 

corresponding web service ID. The web services and the corresponding IDs are shown here: 

Table 22: Web Services used in Transaction Filtering 

Web Service Web Service ID 

Name and Address Name and Address 

BIC BIC 

Country and City Country and City 

Narrative or Free Text Information Narrative or Free Text Information 

Port Screening Port Screening 

Goods Screening Goods Screening 



CONFIGURING THE FEDWIRE MESSAGE PARAMETERS 

<MESSAGE TYPE> OTHER FIELD/SUBFIELD CONFIGURATION WINDOW 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  79 

 

To disable all the web services, replace the [WEBSERVICE_IDS] placeholder with 1, 2, 3, 4, 5, 6 in the 

following command: 

UPDATE FSI_RT_MATCH_SERVICE SET F_ENABLED = 'N' WHERE N_WEBSERVICE_ID IN 

([WEBSERVICE_IDS]) 

To enable all the web services, change N to Y. 

7.3.2 Updating and Removing a Web Service 

To update an existing web service, click the name of the web service. The fields are populated with the 

web service parameters. After you make the changes, click Update. 

To remove an existing web service, click the name of the web service and click Remove. 

7.3.3 Populating Data for the Trade Goods and Trade Port Web Services 

Data for the Trade goods and Trade port web services are taken from a reference table. To populate data 

for these web services, do this: 

1. In the EDQ Director menu, go to the Watch List Management project.  

2. Right-click on the Reference Data Refresh job.  

3. Click Run. Provide a unique run label and run profile. 

4. When you run this job, the port and goods reference data are refreshed at the same time. 

5. Go to the Transaction Filtering project. 

6. Right-click on the MAIN-Shutdown Real-time Screening job to shut down all web services.  

7. Click Run. 

8. Right-click on the MAIN job to restart all web services. 

9. Click Run. 

7.4 <Message Type> Other Field/Subfield Configuration 
Window 

This window allows you to update the other fields which you can configure in the application. It displays 

the list of fixed business data/names for the required fields to run the system for any given message type. 

You can select a business data value to mention the source for a given message type. 
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Figure 45: <Message Type> Other Field/Subfield Configuration Window 

 
 

To update the parameter, click the parameter name. The fields are populated with the field parameters. 

The following fields are displayed in this window: 

 

Table 23: Fields in the <Message Type> Other Field/Subfield Configuration Window 

Fields Field Description 

Generic Business Data This field displays the business name of the record that is selected. It is 

mandatory to configure this field. 

If the message contains one or more of the B, C, D, or E sequences, you 

must configure the field with the first tag of the sequence according to 

the Fedwire standard. 

Message Direction Select INBOUND(o) and OUTBOUND(i) based on the screening 

requirement from the drop-down list. If a field must be screened only for 

incoming messages, select inbound, else select outbound. If that field 

must be screened for both inbound and outbound, then select ANY. 

Expression (ID-Name) Select an expression identifier. When you select an expression identifier, 

the values are populated in the Field and Field/Subfield Name fields. 

Field Select the field name. 

Field/Subfield Name Select the Subfield Name. This displays the Expression. 

Add button To add a web service, provide the required values in the fields shown 

above and click Add . 

Update button To update a web service, select the web service that you want to update 

and click Update . 

Remove button To remove a web service, select the web service that you want to remove 

and click Remove . 

 

After you make the changes, click Update. 
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8 Configurations for the ISO20022 Message 
Parameters 

This chapter explains how to configure the parameters for the ISO20022 message category. The 

Configuration window allows you to view the elements associated with an XSD file after you upload the 

file. The elements are displayed in a tree structure. You must provide the transaction XPath before 

submitting the file. After the file is submitted, you can view the elements associated with a specific web 

service and define the XPath priority. This XSD file can be downloaded again. The Run page has 

information on the different tasks associated with the ISO20022 batch. 

 

NOTE The XPath of an element is the logical structure or hierarchy of 
the element within the XSD file. 

 

8.1 Configuring the ISO20022 Message Parameters 

To configure the ISO20022 message parameters, follow these steps: 

1. On the Financial Services Analytical Applications Transactions Filtering landing page, click 

ISO20022/XML Configuration Admin. The Configuration window is displayed. 

 

Figure 46: Configuration Window - ISO20022 

 
 

The Message List displays the XSD files associated with each message provider /scheme/message 

type combination. Click the link in the Message Provider column to view the transaction XPaths 

for the message for every screening type. You can download the XSD for a message by clicking 
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Download  in the Download XSD column. The XSD is downloaded as a zip folder; unzip the 

folder to view the XSD files. 

2. To upload a new XSD file, click Add Message. An Add Message dialog box opens. 

 

Figure 47: Add Message Dialog Box 

 
 

3. Select the message provider and message type for the web service. If required, you can also select 

the message scheme. If you select a message scheme, then the message types change depending 

on the selected combination of the message provider and message scheme. 

 

NOTE The message provider, message scheme, and message type 
values are mapped in the fcc_tf_xml_pro_sch_msg_map 
table. 

 

4. To upload the parent XSD file and one or more child XSD files, click Upload  and select the XSD 

file from your local drive. After you select the file and click Open, the XSD file name appears next to 

the Upload button. Select the radio button next to the primary file name and click Upload. A 

confirmation message appears, “File uploaded successfully.” The basic elements related to the 

uploaded file appear in a tree view. 
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Figure 48: Add Message Dialog Box 

 
 

If you want to see the XPath of an element, select the element from the drop-down field. In the 

example window, the XPath for the StrNm element is highlighted in red. 

To choose the Batch XPath or the Transaction XPath of the element, right-click any element 

node in the Tree view and click Batch or Transaction respectively. The values appear in the tree 

view. It is mandatory to select the Transaction XPath Configuration before you submit the 

uploaded files. 

 

NOTE To view the child elements for a parent element, mouse over 
the parent element and click the parent element in the Tree 
view. If Zero  is displayed beside the element name, it means 
that there are no more child elements you can drill down to. 

 

5. Click Submit. The ISO20022 parameter name appears in the Message List section with _Draft 

attached to the parameter name.  
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Figure 49: Message List Window 

 
 

6. To complete the configuration, click the message provider link. The XML Screening Configuration 

tab is displayed. 

 

Figure 50: Message List Window 

 
 

In this tab, you can view the details of the element XPaths available for the selected web service. 

You can also perform the following actions: 
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Table 24: Other Actions 

To... Do this... 

Add a web service 

configuration 

Click Add. The following fields appear: 

Figure 51: Add a web service configuration 

 

 

Select the message direction and enable or disable the web service and 

click Save. Clicking Clear clears any values selected. If you click Cancel, 

the fields disappear.  

In the Tree view, right-click any element node and click the element to 

view the element’s XPath. The fields appear in the Screening XPath 

Configuration List section. 

Figure 52: Add a web service configuration - 

tree view 

 

 

Update a web service 

configuration 

Select the configuration you want to update and click Update. The fields 

shown in the previous row appear. Make the required changes and click 

Save. The updated values are displayed in the Screening XPath 

Configuration List section. 
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To... Do this... 

Remove a web service 

configuration 

Select the configuration you want to remove and click Remove. The 

selected configuration is removed from the Screening XPath 

Configuration List section. 

Enable all web service 

configurations 

Click Enable All.  

Disable all web service 

configurations 

Click Disable All. 

 

7. To view the message tag configurations for a field, click the XML Message Configuration tab.  

 

Figure 53: XML Message Configuration Tab 

 
 

You can also perform the following actions: 
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Table 25: Other Actions 

To... Do this... 

Add a message 

configuration 

Click Add. The following fields appear: 

Figure 54: Add a message configuration 

 

 

Select the business data value, message direction, enable or disable the 

value, choose the Priority 1 XPath and Priority 2 XPath, and click Save. 

Clicking Clear clears any values selected. If you click Cancel, the fields 

disappear.  

In the Tree view, right-click any element node and click the element to 

view it’s XPath. The fields appear in the Message Tag Configuration 

List section. 

Figure 55: Add a message configuration - tree view 
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To... Do this... 

Update a message 

configuration 

Select the configuration you want to update and click Update. The fields 

shown in the previous row appear. Make the required changes and click 

Save. The updated values are displayed in the Message Tag 

Configuration List section. 

Remove a message 

configuration 

Select the configuration you want to remove and click Remove. The 

selected configuration is removed from the Message Tag 

Configuration List section. 

 

NOTE The ready-to-use business data values are available in the 
DIM_TF_XML_MSG_TAG_FLD column. You can add a new value 
in this column.  

 

8. Click Submit. The ISO20022 parameter name is updated in the Message List without _Draft.  

Figure 56: Message List Window 

 
 

NOTE If an earlier configuration exists with the same message 
version, then this configuration is disabled, and the new 
configuration is enabled. 

 

8.2 SWIFT MX Message Types Configuration 

SWIFT MX is XML message definition used on the SWIFT network. Majority of the MX messages are ISO 

20022 messages. TF will not support mix of different message types in single file. One MX message will 

have one type of message.  

For more information on configuration of XML message parameter, see Section 8.1. 

Table 26 provide information on SWIFT MX message type and their MX identifier. 

Table 26: Message Schema 

Message Type Name MX Message Identifier 

FI To FI Customer Credit Transfer pacs.008.001.08 

Financial Institution Credit Transfer pacs.009.001.08 
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Message Type Name MX Message Identifier 

Payment Return pacs.004.001.09 

InterbankDirectDebit_FinancialInstitutionDirectDebit pacs.010.001.03 

Liquidity Credit Transfer camt.050.001.05 

Customer Credit Transfer Initiation Pain.001.001.09 

 

8.3 Running the ISO20022 Batch 

The ISO20022 messages are processed using batches. So, you must first create the following folders 

before you run the ISO20022 batch: 

1. Create a folder for the MIS date with the folder name as ##FIC_MIS_DATE## (the date on which we 

run the ISO20022 batch) in the following directory structure: 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML 

For example, 
/scratch/fccmappchef/SANC807/ftpshare/SANCINFO/STAGE/SEPA/inputXML/2020021

4. 

20200214 is the MIS Date folder. 

2. Create two folders called OUTBOUND and INBOUND inside the MIS Date folder and create a folder 

called INPUT inside both the folders.  

 

NOTE All the ISO20022 XMLs must be either kept inside the INPUT 
folder inside the OUTBOUND folder or the INPUT folder inside 
the INBOUND folder based on the direction of the message 
XML. The ISO20022 batch takes these XMLs as input when it is 
run. 

 

The directory structures for OUTBOUND and INBOUND are as follows: 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/OUTBOUND/I

NPUT 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/INBOUND/IN

PUT 

For example,  

▪ /scratch/fccmappchef/SANC807/ftpshare/SANCINFO/STAGE/SEPA/inputXML/2

0200214/OUTBOUND/INPUT  

▪ /scratch/fccmappchef/SANC807/ftpshare/SANCINFO/STAGE/SEPA/inputXML/2

0200214/INBOUND/INPUT 

After you run the ISO20022 batch, the following actions are performed: 
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• The VAL_ERROR,PRCSNG_ERROR,PROCESSED, and FEEDBACK folders are created as part of the 

batch processing. 

• If any message XML fails during validation, then it is moved to the VAL_ERROR folder. The directory 

structures for OUTBOUND and INBOUND are as follows: 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/OUTBOUND/V

AL_ERROR 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/INBOUND/VA

L_ERROR 

• If any message XML fails during the parsing process after validation, then it is moved to the 

PRCSNG_ERROR folder. The folder structures for OUTBOUND and INBOUND are as follows: 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/OUTBOUND/P

RCSNG_ERROR 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/INBOUND/PR

CSNG_ERROR 

• If any message XML is successfully processed, then it is moved to the PROCESSED folder. The 

directory structures for OUTBOUND and INBOUND are as follows: 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/OUTBOUND/V

AL_ERROR 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/INBOUND/VA

L_ERROR 

• After the batch is run successfully, a ##FILE_NAME##_feedback.xml file is created for each file 

that is processed. The feedback is created inside the FEEDBACK folder. The directory structures for 

OUTBOUND and INBOUND are as follows: 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/OUTBOUND/F

EEDBACK 

##FTPSHARE_PATH##/SANCINFO/STAGE/SEPA/inputXML/##FIC_MIS_DATE##/INBOUND/FE

EDBACK 

• The logs of the batch are available in the following path: 

##FIC_DB_HOME##/log/TF_XML 

For example, /scratch/fccmappchef/SANC807/SANC807/ficdb/log/TF_XML 

 

NOTE When we take an action (RELEASE/BLOCK) on an alert from 
the Investigation User Interface, a feedback XML is recreated 
for the corresponding file with the name 
##FILE_NAME##_feedback.xml and the name of the 
previous file with the same name becomes 
##FILE_NAME##_feedback_1.xml inside the FEEDBACK 
folder. So, the ##FILE_NAME##_feedback.xml is always the 
latest feedback file for a corresponding message XML. 

 

To run the batch, follow these steps: 

1. Navigate to the Run page. For more information, see the Run Definition Menu. 
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Figure 57: Run Page 

 
 

2. Select the TF_SEPA_messages_batch_process batch and click Fire Run. The Fire Run page is 

displayed. 

 

Figure 58: Fire Run Page 

 
 

3. Select Single as the Request Type.  

4. Select Create & Execute in the Batch field. The MIS Date field is displayed.  

5. Select the date on which you want to execute the run. This date must be the same as the folder you 

create before you run the ISO20022 batch. In the example shown, since the MIS Date folder name is 

20190913, the date you must select is 09/13/2019. 

6. Click OK.  
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A message "Batch execution is in progress" is displayed. Click Close to go back to the Run page. 

After the batch is executed, you can view the batch details on the Batch Monitor page. 

To access the Batch Monitor page, click Operations, and then click Batch Monitor. The Batch 

Monitor page has details of all batches. The batch you have executed is the last in the Batch 

Details list. To run the batch, follow these steps: 

a. Select the Batch and the MIS Date. After you select the MIS Date, the batch ID appears in the 

Batch Run ID field. 

 

Figure 59: Batch Monitor Page 

 
 

b. Select the batch ID. 

c. Click Start Monitoring. The task details associated with the batch appears in the Task Details 

section. You can also view and export the event logs for the batch in the Event Log section. 

 

Figure 60: Tasks in the Batch Monitor Page 

 
 

 

NOTE If the batch run fails, you must restart the batch. In this case, 
the batch run ID changes. 
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The task details are as follows: 

 

Table 27:Task Details 

Task ID Task Name Task Description 

Task1 TF_CallXMLParser Parses the XML data into the pre-

processing tables. 

Task2 TF_CallXMLEDQ Calls EDQ data to check if there 

are any matches. 

Task3 Message Data Attributes NA 

Task4 TF_CallXMLRTIPopulation Moves data from the ISO20022 

configuration tables to the SWIFT 

configuration tables to generate 

OBI reports. 

Task5 TF_CallXMLAlertGeneration Creates alerts and loads data into 

the alert tables. 

Task6 TF_CallXMLImmediateFeedbackCreation Populates the feedback table. 

Task7 TF_CallXMLImmediateFeedbackFileGeneration Generates the feedback in an 

XML format in the 

INBOUND/feedback directory 

for the date on which the run is 

triggered. 

Task8 TF_CallXMLHighlight Populates the highlighted column 

in the fsi_rt_al_raw_data 

table. 

Task9 TF_CallUpdateAdditionalMsgDtls Populates the post-processing 

alert table with the additional 

details provided for the alert. 

Task10 TF_CallXMLStructuredSepa Populates the data in the 

Structured Message tab in the 

Investigation User Interface. 

 

8.4 Audit Queries  

The following are the audit queries you can run to see the different audit operations: 

 

Table 28:Audit Queries for ISO20022 

Table Name Query Description 

FCC_TF_XML_XSD

_CONF 

Select * from 

FCC_TF_XML_XSD_CONF_HIST 
Run this query to see the history of all 

the actions that have been performed. 
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Table Name Query Description 

FCC_TF_XML_MSG

_TAG_FLD_XPATH 

Select * from 

FCC_TF_XML_MSG_TAG_FLD_XPATH 

_HIST 

Run this query to see the history of all 

the actions performed in the XML 

Message Configuration tab. 

FCC_TF_XML_SCR

ENG_XPATH_GRP 

Select * from 

FCC_TF_XML_SCRENG_XPATH_GRP 

_HIST 

Run this query to see the XPath for 

each parent element. 

FCC_TF_XML_SCR

ENG_FLD_XPATH 

Select * from 

FCC_TF_XML_SCRENG_FLD_XPATH 

_HIST 

Run this query to see the XPath for 

each subfield. 
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9 Configurations for the US NACHA Batch Process 

To configure the TF_US_Nacha_Batch_Process batch and to ensure successful completion, follow 

these steps: 

1. On the Financial Services Analytical Applications Transactions Filtering landing page, click 

Financial Services Sanctions Pack. 

 

Figure 61: Financial Services Sanctions Pack Menu 

 
 

2. Click Run Definition. The Run page is displayed. 

 

Figure 62: Run Definition Link 
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3. In the Run page, select the TF_US_NACHA_Batch_Process batch.  

 

Figure 63: Run Page 

 

4. Click Edit . The Run page is displayed in Edit mode. 

 

Figure 64: Run Definition (Edit Mode) 

 

5. Click Selector  and then click Job  from the drop-down list. The Component Selector 

window is displayed. 
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Figure 65: Component Selector Window 

 

 

6. Deselect the 21099:TF87INFO:OFS_TFLT:NA task. 

7. Click Ok. The Run page with the Run Definition is displayed in Edit mode. 

8. Provide a Name for the batch. 

Figure 66: Run Definition (Edit Mode) – Batch Name 

 

 

9. Click Next. 

10. Click Save. 

11. Click No in the Run Rule Framework dialog box. 
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Figure 67: Run Rule Framework Dialog Box 
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10 Enterprise Data Quality (EDQ) Configurations 

The Oracle Financial Services Transactions Filtering application is built using EDQ as a platform. EDQ 

provides a comprehensive data quality management environment that is used to understand, improve, 

protect, and govern data quality. EDQ facilitates best practices such as master data management, data 

integration, business intelligence, and data migration initiatives. EDQ provides integrated data quality in 

customer relationship management and other applications. 

EDQ has the following key features: 

• Integrated data profiling, auditing, and cleansing and matching 

• Browser-based client access 

• Ability to handle all types of data (for example, customer, product, asset, financial, and operational) 

• Connection to any Java Database Connectivity (JDBC) compliant data sources and targets 

• Multi-user project support (Role-based access, issue tracking, process annotation, and version 

control) 

• Representational State Transfer Architecture (REST) support for designing processes that may be 

exposed to external applications as a service 

• Designed to process large data volumes 

• A single repository to hold data along with gathered statistics and project tracking information, with 

shared access 

• Intuitive graphical user interface designed to help you solve real-world information quality issues 

quickly 

• Easy, data-led creation and extension of validation and transformation rules 

• Fully extensible architecture allowing the insertion of any required custom processing 

For more information on EDQ, see Oracle Enterprise Data Quality Documentation. 

10.1 Performance Improvement Measures for EDQ 
 

NOTE The following are some recommendations to help improve 
performance when you are dealing with bulk transactions. 
Perform these steps ONLY after you have completed all 
configurations for EDQ. 

 

• Web Services are CPU-intensive, that is, they are frequently executed, and receive intermittent sets 

of simultaneous requests. Simultaneously running all batch requests slows down the real-time 

processing response time. To avoid this, set the following properties in the 

director.properties file in the <domain_name>/edq/oedq.local.home/ directory: 

▪ Run the data preparation job for web services, for example, Watch-list Management, 

when real-time processing stops.  

https://docs.oracle.com/en/middleware/enterprise-data-quality/12.2.1.3/index.html
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▪ Set the runtime.threads value to a number which is lesser than the total cpu-cores so that 

both the cpu-cores can run in parallel. This ensures that the batch does not occupy all cores 

and allows  real-time processing to run. The default value is 0, that is, the batch threads 

equal the number of cpu-cores on the system.  

▪ Set the runtime.intervalthreads value to display the number of cpu-cores. This allows for 

simultaneous processing, efficient resource utilization, and faster turnaround time. The 

default value is 1, that is, requests are processed sequentially on a single core which leads to 

underutilization.  

▪ Set the workunitexecutor.outputThreads value to a number which is greater than the number of 

cpu-cores and number of connection to write results and staged data to the database to 

tune IO heavy real-time process. This is particularly useful when the database machine is 

more powerful than the EDQ server. 

▪ Set the resource.cache.maxrows value to increase the number of rows for the reference data in 

memory. This yields a faster response time. By default, the maximum number of rows you 

can load is 100000. 

• Optimize the data cluster definition and size of each cluster for real-time processing. 

• Optimize attributes which are critical to performance such as watch list types, reference data size, 

and data store size. 

• Optimize data for the EDQ_RES and EDQ_STAGING tablespace to improve performance. The 

minimum size for EDQ_RES must be 200-300 GB.  

• Optimize the OEDQ job performance by minimizing result writing and disabling the sort and 

filtering feature. 

• Adjust the response time by tuning the java options in the EDQ domain. To do this, follow these 

steps: 

▪ Open the setStartupEnv.sh file in the <domain name given for EDQ>/bin 

directory. 

▪ Update the -server -d64 -Xms16G -Xmx16G -XX:+UseG1GC -
XX:+UseAdaptiveSizePolicy -XX:MaxGCPauseMillis=500 -

Doracle.jdbc.javaNetNio=false -XX:InitiatingHeapOccupancyPercent=80 

-XX:ReservedCodeCacheSize=128m attribute in the # Startup parameters for 

STARTUP_GROUP EDQ-MGD-SVRS section based on your requirments. 

• Set the OEDQ parser processor to Parse Mode instead of to Parse And Profile. 

• Update the user credentials for dnadmin from the default realm to the authentication realm. 

• Enable the EDQ domain to operate in production mode. 
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10.2 EDQ Configuration Process Flow 

The following image shows the EDQ configuration process flow: 

 

Figure 68: Enterprise Data Quality (EDQ) Configuration Steps 

 
 

To configure EDQ, follow these steps: 

1. Import the Watchlist Management.dxi file from the FIC_HOME/SanctionsCommon path. 

2. Import the Transaction_Screening.dxi file from the FIC_HOME/Transaction_Processing 

path (This is for SWIFT messages only). 

3. Import the Transaction_Screening_SEPA.dxi file from the 

FIC_HOME/Transaction_Processing path (This is for ISO20022 messages only). 

4. For these projects, enter the applicable organization-specific Atomic schema details in the Edit 

Data Store window. To access the the Edit Data Store window, follow these steps: 

a. Go to the EDQ URL and open the Director menu. The Director landing page appears. 



ENTERPRISE DATA QUALITY (EDQ) CONFIGURATIONS 

EDQ CONFIGURATION PROCESS FLOW 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  102 

Figure 69: Director Menu in EDQ 

  

b.  

c. In the Director landing page, expand the Transaction_Screening project in the Project 

Browser pane.  
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Figure 70: Project Browser Pane 

  

d.  

e. Expand the Data Stores node and open AtomicDatasource. The Edit Data Store window 

appears. 

f.    
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Figure 71: Edit Data Store Window 

 

 

5. Load the Reference data. For more information on Reference data, see Viewing Reference Data for 

Web Services. 

6. Update the command area path in the following locations: 

7. Watchlist Management > External Tasks > WatchListLoadPreparedData 

8. Transaction_Screening > External Tasks > WatchListLoadData 

9. Transaction_Screening > External Tasks > SanctionedListRefLoadData 
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Figure 72: Edit Task Window 

 
 

10. Go to the EDQ URL and open the Server Console menu. The Server Console landing page appears. 
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Figure 73: Server Console Menu in EDQ 

  

11.  

12. Run the following jobs under the Watchlist Management project: 

▪ Analyze Reference Data Quality 

▪ Download, Prepare, Filter and Export All Lists 

▪ Generate StopPhrases 

13. Run the MAIN job under the Transaction_Screening project. 

14. Change the EDQ URL in the Transaction Filtering application. To change the EDQ URL, see 

Configuring the Application Level Parameters. 

 

NOTE The first time you set up the Transaction Filtering application, 
you must change the EDQ URL. 

 

15. Configure the message and screening parameters, if required. 

10.2.1 Importing the Transaction Screening Project 

For information on importing the Transaction Screening project, see the Importing the OFS Customer 

Screening and OFS Transaction Filtering Projects section in the Oracle Financial Services Sanctions 

Installation Guide. 

 

 

https://docs.oracle.com/cd/E91256_01/install.htm
https://docs.oracle.com/cd/E91256_01/install.htm
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NOTE After EDQ services are up and running, post a sample 
message, so that caching will happen and makes the messages 
scan fast. 

 

10.2.2 Configuring Watch List Management and Transaction Filtering 

The Oracle Financial Services Transaction Filtering distribution contains two run Profiles for configuring 

Watch List Management and screening: watchlist-management.properties and watchlist-

screening.properties. These profiles are available in the 

<domain_name>/edq/oedq.local.home/runprofiles/ directory when you log into the WinSCP 

server. 

Run profiles are optional templates that specify the number of override configuration settings for 

externalized options when a Job is run. They offer a convenient way of saving and reusing multiple 

configuration overrides, rather than specifying each override as a separate argument. 

Run profiles may be used when running jobs either from the Command Line Interface, using the 

runopsjob command, or in the Server Console User Interface. 

The watchlist-management.properties run profile controls the following processes: 

• Which watch lists are downloaded, and the configuration of the download process 

• Whether filtering is applied to the watch lists or not 

• Whether Data Quality Analysis is applied to the watch lists. 

• Real-Time and Batch Screening set up 

• Screening reference ID prefixes and suffixes 

• Watch list routing 

• Configuration of match rules. 

 

NOTE The properties controlling match rules are not included in the 
watchlist-screening.properties run profile by default. 
For more information, see Configuring Match Rules. 

 

10.2.2.1 Preparing Watch List Data 

Oracle Financial Services Transaction Filtering is pre-configured to handle reference data from the 

following sources: 

• HM Treasury 

• OFAC 

• EU consolidated list 

• UN consolidated list 

• World-Check 
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• Dow Jones watch list 

• Dow Jones Anti-Corruption List 

• Accuity Reference Data 

• For information on the watch lists, see Appendix A: Watch Lists. 

10.2.2.2 Setting Up Private Watch List 

Oracle financial services Customer Screening is pre-configured to work with commercially available and 

government-provided watch lists. However, you can also screen data against your private watch lists. 

Sample private watch lists are provided in the config/landingarea/Private directory in the 

privateindividuals.csv and privateentities.csv files. 

 

NOTE OEDQ release 12c has a base config folder and a local config folder. 

The base config folder is called oedqhome and the local config 

folder is called oedqlocalhome. The names may differ in some 

cases. For example, dots or underscores may be inserted in the 

names, such as oedq_local_home. 

 

To replace the data, follow these steps: 

1. Transform your private watch list data into the format specified in the Private List Interface 

chapter in the Oracle Financial Services Data Interfaces Guide.  

2. Replace the data in the privateindividuals.csv and privateentities.csv files with your 

transformed private watch list data.  

 

NOTE The files must be saved in UTF-8 format. 

 

To enable the staging and preparation of the private watch list in the watchlist-

management.properties Run Profile, follow these steps: 

1. Move your private watch list data to the staging area by setting phase.PRIV\ -\ Stage\ 

reference\ lists.enabled to Y. 

2. Set phase.PRIV\ -\ Prepare\ without\ filtering.enabled to Y to prepare the private 

watch list without filtering. 

Set phase.PRIV\ -\ Prepare\ with\ filtering\ (Part\ 1).enabled and 

phase.PRIV\ -\ Prepare\ with\ filtering\ (Part\ 2).enabled to Y to prepare the 

private watch list with filtering. 

10.2.2.2.1 Showing Watch List Staged Data/Snapshots in the Server Console User Interface 

Certain types of staged data and snapshots are hidden in the Server Console User Interface by default. 

These are: 

https://docs.oracle.com/cd/E91256_01/tf.htm
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• Watch list snapshots 

• Intermediate filtered watch list staged data 

• Centralized reference data staged data and snapshots 

To display this data, set the corresponding visibility property value(s) in the relevant run profile to Y. 

For example, to make all HM Treasury watch list snapshots generated during Watch List Management 

visible, set the following properties in the watchlist-management.properties run profile: 

stageddata.ACY\ Sources.visible = Y  

stageddata.ACY_All.visible = Y  

stageddata.ACY_Sources.visible = Y  

10.2.2.2.2 Configuring Match Rules 

Match rules and match clusters can be configured and controlled by adding a property to the 

watchlist-screening.properties run profile. 

 

NOTE Ensure that data is available in the ref_port_cntry table before you begin the 
matching process. This table contains the port code for a port name and the 
corresponding port country. For more information on matching, see 
https://docs.oracle.com/middleware/1221/edq/user/adv_features.htm#DQUSG380. 

 

For example, to disable the Exact name only rule for Batch and Real-Time Sanctions screening, add the 

following property to the Run Profile: 

phase.*.process.*.[I010O]\ Exact\ name\ only.san_rule_enabled = false  

 

NOTE Ensure that values are capitalized and characters are escaped 
as applicable. 

 

The * character denotes a wildcard and therefore specifies that the above rule applies to all phases and all 

processes. If disabling the rule for batch screening only, the property would read: 

phase.Batch\ screening.process.*.[I010O]\ Exact\ name\ only.san_rule_enabled = 

false  

For further details on tuning match rules, see the Oracle Financial Services Transaction Filtering Matching 

Guide. 

10.2.2.2.3 Configuring Jobs 

To configure a job, it must be configured in the properties file and on the administration window to 

enable or disable the web services. 

The WatchListLoadPreparedData process is disabled by default. To enable the process, follow these 

steps: 

https://docs.oracle.com/middleware/1221/edq/user/adv_features.htm#DQUSG380
https://docs.oracle.com/cd/E91256_01/tf.htm
https://docs.oracle.com/cd/E91256_01/tf.htm
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1. In the Watchlist_Management-<patch number> project, double-click the Load List data from 

Stg to Processed table job. All processes related to the job are displayed. 

 

Figure 74: EDQ Director Menu 

 
 

2. Right-click the WatchListLoadPreparedData process and click Enable. 

10.2.2.3 Filtering Watch List Data 

The following sections provide information on how to enable and configure the watch list filters. 

10.2.2.3.1 Enabling Watch List Filtering 

Watch list data is filtered either during List Management, Screening, or both. 
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To enable filtering for a specific watch list, set the Prepare Filtering phase(s) in the appropriate 

run profile to Y, and the Prepare Without Filtering phase(s) to N. 

10.2.2.3.2 Configuring Watch List Filtering 

Watch list filtering is controlled by configuring reference data in the watch list projects. 

 

NOTE After data is filtered out, it is not possible to filter it back in. For 
example, if all entities are filtered out in the Watchlist 
Management project, even if the Transaction_Screening 
project is configured to include entities, they will not appear in 
the results data. 

 

The top-level of filtering is controlled by editing the Reference Data Editor - Filter - Settings reference 

data. 

Figure 75: Reference Data Editor - Filter - Settings Window 

 
 

All the reference data filters are set to Y by default, except Linked Profiles which is set to N. No actual 

filtering is performed on watch list data unless these settings are changed. 
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NOTE In the Filter - Settings reference data, a value of Y 
indicates that all records must be included - in other words, no 
filter must be applied. 

 

Broadly speaking, watch list filtering falls into four categories: 

• By list and list subkey. 

• By list record origin characteristics. 

• By list profile record characteristics. 

• By linked profiles. 

10.2.2.3.3 Primary and Secondary Filtering, and Linked Records 

• Primary filtering - These filters are used to return all profiles that match the criteria specified. 

• Linked Profiles - If this value is set to Y, then all profiles linked to those captured by Primary filters 

are also captured. An example is a filter configured to capture all Sanctions and their related PEPs. 

• Secondary filtering - These filters are applied to further filter any linked profiles that are returned.  

 

NOTE Only the World-Check and DJW watch lists can provide Linked 
Profiles. 

 

10.2.2.3.4 Setting Multiple Values for Primary and Secondary Filters 

The following filter options require further configuration in additional reference data: 

• Origins 

• Origin Regions 

• Origin Statuses 

• Primary and Secondary Name Qualities 

• Primary and Secondary Name Types 

• Primary and Secondary PEP Classifications 

To filter using one or more of these options, set the relevant value in the Filter - Settings reference 

data to N, and then make further changes to the corresponding reference data. 
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NOTE When you set the Filter - Settings reference data to N, 
only the records that match the values set in the corresponding 
reference data are included. For example, if you set the value 
of All name qualities to N in Filter - Settings, then 
you can determine which name qualities must be included for 
each watch list in the Filter - Primary Name Qualities 
reference data. For instance, if you include a row for high-
quality names in the EU watch list, but you do not include rows 
for medium-quality and low-quality names for this watch list, 
then only records with high-quality names are included in the 
watch list. 

 

Some of these reference data sets are pre-populated with rows, to be edited or removed as required. 

These rows contain data (generally, but not always) supplied by each watch list provider and are all 

contained within the Watchlist Management project. 

For example, to view all possible keywords for World-Check data, open the WC Keyword reference data in 

the Watchlist Management project. See the following example for further details. 

10.2.2.3.5 Filtering World-Check Data 

This example describes configuring filtering on the World-Check Sanctions list in the Watchlist 

Management project and setting further filters in the Transaction_Screening project. You can also 

perform the following actions: 

• Enable filtering in the Run Profiles 

• Configure the Primary filters in the Watch List Management project to return only active records for 

sanctioned individuals (not entities) originating from the EU list 

• Enable the filtering of Linked Profiles in the Watch List Management project 

• Configure the Secondary filters in the Transaction Filtering project to further filter out all Linked 

Profiles of deceased individuals. 

10.2.2.4 Setting Filtering options in the Run Profiles 

In the watchlist-management.properties Run Profile, set the World-Check filtering phases as 

follows: 

phase.WC\ -\ Prepare\ without\ filtering.enabled = N 

phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 1).enabled = Y 

phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 2).enabled = Y 

In the watchlist-screening.properties Run Profile, set the World-Check filtering phases as 

follows: 

phase.WC\ -\ Load\ without\ filtering.enabled = N 

phase.WC\ -\ Load\ with\ filtering\ (Part\ 1).enabled = Y 

phase.WC\ -\ Load\ with\ filtering\ (Part\ 2).enabled = Y 
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10.2.2.4.1 Setting Primary Filters and Linked Profiles in the Watchlist Management Project 

To set the primary filters, follow these steps: 

1. In the Director menu, open the Watchlist Management project and expand the Reference 

Data node. 

2. Locate the Filter - Settings reference data and double-click to open it. 

Ensure the List/sub-list value in the WC-SAN row is set to Y. 

3. Set the Entities value in the WC-SAN row to N. 

4. Set the Inactive value in the WC-SAN row to N. 

5. Set the All Origins value in the WC-SAN row to N. 

Ensure all other values in the WC-SAN row are set to Y. 

6. Click OK to close the reference data and save changes. 

7. Locate the Filter - Origins reference data and double-click to open it. 

8. Add a new row with the following values: 

▪ List Key - WC 

▪ List Sub Key - WC-SAN 

▪ Origin - EU 

9. Change the Linked Profiles value in the WC-SAN row to Y. 

10. Click OK to close the Filter Settings reference data and save changes. 

10.2.2.4.2  Setting Secondary Filters in the Transaction_Screening Project 

To set secondary filters, follow these steps: 

1. Open the Transaction_Screening project, and expand the reference data link. 

2. Locate the Filter - Settings reference data file, and double-click to open it. 

3. Set the Deceased value in the WC-SAN row to N. 

4. Click OK to close the reference data and save changes. 

10.2.2.4.3 Screening All Data Using Sanctions Rules 

By default, watch list records are routed to the different screening processes depending on their record 

type, that is, SAN,PEP,or EDD. This allows different rules, and hence different levels of rigor, to be applied 

to the list data according to risk appetite.  

However, if you want to use the same screening logic for all list records, and do not want the overhead of 

maintaining separate rule sets, the system can be configured to reroute all list records to the SAN 

screening processes. To do this, set the phase.*.process.*.Screen\ all\ as\ SAN value in the 

watchlist-screening.properties Run Profile to Y. 
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10.2.2.5 Viewing Reference Data for Web Services 

Previously, all reference data was available in EDQ. From 807 onwards, only data related to name and 

address is enabled in EDQ. All other reference data is available in the database in the following tables: 

• Goods prohibition reference data is available in fcc_prohibiton_goods_ref_data 

• Ports prohibition reference data is available in fcc_port_ref_data 

• Bad BICs reference data is available in dim_sanctioned_bic 

• Stop Keywords reference data is available in dim_stop_keywords 

• Blacklisted Cities reference data is available in dim_sanctioned_city 

• Blacklisted Countries reference data is available in dim_sanctioned_country  

10.2.2.5.1 Bad BICs Reference Data 

The following columns are available in the template for BICs: 

• Record ID: This column displays the record serial number for the blacklisted BIC. The record ID is 

unique for every BIC. 

• BIC: This column displays the name of the BIC. 

• Details of BIC: This column displays the details of the BIC. 

• Data Source: This column displays the source of the data for the BIC. 

• Risk Score: This column displays the risk score for the BIC. 

Sample Data for Sanctioned BICs 

The following table provides examples based on BICs: 

 

Table 29: Sample Data for Sanctioned BICs 

Record ID BIC Data Source Risk Score 

1 SIIBSYDA OFAC (Office of Foreign Assets Control) 85 

2 FTBDKPPY OFAC (Office of Foreign Assets Control) 90 

3 DCBKKPPY OFAC (Office of Foreign Assets Control) 85 

4 ROSYRU2P OFAC (Office of Foreign Assets Control) 90 

5 INAKRU41 OFAC (Office of Foreign Assets Control) 90 

6 SBBARUMM OFAC (Office of Foreign Assets Control) 90 

 

10.2.2.5.2 Blacklisted Cities Reference Data 

The following columns are available in the template for blacklisted cities: 

• Record ID: This column displays the record serial number for the blacklisted city. The record ID is 

unique for every city. 



ENTERPRISE DATA QUALITY (EDQ) CONFIGURATIONS 

EDQ CONFIGURATION PROCESS FLOW 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  116 

• Country: This column displays the name of the country of the blacklisted city. 

• City: This column displays the name of the blacklisted city. 

• ISO City Code: This column displays the ISO code of the blacklisted city. 

• Data Source: This column displays the source of the data for the blacklisted city. 

• Risk Score: This column displays the risk score for the blacklisted city. 

Sample Data for Sanctioned Cities 

The following table provides examples for blacklisted cities: 

 

Table 30: Sample Data for Sanctioned Cities 

Record ID Country City ISO City Code Data 

Source 

Risk Score 

1 IRAQ ARBIL ABL OFAC 

(Office of 

Foreign 

Assets 

Control) 

90 

2 IRAQ ABU AL FULUS ALF OFAC 

(Office of 

Foreign 

Assets 

Control) 

90 

3 IRAQ AMARA (AL-

AMARAH) 

AMA OFAC 

(Office of 

Foreign 

Assets 

Control) 

85 

4 IRAQ ARAK ARK OFAC 

(Office of 

Foreign 

Assets 

Control) 

90 

 

10.2.2.5.3 Blacklisted Countries Reference Data 

The following columns are available in the template for blacklisted countries: 

• Record ID: This column displays the record serial number for the blacklisted country. The record ID 

is unique for every country. 

• Country: This column displays the name of the blacklisted country. 

• ISO Country Code: This column displays the ISO code of the blacklisted country. 

• Country Synonyms: This column displays the synonyms of the blacklisted country. 

• Data Source: This column displays the source of the data for the blacklisted country. 
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• Risk Score: This column displays the risk score for the blacklisted country. 

Sample Data for Sanctioned Countries 

The following table provides sample data for blacklisted countries: 

 

Table 31: Sample Data for Sanctioned Countries 

Record ID Country ISO Country 

Code 

Country 

Synonyms 

Data Source Risk Score 

1 IRAQ IQ IRAK, REPUBLIC 

OF IRAQ, AL 

JUMHURIYAH 

AL IRAQIYAH, 

AL IRAQ 

OFAC (Office 

of Foreign 

Assets 

Control) 

90 

2 DEMOCRATIC 

REPUBLIC OF 

THE CONGO 

CD CONGO, THE 

DEMOCRATIC 

REPUBLIC OF 

THE 

OFAC (Office 

of Foreign 

Assets 

Control) 

90 

3 AFGHANISTAN AF NA ITAR 

(International 

Traffic in Arms 

Regulations) 

85 

4 ZIMBABWE ZW NA ITAR 

(International 

Traffic in Arms 

Regulations) 

90 

5 CENTRAL 

AFRICAN 

REPUBLIC 

CF NA EAR (Export 

Administration 

Regulations) 

85 

6 BELARUS BY NA EAR (Export 

Administration 

Regulations) 

80 

 

10.2.2.5.4 Stop Keywords Reference Data 

The following columns are available in the template for keywords: 

• Record ID: This column displays the record serial number for the keyword. 

• Stop keyword: This column displays the keyword. 

• Risk Score: This column displays the risk score for the keyword. 

Sample Data for Sanctioned Stop Keywords 

The following table provides examples based on keywords: 
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Table 32: Sample Data for Sanctioned Stop Keywords 

Record ID Stop KeyWords Risk Score 

1 EXPLOSIVE 80 

2 DIAMOND 90 

3 TERROR 80 

4 TERRORIST 85 

5 ARMS 80 

6 NUCLEAR 90 

 

10.2.2.5.5 Goods Prohibition Reference Data 

The following columns are available in the template for prohibited goods: 

• Record ID: This column displays the record serial number for the prohibited good. The record ID is 

unique for every good. 

• Good Code: This column displays the code of the prohibited good. 

• Good Name: This column displays the name of the prohibited good. 

• Good Description: This column displays the description of the prohibited good. 

Sample Data for Prohibited Goods 

The following table provides sample data for prohibited goods: 

 

Table 33: Sample Data for Prohibited Goods 

Record ID Good Code Good Name Good Description 

1 0207 43 00 Fatty livers Fatty livers, fresh or 

chilled 

2 0208 90 10 Ivory CONGO, THE 

DEMOCRATIC 

REPUBLIC OF THE 

3 0209 10 00 Ivory powder and waste NA 

4 3057100 Shark fins NA 

5 4302 19 40 Tiger-Cat skins NA 

 

10.2.2.5.6 Ports Prohibition Reference Data 

The following columns are available in the template for prohibited ports: 

• Record ID: This column displays the record serial number for the prohibited port. The record ID is 

unique for every port. 
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• Country: This column displays the name of the country where the prohibited port is located. 

• Port Name: This column displays the name of the prohibited port. 

• Port Code: This column displays the code of the prohibited port. 

• Port Synonyms: This column displays the synonym of the prohibited port. 

Sample Data for Prohibited Ports 

The following table provides sample data for prohibited ports: 

 

Table 34: Sample Data for Prohibited Ports 

Record ID Country Port Name Port Code Port Synonyms 

1 IRAN, ISLAMIC 

REPUBLIC OF 

KHORRAMSHAHR IR KHO KHORRAMSHAHR 

Port 

2 RUSSIA Sevastopol SMTP Sebastopol,Port 

of Sevastopol 

3 New Zealand Dunedin NZ ORR Otago Harbour 

4 New Zealand Ravensbourne NZ ORR Otago Harbour 

 

10.2.2.6 Extending Prohibition Screening 

Oracle Financial Services Transaction Filtering, as delivered, allows for prohibition screening against 

Nationality and Residency for Individuals and [country of] Operation and [country 

of] Registration for Entities. Additional prohibition types can be added as follows: 

• Create new entries in the prohibition reference data with a new Prohibition Type name, for example, 

"Employment Country". 

• [Batch screening only] Extend the customer data preparation process to create a new attribute, for 

example, dnEmploymentCountryCode. 

• Edit the appropriate screening process, to create the necessary match rules and clusters for the new 

attribute. 
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11 Configuring Risk Scoring Rules 

This chapter provides a brief overview of configuring Risk Scoring Rules for Transaction Filtering. These 

rules are configured in the Inline Processing Engine (IPE). Transaction Filtering has a few ready-to-use 

business rules. The following steps show the pre-configured business rules and how you can create your 

business rules based on the requirements. 

Before you configure the rules, you must update the sequence ID for IPE. To do this, execute the following 

script in the Config schema as a post-installation step: 

Begin p_set_sequence_value('TASKS','5000000','Y'); end; 

For information on the post-installation activities, see the Oracle Financial Services Behavior Detection 

Installation Guide. 

 

NOTE The screenshots shown for these steps are taken for existing 
tables. You can perform similar steps for newly added tables. 

 

To configure rules in IPE, follow these steps: 

1. Navigate to the Financial Services Analytical Applications Transactions Filtering landing page. 

For more information, see the Inline Processing Menu. 

2. Click Inline Processing. The Inline Processing page is displayed.  

The following window shows the Profiles menu. Profiles are an aggregation of information. Profiles 

can be based on different grouping entities (For example, account and customer) and can be 

filtered to only look at specific types of transactions. Profiles can also be based on time (last three 

months) or activity counts (last 100 transactions). For more information on Profiles, see the 

Managing Profiles chapter in the Oracle Financial Services Inline Processing Engine User Guide. 

 

Figure 76: Profiles Menu 

 
 

3. Import data model tables into IPE using the Business Entities sub-menu. A Business Entity is a 

virtual layer that can be added to an existing table. You can add a new business entity and search 

for existing business entities to modify or remove a business entity For more information on 

Business Entities, see the Managing Business Entities section in the Oracle Financial Services 

Inline Processing Engine User Guide. 

To import a table, follow these steps: 

https://docs.oracle.com/cd/E91253_01/install.htm
https://docs.oracle.com/cd/E91253_01/install.htm
https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
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a. Click the Association and Configuration menu, then click the Business Entities sub-menu. 

b. Select the Business Entity you want to import. 

c. Click Import Entity . 

d.  

Figure 77: Import Table Action 

 

By default, all the tables defined for the entity (data model) are displayed. The Entity name is 

displayed in the format <Logical Name>-<Physical Name>. 

 

Figure 78: Entities List 
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e. Select an entity. The Business Entity fields are enabled. You can enter the following details: 

 

Table 35: Business Entity Fields 

Field Description 

Business Name Enter a unique Business Name of the Entity. By default, the Business 

Name is populated as the logical name provided for the Table in the data 

model. The details of this field can be modified. 

Entity Type Select the Entity Type from the drop-down list. The following entity 

types are available:  

• Activity: Select a table as Activity if the data is to be processed by 

IPE as a part of assessment execution. To use Activity as a 

Reference, relevant Inline Datasets and Traversal Paths must be 

created. For example, if wire transactions and cash transactions 

are two activities, then there must be inline datasets created for 

them and a traversal path connecting the two. 

• Reference: Select a table as a Reference if the table has static 

values for IPE. Reference data cannot be processed by IPE. 

• Lookup: Select a table as Lookup if it is used as a scoring table in 

Evaluations. This can be used as a Reference. 

After a table is imported, you cannot change the entity type of the table. 

Processing Segment Select the Processing Segment from the multi-select drop-down list. 

Set Primary Key Attribute Select the Primary Key Attribute from the drop-down list.  

This shows all the columns of the table. This is a unique attribute of the 

table which is imported. It is a mandatory field. 

Composite Primary Keys are not supported. 

Set Sequence ID Attribute Select the sequence ID attribute from the drop-down list. 

Select the sequence ID attribute from the drop-down list. 

This field is enabled if you select Activity as the Entity Type. 

DB Sequence Name Enter the DB sequence name.  

A DB Sequence must be created in the Atomic Schema. The name of 

that Sequence must be provided in this field. 

This field is enabled if you select Activity as the Entity Type. 

Set Processing Status 

Attribute 

Select the processing status attribute from the drop-down list.  

This attribute is updated by IPE to indicate if the assessment has passed 

or failed. 

This field is enabled if you select Activity as the Entity Type. 

Set Processing Period 

Attribute 

Select the processing period attribute from the drop-down list.  

This attribute defines the date or time when the activity has occurred. 

For example, Transaction Time. 

This field is enabled if you select Activity as the Entity Type. 

Score Attribute This field is enabled ONLY if you select Lookup as the Entity Type. 

Select the Score Attribute from the drop-down list.  

This attribute can be used in evaluation scoring. 
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f. Click Save. 

4. Add a business entity. To do this, follow these steps: 

a. In the Business Entities sub-menu, select an entity from the Entity Name drop-down. 

 

Figure 79: Entities List 

 
 

b. Click Add. 

5. Provide the name, processing segment, and score attribute for the business entity. 

 

Figure 80: Business Entity attributes 

 
 

6. Click Add. The new parameter is added to the list of Business Entities on the Business Entities 

page.  

7. Add a join in IPE from the Inline Datasets sub-menu in the Association and Configuration menu. 

Inline Datasets are joins between two Business Entities. When you create an Inline Dataset, you 

must define at least one join. 

To add a join, follow these steps: 

a. On the Inline Datasets page, click Add. 
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Figure 81: Inline Datasets page 

 
 

b. Enter a name for the inline dataset.  

c. In the Start Table field, select the start table of the join. 

d. In the End Table field, select the end table of the join. 

 

Figure 82: Inline Datasets Attributes 

 
 

e. Click Add. 

f. Click Save. The new dataset is added to the list of Inline Datasets on the Inline Datasets page. 

For more information on inline datasets, see the Managing Inline Datasets section in the 

Oracle Financial Services Inline Processing Engine User Guide. 

8. Add a traversal path for each join defined in the Inline Datasets sub-menu. Traversal paths are the 

paths between two or more entities. The traversal paths defined can be used to create expressions, 

evaluations, and profiles. 

To add a traversal path, follow these steps: 

a. Click the Traversal Paths sub-menu in the Association and Configuration menu. 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
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b. On the Traversal Paths page, click Add. 

 

Figure 83: Traversal Paths Page 

 
 

c. Enter a name for the traversal path.  

d. In the Start Table field, select the same start table that you selected in step c.  

e. In the End Table field, select the same end table that you selected in step d. 

 

Figure 84: Traversal Paths Attributes 

 
 

a. Click Add. 

b. Select the values for the traversal path flow as shown in the figure. 

c. Click Save. The new path is added to the list of traversal paths on the Traversal Paths page. For 

more information on traversal paths, see the Managing Traversal Paths section in the Oracle 

Financial Services Inline Processing Engine User Guide.  

https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf


CONFIGURING RISK SCORING RULES 

EDQ CONFIGURATION PROCESS FLOW 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  126 

9. Add an Expression on the risk score column of the newly created business entity which is to be 

scored as a risk parameter from the Expressions menu. An expression is used as a filter when 

creating evaluations or profiles. Expressions must only be created on the activity table on which an 

evaluation is created. 

In this example, two expressions are created. The first expression is for the column which holds the 

value of the new risk parameter, and the second expression is for the calculations that are needed 

to derive the risk score 

To add an expression, follow these steps: 

a. Click the Expressions menu. 

b. On the Expressions page, click Add. 

 

Figure 85: Expressions Page 

 
 

c. For the first expression, enter a name for the expression and select the values as shown in the 

figure. 
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Figure 86: First Expression Attributes 

 
 

d. Select the business entity and the business attribute where the value of the new parameter 

resides. 

e. Click the Save icon. The variable is displayed on the window. 

 

Figure 87: First Expression Displayed 

 
 

f. For the second expression, enter a name for the expression and select the values as shown in 

the figure. 
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Figure 88: Second Expression Attributes 

 
 

g. Click the Save icon. The variable is displayed. 

 

Figure 89: Second Expression Displayed 

 
 

For information on applying a function to the group or expression, see the Managing Expressions 

chapter in the Oracle Financial Services Inline Processing Engine User Guide. 

 

h. Click Submit. The new expression is added to the list of expressions on the Expressions page. 

10. Add the following ready-to-use evaluations from the Evaluations Menu. Evaluations are logical 

comparisons against conditions that result in a score. For information on the conditions, see the 

Managing Evaluations section in the Oracle Financial Services Inline Processing Engine User 

Guide. 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
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You can define new rules according to your requirement using the expressions defined in the earlier 

steps. 

a. ISO20022 Risk-Currency VS Amount Threshold Evaluation 

For all filter conditions mentioned in the following table, if the filter values are met as 

configured then add a risk score of 20. 

 

NOTE • This evaluation applies to the ISO message category. 

• This score is configurable. 

 

Table 36: ISO20022 Risk-Currency VS Amount Threshold Evaluation Filters 

Sl.No Filter Name  Filter Clause 

1.  Batch ID ( Message Data Attributes:V_BATCH_RUN_ID ) = BATCH RUN ID 

2.  Amount ( Message Data Attributes:N_CNTRL_SUM_AMT ) >= 10000 

3.  Currency ( Transaction Tag Attributes:V_ CURRENCY ) = 'EUR' 

 

b. Risk- High Risk Party Evaluation 

For all filter conditions mentioned in the following table, if the filter values are met as configured 

then add a risk score of 40. 

 

Table 37: Risk- High-Risk Party Evaluation Filters 

Sl.No Filter Name  Filter Clause 

1.  Beneficiary Account Number ( Message Tag Table:V_BENF_ACC_NO) = ( Rule 

Configuration Table:V_COND1) 

2.  Rule Name ( Rule Configuration Table:V_RISK_RULE_CODE) =  

'TF_HIGH_RSK_PARTY' 

3.  Message Type ( Real Time Raw Data:V_GRP_MSG_TYPE) =  'MT700' 

4.  Direction ( Message Tag Table:V_DIRECTION) in (('INBOUND', 

'OUTBOUND')) 

 

c. Risk-Currency VS Amount Threshold Evaluation 

For all filters conditions mentioned in the following table, if the filter values are met as configured 

then add a risk score of 25. 

 

NOTE This score is configurable. 
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Table 38: Risk-Currency VS Amount Threshold Evaluation Filters 

Sl.No Filter Name  Filter Clause 

1.  Message Type  ( Real Time Raw Data:V_GRP_MSG_TYPE) in ('MT101', 'MT103', 

'MT202COV', 'MT202') 

2.  Jurisdiction ( Real Time Raw Data:V_BIC_CODE) =  'CHASUS33XXX' 

3.  Direction ( Message Tag Table:V_DIRECTION) in ('INBOUND','OUTBOUND') 

4.  Currency ( Message Tag Table:V_CURRENCY) =  'USD' 

5.  Amount ( Message Tag Table:V_AMOUNT) >=  10000 

 

d. Risk-Currency VS Destination Country Evaluation 

For all filters conditions mentioned in the following table, if the filter values are met as configured 

then add a risk score of 20. 

This evaluation works with reference table SETUP_RULE_CONFIGURATION, which is another way of 

configuring evaluation or risk scoring rule. This evaluation is done using one of the lookup tables 

from the database. Similarly, you can add more rules using the same table where columns are 

generalized. 

 

Table 39: Risk-Currency VS Destination Country Evaluation Filters 

Sl.No Filter Name  Filter Clause 

1.  Currency  ( Message Tag Table:V_CURRENCY) = ( Rule Configuration 

Table:V_COND1) 

2.  Destination Country ( Message Tag Table:V_DESTINATION_CNTRY) = ( Rule 

Configuration Table:V_COND2) 

3.  Direction ( Message Tag Table:V_DIRECTION) in ('INBOUND','OUTBOUND') 

4.  Message Type ( Real Time Raw Data:V_GRP_MSG_TYPE) = ( Rule Configuration 

Table:V_TXN_TYPE_CD) 

5.  Rule Name ( Rule Configuration Table:V_RISK_RULE_CODE) =  

'TF_CCY_CTRY_RSK' 

 

e. Risk-High Risk Destination Country Evaluation 

For all filters conditions mentioned in the following table, if the filter values are met as configured 

then add a risk score of 20. 

 

NOTE This score is configurable. 
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Table 40: Risk-High Risk Destination Country Evaluation Filters 

Sl.No Filter Name  Filter Clause 

1.  Amount ( Message Tag Table:V_AMOUNT) >=  10000 

2.  Currency ( Message Tag Table:V_CURRENCY) =  'EUR' 

3.  Destination Country ( Message Tag Table:V_DESTINATION_CNTRY) in ('TH', 'PK') 

4.  Direction ( Message Tag Table:V_DIRECTION) =  'OUTBOUND' 

5.  Message Type ( Real Time Raw Data:V_GRP_MSG_TYPE) in ('MT101', 

'MT103', 'MT202COV', 'MT202') 

 

f. Risk-High Risk Originator Country Evaluation 

For all filters conditions mentioned in the following table, if the filter values are met as configured 

then add a risk score of 20. 

 

NOTE This score is configurable. 

 

Table 41: Risk-High Risk Originator Country Evaluation Filters 

Sl.No Filter Name  Filter Clause 

1.  Amount ( Message Tag Table:V_AMOUNT) >=  10000 

2.  Currency ( Message Tag Table:V_CURRENCY) =  'EUR' 

3.  Message Type  ( Real Time Raw Data:V_GRP_MSG_TYPE) in ('MT101', 'MT103', 

'MT202COV', 'MT202') 

4.  Direction ( Message Tag Table:V_DIRECTION) =  'INBOUND' 

5.  Originator Country ( Message Tag Table:V_ORIGINATOR_CNTRY) in ('PK', 'TH') 

 

g. Risk-Trade Amendments Evaluation 

For all filters conditions mentioned in the following table, if the filter value conditions are met as 

configured then add a risk score of 20. 

 

NOTE This score is configurable. 

 

Table 42: Risk-Trade Amendments Evaluation Filters 

Sl.No Filter Name  Filter Clause 

1.  Message Type  ( Real Time Raw Data:V_GRP_MSG_TYPE) =  'MT707' 
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Sl.No Filter Name  Filter Clause 

2.  Direction ( Message Tag Table:V_DIRECTION) in 

(('INBOUND','OUTBOUND')) 

3.  Number of Amendments ( Message Tag Table:N_NUMBER_OF_AMENDMENT) 

>=  5 

 

h. Risk-WatchList Screening Evaluation 

This evaluation or risk rule returns the match score generated from the matching engine. In the 

case of multiple matches for a given message, it returns the maximum match score. The matching 

rules are configured with different match scores in EDQ. 

 

NOTE • This evaluation applies to the SWIFT message 
category. 

• This score is configurable. 

 

i. Watch List Score 

This evaluation or risk rule watch list response score. The matching rules are configured with 

different match scores in EDQ. 

 

NOTE • This evaluation applies to the ISO message category. 

• This score is configurable. 

 

Table 43: Watch List Score Filters 

Sl.No Filter Name  Filter Clause 

1.  Watch List Score (Get Max Watch List Score(( Name Addr Screening 

Response:N_MATCH_SCORE),Goods Score,Country and City 

Score,BIC Score,Ports Score,Narrative Score)) >  50 

2.  Batch Run ID ( Message Data Attributes:V_BATCH_RUN_ID) =  

:BATCH_RUN_ID 

 

To add an evaluation, follow these steps: 

a. Click the Evaluations menu. 

b. On the Evaluations page, click Add. 

 



CONFIGURING RISK SCORING RULES 

EDQ CONFIGURATION PROCESS FLOW 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  133 

Figure 90: Evaluations Page 

 
 

c. Enter a name for the evaluation.  

d. Select an activity for the evaluation and the Transaction Filtering processing segment. 

 

Figure 91: Evaluations Attributes 

 

 

e. To add a filter for the evaluation, click Add.  

f. Select the expression as mentioned in step f. 

 

Figure 92: Evaluations Filters 

 
 



CONFIGURING RISK SCORING RULES 

EDQ CONFIGURATION PROCESS FLOW 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  134 

g. Click Save. The new evaluation is added to the list of evaluations on the Evaluations page.  

11. Create an Assessment for the ready-to-use evaluations. The Assessments checks the logic of all the 

evaluations and considers the sum of all the Evaluations for the output score. 

12.  

 

NOTE You can adjust the risk score for any given evaluation 
depending on the requirement, but it must be within 40, 
because match rule score configuration starts with 45, and 
match score must always have high weightage than the 
individual evaluation risk score. 

 

The risk score is calculated at the assessment level is as follows: 

▪ The total risk score of a message is the sum of all risk scores derived from configured 

evaluations or risk rules including match score.  

▪ In the case of multiple transactions, the risk score is the sum of all risk scores derived from 

different evaluations across transactions. 

▪ If the same evaluation is true for multiple transactions within a message, then the score is 

considered once and the maximum one is considered.  

▪ If different evaluations are true for different transactions, then it sums up all the risk scores 

across transactions within a message. 

To add an Assessment, follow these steps: 

a. Click the Assessments menu.  

 

Figure 93: Assessments Page 

 
 

b. On the Assessments page, click Add. 

The following image shows the evaluations for the Transaction Filtering Assessment: 
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Figure 94: Assessments Attributes 

 
 

The following image shows the evaluations for the Transaction Filtering ISO20022 

Assessment: 
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Figure 95: Sample Assessment 

 
 

c. Provide the assessment name, activity, processing segment, assessment scoring method, and 

change description for the assessment. 

d. Click Save. The new assessment is added to the list of assessments on the Assessments page. 

For more information on assessments, see the Managing Assessments section in the Oracle 

Financial Services Inline Processing Engine User Guide. 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.9.x/8.0.9.0.0/OFS_IPE_User_Guide_8.0.9.0.0.pdf
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12 Creating a JSON 

Transaction Filtering allows you to add new SWIFT message types and configure the messages by 

uploading a JSON for a given message type followed by few configurations using the admin UI window. A 

new JSON is required for each new SWIFT message type and for editing any existing message type. JSON 

follows SWIFT message standards given in the SWIFT document. JSON file must be .txt or .json 

extensions only. 

This chapter explains how to create a JSON for SWIFT messages with sequences and SWIFT messages 

without sequences.  

 

NOTE For information on how to upload a JSON, see the Adding or 
Updating a New Message Type section. 

 

12.1 Structure of a JSON 

The following example shows the structure of a JSON: 

{ 

  "message": [ 

    { 

      "attr": { 

        "id": "t1", 

        "field": "Basic Header Block", 

        "status": "", 

        "fieldName": "", 

        "expression": "", 

        "editable": "N" 

      }, 

      "children": [ 

        { 

          "attr": { 

            "id": "t1:1", 

            "field": "", 

            "status": "", 

            "fieldName": "Block Identifier", 

            "expression": "", 

            "editable": "Y", 

            "size": "1" 

          } 
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        } 

      ] 

   } 

 ] 

} 

Each JSON must start with a message element. Every message" element is a list of attr elements. 

Each field/tag in the JSON must be represented by attr. Every attr element in the JSON can have the 

following properties: 

• ID: A unique value that identifies each element 

• Field: Name of the element as per the Swift document, used at the parent level. 

• Status: It can hold either "M" or "O" ("M" - mandatory, "O" - optional) 

• FieldName: Name of the element as per the Swift document, used at child level. 

• Expression: Swift expression as per the Swift document 

• Editable: It can hold either "Y" or "N" ("Y" - editable in Admin UI, "N" - non-editable in Admin UI) 

• Size: This property is applicable for Swift Block 1, Swift Block 2 where data is only positional, that is, 

there is no swift expression for the element 

 

For example: 

• The following attr element represents the Swift Block Name: 

{ 

 "attr": 

   { 

    "id":"t1", 

    "field":"Basic Header Block", 

    "status":"", 

    "fieldName":"", 

    "expression":"", 

    "editable":"N" 

   } 

} 

• The following attr element represents the Swift Block Tag with a size property: 

  

NOTE The expression property must be blank for positional elements. 

 

{ 

 "attr": 
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   { 

    "id":"t1:1", 

    "field":"", 

    "status":"", 

    "fieldName":"Block Identifier", 

    "expression":"", 

    "editable":"Y", 

    "size":"1" 

   } 

} 

• The following attr element represents the Swift Block Tag with an expression property: 

{ 

 "attr": 

   { 

    "id":"t4:1:2:5:2:1", 

    "field":"", 

    "status":"", 

    "fieldName":"Party Identifier", 

    "expression":"35x", 

    "editable":"Y" 

   } 

} 

 

Each attr element in the JSON can have one or more child attributes. Child is used as a notation to identify 

the children of a particular attr element. 

 

{ 

  "attr": { 

    "id": "t1", 

    "field": "Basic Header Block", 

    "status": "", 

    "fieldName": "", 

    "expression": "", 

    "editable": "N" 

  }, 

  "children": [ 

    { 
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      "attr": { 

        "id": "t1:1", 

        "field": "", 

        "status": "", 

        "fieldName": "Block Identifier", 

        "expression": "", 

        "editable": "Y", 

        "size": "1" 

      } 

    }, 

    .......... 

 ] 

} 

12.2 Creating JSON for SWIFT Messages with Sequences 

To create a JSON, follow these steps: 

1. Creating Message Elements 

2. Configuring SWIFT Message Blocks 

12.2.1 Creating Message Elements 

To create a message element, use the following sample code: 

{ 

  "message": [ 

  { 

    Requires tags  ... 

  } 

  ] 

} 

12.2.2 Configuring SWIFT Message Blocks 

To configure a SWIFT message block, follow these steps: 

1. Configure the Basic Header Block. See Configuring the Basic Header Block. 

2. Configure the Application Header Block. See Configuring the Application Header Block. 

3. Configure the User Header Block. See Configuring the User Header Block. 

4. Configure the Text Block. See Configuring the Text Block. 

5. Configure the Trailer Block. See Configuring the Trailer Block. 
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12.2.2.1 Configuring the Basic Header Block 

To configure a User Header Block, follow these steps: 

1. Create an attr element node with fieldName property as the Basic Header Block and editable 

property as N. 

2. Create a child element with the required attr elements that must be part of the Basic Header Block. 

{ 

  "attr": { 

    "id": "t1", 

    "field": "Basic Header Block", 

    "status": "", 

    "fieldName": "", 

    "expression": "", 

    "editable": "N" 

  }, 

  "children": [ 

    { 

      "attr": { 

        "id": "t1:1", 

        "field": "", 

        "status": "", 

        "fieldName": "Block Identifier", 

        "expression": "", 

        "editable": "Y", 

        "size": "1" 

      } 

    }, 

     

  ] 

} 

12.2.2.2 Configuring the Application Header Block 

To configure an Application Header Block, follow these steps: 

1. Create an attr element node with fieldName property as Application Header Block and editable 

property as N. 

2. Create a child element with two attr elements with fieldName property as Application Header - 

Input and Application Header - Output and editable property as N. 
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3. Create a child element with the required attr elements that must be part of Application Header - 

Input and Application Header - Output. 

{ 

  "attr": { 

    "id": "t2", 

    "field": "Application Header Block", 

    "status": "", 

    "fieldName": "", 

    "expression": "", 

    "editable": "N" 

  }, 

  "children": [ 

    { 

      "attr": { 

        "id": "t2:1", 

        "field": "Application Header - Input", 

        "status": "", 

        "fieldName": "", 

        "expression": "", 

        "editable": "N" 

      }, 

      "children": [ 

        { 

          "attr": { 

            "id": "t2:1:1", 

            "field": "", 

            "status": "", 

            "fieldName": "Block Identifier", 

            "expression": "", 

            "editable": "Y", 

            "size": "1" 

          } 

        }, 

  ................... 

      ] 

    }, 

    { 
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      "attr": { 

        "id": "t2:2", 

        "field": "Application Header - Output", 

        "status": "", 

        "fieldName": "", 

        "expression": "", 

        "editable": "N" 

      }, 

      "children": [ 

        { 

          "attr": { 

            "id": "t2:2:1", 

            "field": "", 

            "status": "", 

            "fieldName": "Block Identifier", 

            "expression": "", 

            "editable": "Y", 

            "size": "1" 

          } 

        }, 

  ................... 

      ] 

    } 

  ] 

} 

12.2.2.3 Configuring the User Header Block 

To configure a User Header Block, follow these steps: 

1. Create an attr element node with fieldName property as the User Header Block and editable 

property as N. 

2. Create a child element with the required attr elements that must be part of the User Header Block. 

{ 

  "attr": { 

    "id": "t3", 

    "field": "User Header Block", 

    "status": "", 

    "fieldName": "", 
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    "expression": "", 

    "editable": "N" 

  }, 

  "children": [ 

    { 

      "attr": { 

        "id": "t3:1", 

        "field": "", 

        "status": "", 

        "fieldName": "Block Identifier", 

        "expression": "", 

        "editable": "Y" 

      } 

    }, 

 ................... 

  ] 

} 

12.2.2.4 Configuring the Text Block 

To configure a Text Block, follow these steps: 

1. Create an attr element node with fieldName property as Text Block and editable property as N. 

2. Create a child element with attr element having fieldName property as Sequences and editable 

property as N. 

3. Create a child element with the required attr elements that represent individual Sequence (that is, 

Sequence <X>, where X can be A, B, or C) that must be part of Sequences. 

{ 

  "attr": { 

    "id": "t4",  

    "field": "Text Block", 

    "status": "", 

    "fieldName": "", 

    "expression": "", 

    "editable": "N" 

  }, 

  "children": [ 

    { 

      "attr": { 

        "id": "t4:1", 
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        "field": "Sequences", 

        "status": "", 

        "fieldName": "", 

        "expression": "", 

        "editable": "N" 

      }, 

      "children": [ 

        { 

          "attr": { 

            "id": "t4:1:1", 

            "field": "Sequence A", 

            "status": "", 

            "fieldName": "", 

            "expression": "", 

            "editable": "N" 

          }, 

          "children": [ 

            { 

              "attr": { 

                "id": "t4:1:1:1", 

                "field": "20", 

                "status": "M", 

                "fieldName": "Sender's Reference", 

                "expression": "16x", 

                "editable": "Y" 

              } 

            }, 

   ............... 

          ] 

        }, 

        { 

          "attr": { 

            "id": "t4:1:2", 

            "field": "Sequence B", 

            "status": "", 

            "fieldName": "", 

            "expression": "", 
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            "editable": "N" 

          }, 

          "children": [ 

            { 

              "attr": { 

                "id": "t4:1:2:1", 

                "field": "21", 

                "status": "M", 

                "fieldName": "Transaction Reference", 

                "expression": "16x", 

                "editable": "Y" 

              }, 

     ............... 

            } 

          ] 

        } 

      ] 

    } 

  ] 

} 

12.2.2.5 Configuring the Trailer Block 

To configure the Trailer Block, follow these steps: 

1. Create an attr element node with fieldName property as Trailer Block and editable property as N. 

2. Create a child element with the required attr elements that must be part of Trailer Block. 

{ 

  "attr": { 

    "id": "t5", 

    "field": "Trailer Block", 

    "status": "", 

    "fieldName": "", 

    "expression": "", 

    "editable": "N" 

  }, 

  "children": [ 

    { 

      "attr": { 
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        "id": "t5:1", 

        "field": "CHK", 

        "status": "M", 

        "fieldName": "Checksum", 

        "expression": "", 

        "editable": "Y" 

      } 

    }, 

 .............. 

  ] 

} 

 

12.2.3 Example of MT101 with Sequences 

To see examples of MT101 with sequences, see MOS Document 2329509.1. 

12.2.4 Creating a JSON for the 3xx, 5xx, and 6xx Message Types 

The following sample JSONs show the JSON format for the MT3xx, MT5xx, and MT6xx message types: 

12.2.4.1 Sample JSON 1 

The following example contains the JSON for a message type which has the sequence displayed on the 

SWIFT website: 

"attr": { 

                "id": "t4:1:1", 

                "field": "Sequence A", 

                "status": "M",       <!--Highlighed Part---!>(Mandatory) 

                "fieldName": "", 

                "expression": "", 

                "editable": "Y", 

                "identifierTag": "16R" <!--Highlighed Part---!>(Mandatory) 

                                }"children": [ 

                { 

                  "attr": { 

                    "id": "t4:1:1:1", 

                    "field": "16R", 

                    "status": "M", 

                    "fieldName": "Start of Block", 

                    "expression": "", 

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=179616680891140&parent=AWIZ_SUBMIT&id=2329509.1&_afrWindowMode=0&_adf.ctrl-state=ak9ki7kpu_4#aref_section21
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                    "editable": "Y", 

                    "lov": [ 

                      "GENL" 

                    ], 

                    

                  } 

                }, 

                { 

                  "attr": { 

                    "id": "t4:1:1:2", 

                    "field": "28E", 

                    "status": "M", 

                    "fieldName": "Page Number/Continuation Indicator", 

                    "expression": "5n/4!c", 

                    "editable": "Y", 

                     

                  } 

                } 

                                                                ] 

If the message contains the sequence mentioned on the SWIFT website, then you must add an identifier 

tag into that sequence. The identifier tag must be the tag name of the first child in that sequence. You 

must also provide the sequence status: if the status is Mandatory, the value must be “M”, and if the status 

is Optional, the value must be “O”. 

12.2.4.2 Sample JSON 2 

The following example contains the JSON for a message type which has a subsequence available under a 

sequence: 

{ 

                  "attr": { 

                    "id": "t4:1:1:9", 

                    "field": "Subsequence A1", 

                    "status": "O",<!---Highlighted Part-----!>(Mandatory) 

                    "fieldName": "", 

                    "expression": "", 

                    "editable": "Y", 

                    "isGroup": "Y",  <!---Highlighted Part-----!>(Mandatory) 

                    "isGroupIdenPresent": "Y" <!---Highlighted Part-----

!>(Mandatory) 

        } 
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If a subsequence is available under a sequence, you must provide the sequence status: if the status is 

Mandatory, the value must be “M”, and if the status is Optional, the value must be “O”. 

12.3 Creating JSON for SWIFT Messages without Sequences 

To create a JSON, follow these steps: 

1. Creating Message Elements 

2. Configuring SWIFT Message Blocks 

12.3.1 Creating Message Elements 

To create a message element, use the following sample code: 

{ 

  "message": [ 

  { 

    Requires tags  ... 

  } 

  ] 

} 

12.3.2 Configuring SWIFT Message Blocks 

To configure a SWIFT message block, follow these steps: 

1. Configure the Basic Header Block. See Configuring the Basic Header Block. 

2. Configure the Application Header Block. See Configuring the Application Header Block. 

3. Configure the User Header Block. See Configuring the User Header Block. 

4. Configure the Text Block. See Configuring the Text Block. 

5. Configure the Trailer Block. See Configuring the Trailer Block. 

12.3.2.1 Configuring the Text Block 

To configure the text block, follow these steps: 

1. Create an attr element node with fieldName property as Text Block and editable property as N. 

2. Create a children element with the required attr elements that must be part of Text Block. 

{ 

  "attr": { 

    "id": "t4", 

    "field": "Text Block", 

    "status": "", 

    "fieldName": "", 
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    "expression": "", 

    "editable": "N" 

  }, 

  "children": [ 

    { 

      "attr": { 

        "id": "t4:1", 

        "field": "20", 

        "status": "M", 

        "fieldName": "Sender's Reference", 

        "expression": "16x", 

        "editable": "Y" 

      } 

    }, 

 .......... 

  ] 

} 

12.3.3 Example of MT101 without Sequences 

To see examples of MT101 with sequences, see 2329509.1. 

12.3.4 Creating a JSON for the Nxx Message Types 

The following sample JSON shows the JSON format for the N92, N95, and N96 message types: 

{ 

          "attr": { 

            "id": "t4:7:2", 

            "field": "Additional Data", 

            "status": "O", 

            "fieldName": "Extra Information", 

            "expression": "100*100z", 

            "editable": "Y", 

            "ignoreColon": "Y" 

          } 

        } 

The following sample JSON shows the JSON format to add for tag 77E for the N98 message type: 

 

{ 

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=179616680891140&parent=AWIZ_SUBMIT&id=2329509.1&_afrWindowMode=0&_adf.ctrl-state=ak9ki7kpu_4#aref_section21
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          "attr": { 

            "id": "t4:3", 

            "field": "77E", 

            "status": "", 

            "fieldName": "Proprietary Message", 

            "expression": "", 

            "editable": "Y", 

            "ignoreColon": "Y" 

          }, 

          "children": [ 

            { 

              "attr": { 

                "id": "t4:3:1", 

                "field": "77E", 

                "status": "M", 

                "fieldName": "", 

                "expression": "", 

                "editable": "Y", 

                "ignoreColon": "Y" 

              }, 

              "children": [ 

                { 

                  "attr": { 

                    "id": "t4:3:1:1", 

                    "field": "", 

                    "status": "", 

                    "fieldName": "(Text1)", 

                    "expression": "73z", 

                    "editable": "Y", 

                    "regex": "\\A((?<G1>[\\w|\\.|\\,|\\-

|\\(|\\)|\\/|\\=|\\'|\\+|\\:|\\?|\\!|\\\"|\\%|\\&|\\*|\\<|\\>|\\;|\\@|\\#| 

]{1,73})(\\r\\n|\\n|\\r|$))" 

                  } 

                }, 

                { 

                  "attr": { 

                    "id": "t4:3:1:2", 

                    "field": "", 
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                    "status": "", 

                    "fieldName": "(Text2)", 

                    "expression": "78*78z", 

                    "editable": "Y", 

                    "regex": "\\A(?<M>((?<G1>s*[\\w|\\.|\\,|\\-

|\\(|\\)|\\/|\\=|\\'|\\+|\\:|\\?|\\!|\\\"|\\%|\\&|\\*|\\<|\\>|\\;|\\@|\\#| 

]{1,78})(\\r\\n|\\n|\\r|$)){1,78})\\Z" 

                  } 

                } 

              ] 

            } 

          ] 

        } 

For the N98 message type, you must copy at least the mandatory fields of the original message: 

{1:F01FSABLBBXAXXX0431806794}{2:O1952203181212BCITITMMDXXX56471423671812130747N

}{4: 

:20:BILADDB25388145 

:21:FEE STATEMENT 

:75:00800100144503486 

:32D:181217EUR1342, 

:71B:/COMM/ 

//XXXXX ON YR CASH ACTIVITY FROM 

//181101 TO 181130 AS PER OUR FEE 

//STATEMENT XXXXX YOU TODAY, 

//Full XXXXX XXXXXX on ISP 

//Website XXXXXX to Fin.Inst. 

-}{5:{MAC:44544500}{CHK:3924074D35D3}{DLM:}}{S:{SAC:}{COP:S}} 

In the above example, the mandatory fields are: 

:20:BILADDB25388145 

:21:FEE STATEMENT 

:75:00800100144503486 

The remaining fields are optional.  

12.4 Creating JSON for SWIFT messages with the List of 
Values (LOV) Attribute 

According to SWIFT standards, if there is a tag which contains predefined codes, then we must prepare a 

List of Values (LOV) attribute for the SWIFT tag. The following shows a JSON with an LOV attribute: 

{ 
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                  "attr": { 

                    "id": "t4:14:2:2", 

                    "field": "", 

                    "status": "", 

                    "fieldName": "Code", 

                    "expression": "14x", 

                    "regex": "", 

                    "editable": "Y", 

                    "lov": [ 

                      "BY ACCEPTANCE", 

                      "BY DEF PAYMENT", 

                      "BY MIXED PYMT", 

                      "BY NEGOTIATION", 

                      "BY PAYMENT" 

                    ] 

                  } 

                } 
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13 Appendix A: Watch Lists 

Monitoring transactions against watch lists of sanctioned individuals and companies, internal watch lists, 

and other commercial lists of high-risk individuals and organizations is a key compliance requirement for 

financial institutions worldwide. These watch lists help financial institutions identify customers who are 

sanctioned, live in sanctioned countries and any inbound or outbound transactions associated with these 

customers.  

13.1 HM Treasury Watch List 

The HM Treasury publishes a sanctions list that can be used for screening in Transaction Filtering. The 

sanctions list provides a consolidated list of targets listed by the United Nations, the European Union, and 

the United Kingdom under legislation relating to current financial sanctions regimes. For more 

information, see the HM Treasury website. 

Oracle Transaction Filtering uses the list in a semi-colon delimited form. It can be downloaded from the 

following location: 

https://ofsistorage.blob.core.windows.net/publishlive/ConList.csv 

13.2 OFAC Watch List 

The US Treasury website states that The US Treasury's Office of Foreign Assets Control (OFAC) 

administers and enforces economic and trade sanctions based on US foreign policy and national security 

goals against targeted foreign countries, terrorists, international narcotics traffickers, and those engaged 

in activities related to the proliferation of weapons of mass destruction. For more information, see the 

Treasury website. 

Oracle Transaction Filtering supports two lists that are produced by OFAC. The OFAC Specially Designated 

Nationals (SDN) list, which is available for download in three separate parts from the following links: 

https://www.treasury.gov/ofac/downloads/sdn.csv 

https://www.treasury.gov/ofac/downloads/add.csv 

https://www.treasury.gov/ofac/downloads/alt.csv 

The OFAC Consolidated Sanctions List, which can be downloaded in three separate parts from the 

following links: 

https://www.treasury.gov/ofac/downloads/consolidated/cons_prim.csv 

https://www.treasury.gov/ofac/downloads/consolidated/cons_add.csv 

https://www.treasury.gov/ofac/downloads/consolidated/cons_alt.csv 

13.3 EU Watch List 

The European Union applies sanctions or restrictive measures in pursuit of the specific objectives of the 

Common Foreign and Security Policy (CFSP) as set out in Article 11 of the Treaty on European Union. 

The European Commission offers a consolidated list containing the names and identification details of all 

persons, groups, and entities targeted by these financial restrictions. For more information, see the 

European Commission website. 

https://www.gov.uk/government/publications/financial-sanctions-consolidated-list-of-targets
https://ofsistorage.blob.core.windows.net/publishlive/ConList.csv
http://www.treasury.gov/ofac/
https://www.treasury.gov/ofac/downloads/sdn.csv
https://www.treasury.gov/ofac/downloads/add.csv
https://www.treasury.gov/ofac/downloads/alt.csv
https://www.treasury.gov/ofac/downloads/consolidated/cons_prim.csv
https://www.treasury.gov/ofac/downloads/consolidated/cons_add.csv
https://www.treasury.gov/ofac/downloads/consolidated/cons_alt.csv
http://eeas.europa.eu/cfsp/sanctions/index_en.htm
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To download the consolidated list: 

1. Go to https://webgate.ec.europa.eu/europeaid/fsd/fsf#!/account. 

2. Create an account.  

3. Navigate to https://webgate.ec.europa.eu/europeaid/fsd/fsf#!/files and open show settings for 

crawler/robot.  

4. Copy the URL for 1.0 XML (Based on XSD). This is in the format 
https://webgate.ec.europa.eu/europeaid/fsd/fsf/public/files/xmlFullSanctio

nsList/content?token=[username]. You must replace the [username] placeholder with the 

user name you have created. 

5. Enter this URL in your run profile or download the task. 

13.4 UN Watch List 

The United Nations (UN) or United Nations Security Council consolidated list is a watch list that includes all 

individuals and entities who are subject to sanctions measures imposed by the Security Council. For more 

information, see the UN Security Council website. 

Download the consolidated list from 

https://www.un.org/sc/suborg/sites/www.un.org.sc.suborg/files/consolidated.xml. 

13.5 World-Check Watch List 

World-Check provides a subscription-based service, offering a consolidated list of PEPs (Politically 

Exposed Persons) and entities and individuals appearing on the HM Treasury, OFAC, and other world lists.  

Three levels of subscription are provided: Standard, Premium, and Premium+. Some features of the 

World-Check lists are only available to users with a higher subscription level. For more information, see 

the World-Check website. 

To download the World-Check Premium+ feed, set values in the WC Setup section of the watch list-

management. properties run profile as follows: 

phase.WC\ -\ Download.enabled = Y 

phase.WC\ -\ Download\ native\ aliases.enabled = Y 

phase.WC\ -\ Stage\ reference\ lists.enabled = Y 

phase.*.snapshot.*.use_native_aliases = 1 

To download the Standard or Premium feeds, set values in the WC Setup section of the watchlist-

management.properties run profile as follows: 

phase.WC\ -\ Download.enabled = Y 

phase.WC\ -\ Download\ native\ aliases.enabled = N 

phase.WC\ -\ Stage\ reference\ lists.enabled = Y 

phase.*.snapshot.*.use_native_aliases = 0 

See the World-Check website for more details: https://risk.thomsonreuters.com/en/products/third-

party-risk/world-check-know-your-customer.html 

 

https://webgate.ec.europa.eu/cas/login?loginRequestId=ECAS_LR-8844270-0wsC3zVowdG8iNxCtFzeLg5Kc2Rq9hTemqqpfgTrq7xZw8NFzepVtzip74LoVg6vC6v1SgJ1zToaXHYuvdthzzM4-jpJZscgsw0KaEwGAvEFBby-leZcT2IxQBhP6ZUiXzHLM9pYERAPzpUCzGGiQf0zYwR5#!/account
https://webgate.ec.europa.eu/cas/login?loginRequestId=ECAS_LR-8846806-L85CwDcx1RG1TUhGfPniYhERmLZ4B19CWA1bn5RFQnH26rSjkvWeza1avzbxL9K6GJDzLggChY9mUVwIzU2mx6K-jpJZscgsw0KaEwGAvEFBby-CMbClqk7umLxegFaW6ztitzNxbnvCp3yqnVHBzKKLW08#!/files
https://www.un.org/sc/suborg/en/sanctions/un-sc-consolidated-list
https://www.un.org/sc/suborg/sites/www.un.org.sc.suborg/files/consolidated.xml
https://risk.thomsonreuters.com/en/products/third-party-risk/world-check-know-your-customer.html
https://risk.thomsonreuters.com/en/products/third-party-risk/world-check-know-your-customer.html
https://risk.thomsonreuters.com/en/products/third-party-risk/world-check-know-your-customer.html
https://risk.thomsonreuters.com/en/products/third-party-risk/world-check-know-your-customer.html
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NOTE If your instance of Oracle Transaction Filtering uses the 
WebLogic application server, and you are screening against the 
World-Check watch list, then, to download the World-Check 
reference data successfully, you must add the following to the 
'Server Start' arguments of your EDQ managed server: -
DUseSunHttpHandler=true. This is only required if you are 
using the WebLogic application server and screening against 
the World-Check watch list. 

 

13.6 Dow Jones Watch List 

Dow Jones provides a subscription-based service offering a consolidated list of PEPs (Politically Exposed 

Persons) and entities and individuals appearing on the various sanctions lists. For more information, see 

the Dow Jones website. 
The Dow Jones watch list automated download task uses one of two script files that are provided with 

Oracle Transaction Filtering to provide further configuration of the download process. These script files 

are: 

▪ download-djw.sh (for use on Unix platforms) 

▪ download-djw.bat (for use on Windows platforms) 

The script files are invoked by the automated task and will download the data files and copy them to the 

appropriate sub-folder of the OEDQ landing area.  

13.7 Dow Jones Anti-Corruption Watch List 

Dow Jones provides a subscription-based service containing data to help you assess, investigate, and 

monitor third-party risk about anti-corruption compliance regulation. For more information, see the Dow 

Jones website. 

The Dow Jones Anti-Corruption List automated download task uses one of two script files that are 

provided with Oracle Transaction Filtering to provide further configuration of the download process. 

These script files are: 

▪ download-djac.sh (for use on Unix platforms) 

▪ download-djac.bat (for use on Windows platforms) 

The script files are invoked by the automated task and will download the data files and copy them to the 

appropriate sub-folder of the OEDQ landing area. 

13.8 Accuity Watch List 

The Accuity Global watch list is a subscription-based service. The Accuity website states: 

Accuity's proprietary collection of watch list screening databases is an aggregation of specially designated 

individuals and entities compiled from dozens of regulatory and enhanced due diligence lists from around 

the world. The global watch list provides the ideal framework for your Transaction Filtering and 

interdiction filtering processes. 

https://www.dowjones.com/products/risk-compliance/
https://www.dowjones.com/products/risk-compliance/
https://www.dowjones.com/products/risk-compliance/
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Accuity provides its aggregated data as a set of three lists as follows: 

• The Regulatory Due Diligence (RDD) lists which cover sanctioned entities and individuals. The 

Accuity Group File can also be used in conjunction with this list.  

• Enhanced Due Diligence (EDD) lists which cover entities and individuals who are not part of the 

regulatory sanctions lists, but whose activities may need to be monitored 

• The Politically Exposed Persons (PEPs) Due Diligence Database, and covering PEPs 

Any or all the lists can be downloaded and used separately or in conjunction with each other. For more 

information, see the Accuity website. 

13.8.1 Using the Accuity Group File 

The Accuity global Watchlist is created by aggregating multiple watch lists. As such, any given individual 

or entity may be represented in the watch list by multiple entries using the GROUP.XML file. 

In the GROUP.XML file, all records which represent the same individual or entity are collected into groups, 

and each group is assigned a unique group ID. The group ID has a unique identifier to differentiate it from 

the original record identifier in Enterprise Case Management (ECM). Records that are not included in the 

group use their original Accuity record ID with a different identifier to indicate that they are single records. 

 

NOTE Only entities and individuals on the Regulatory Due Diligence 
(RDD) watch lists are included in the group file. 

 

The group file allows you to generate cases on individuals who are grouped together, instead of 

generating cases on separate individuals. Groups are used by default. To change this, open Accuity Data 

Store in the Watch List Management project and deselect the Use groups option. 

 

Figure 96: Edit Data Store Window 

 
 

If you choose to use the group file but it is not present in your downloaded data, an error is generated. 

http://www.accuity.com/compliance/
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13.8.2 New Alerts Resulting from Use of the Group File 

Using the group file causes the original list ID for an entry to be replaced with the appropriate group ID. 

The list ID is used in the alert key, so changes to the list ID will result in new alerts being raised for existing, 

known relationships. There are two main scenarios in which this may occur: 

Individuals or entities are moved into, out of, or between groups by Accuity, new alerts are generated for 

existing relationships. 

 

NOTE Use of the group file may result in new alerts being raised for 
existing relationships if the group file structure is changed by 
Accuity. There is at present no way to circumvent this issue. 

 

The Use Groups setting is changed after cases and alerts have already been generated. The setting for the 

Use Groups option must be selected during the implementation phase of the project. After screening has 

started, it must not be changed unless necessary. Changing this setting is likely to result in duplication of 

existing alerts with a new alert ID. 

13.9 Private Watch List 

This section describes the structure of the .csv files used in the Private List Interface (PLI). 

Private watch list data are provided in two .csv (comma-separated value) files; 

privateindividuals.csv and privateentities.csv. These files come with a pre-defined structure 

and set of validation rules. On installation, these files are populated with sample private watch list data, 

which must be replaced with your data, once it has been transformed into the required format.  

 

NOTE • It is recommended that you keep a copy of the sample 
private watch list files, as they can be used to verify 
the correct functioning of your installation on a known 
data set. 

• The files must be saved in UTF-8 format. 

 

Three types of attributes are used in the PLI for screening: 

Mandatory attributes: These attributes are tagged in the PLI tables with the [Mandatory attribute] tag 

and are mandatory for screening. 

Recommended attributes: These attributes are used in matching, typically to either eliminate false 

positive matches that may occur if the mandatory fields alone were used or to reinforce the likelihood of a 

possible match. They are tagged in the PLI tables with the [Recommended attribute] tag. 

Optional attributes: These attributes are not used in matching. Information provided in these fields may 

be of use in processes downstream of the match process. 
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13.9.1 Individual Private Watch List Input Attributes 

This section lists the PLI fields used for individuals. In addition to the prescribed fields, fifty customizable 

input attributes are available for individual private watch lists, out of which forty are string attributes, five 

are date attributes and five are number attributes. They are available for any additional inputs required by 

your private watch list.  

The following table lists the individual PLI fields in order, the data format expected for each field, and 

notes on their use in screening: 

 

Table 44: Individual Private Watch List Input Attributes 

Field Name Expected Data Format Notes 

ListSubKey String This field is used to identify the source 

list of the watch list record (for example, 

Private List, Accounting Private List, 

Financial Private List, and so on). It is 

included in the alert key. 

ListRecordType String NA 

ListRecordOrigin String This field is used to record the 

provenance of a record when it is part of 

a consolidated list. 

ListRecordId String [Mandatory attribute] This attribute is 

not used as part of the matching 

process, but it must be populated with a 

unique identifier. 

PassportNumber String This is an optional field that may be used 

to capture the passport numbers of 

customers or individuals for use in the 

review process.  

Passport numbers are not used in the 

default screening rules. 

NationalId  String This is an optional field that may be used 

to capture customer National IDs for use 

in the review process.  

The National IDs of customers and 

individuals must not use in the default 

screening rules. 

Title String This field must contain the titles of 

customers or individuals (such as 

Mr/Mrs/Dr/Herr/Monsieur). It is used to 

derive gender values where gender is 

not already stated and is used during the 

review process.  

Avoid putting titles in the name fields. 

FullName String [Mandatory attribute] The individual 

matching process is based primarily on 
GivenName String 
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Field Name Expected Data Format Notes 

FamilyName String the name supplied for the individual. 

Either a full name, a pair of given and 

family names, or an original script name 

must be submitted to the screening 

process for screening to proceed. 

NameType String This is an optional field used in the 

review process only. Multiple names may 

exist for the same person. The Name 

Type, therefore, denotes if the name is 

the primary name of the listed party, or 

an additional name (such as an Alias, or 

Alternate Spelling). If two 

Private list records were derived from a 

single source with multiple names (such 

as Mrs. Louise Wilson née Hammond 

being split into two records, Louise 

Wilson and Louise Hammond) you may 

wish to denote one as the primary name 

and one as a maiden or alias name. 

NameQuality String This field may be assigned a value of 

Low, Medium, or High to indicate the 

quality of the individual name. High is 

used for Primary names and specified 

good/high-quality aliases. 

PrimaryName String For alias records, this field indicates the 

main name for that record. 

OriginalScriptName String [Mandatory attribute] The individual 

matching process is based primarily on 

the name supplied for the individual. 

Either a full name, a pair of given and 

family names, or an original script name 

must be submitted to the screening 

process for screening to proceed. If you 

populate the Original Script Name, then 

you will also need to enable two facets of 

Match processor configuration that are 

disabled by default: the Original Script 

Name Cluster and some or all of the 

Match Rules that include Original script 

name in their name. To adapt the Match 

Processor configuration, you will need to 

open the Transaction screening project 

within the Director user interface and 

make the changes to every process used 

during the Transaction Filtering 

installation. 
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Field Name Expected Data Format Notes 

Gender String The value supplied must be either ‘M’ or 

‘F’. The gender is not used directly in the 

matching process, but optionally, the 

value of the Gender field can be used by 

the elimination rules to eliminate poor 

matches. 

Occupation String This is an optional field that may be used 

to eliminate records with "safe" 

occupations, in the review process and 

risk scoring. Note that customer 

occupations are not matched against list 

occupations using the default screening 

rules. 

DateofBirth String, representing a date, 

in the format 

'YYYYMMDD'; day, month, 

and year are required. 

[Recommended attribute] Birth date 

information can be used in matching to 

identify particularly strong matches or to 

eliminate matches that are too weak. 

YearofBirth String, in the format 'YYYY'. NA 

Deceased Flag String If populated, this optional field must 

contain either Y or N. 

DeceasedDate String, representing a 

date, in the format 

'YYYYMMDD'. 

If populated, this optional field must 

contain either the current date or a date 

in the past. 

Address1 String These are optional fields that may be 

used in the review process. 
Address2 String 

Address3 String 

Address4 String 

City String [Recommended attribute] City data is 

used to strengthen potential match 

information. 
State String 

Postal Code String 

AddressCountryCode String; ISO 2-character 

country code. 

[Recommended attribute] Address 

country data is used to strengthen 

potential match information. 

ResidencyCountryCode String; ISO 2-character 

country code. 

[Recommended attribute] The country of 

residence can be used in optional 

country prohibition screening. 

CountryOfBirthCode String; ISO 2-character 

country code. 

NA 
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Field Name Expected Data Format Notes 

NationalityCountryCodes String; comma separated 

list of 

ISO 2-character 

country codes. 

[Recommended attribute] The 

nationality can be used in optional 

country prohibition screening. 

ProfileHyperlink String; a hyperlink to an 

Internet or intranet resource 

for the record. 

This field may contain a hyperlink to an 

Internet or intranet resource that can 

provide reviewers with additional 

information about the individual. 

RiskScore Number, between 0 and 100 This field is included where the risk score 

for a customer is calculated externally. 

RiskScorePEP Number, between 0 and 100 A number indicating the relative 

‘riskiness’ of the Individual, considered 

as a PEP. The risk score is expressed as 

an integer between 1 and 100, with 

Higher numbers indicating a higher risk. 

AddedDate String, representing a 

date, in the format 

'YYYYMMDD' 

These are optional fields for use in the 

review process. 

LastUpdatedDate String, representing a 

date, in the format 

'YYYYMMDD' 

DataConfidenceScore Number, between 

0 and 100 

DataConfidenceComment String 

InactiveFlag String If populated, this optional field must 

contain either Y or N. 

InactiveSinceDate String, representing a 

date, in the format 

'YYYYMMDD' 

If populated, this optional field must 

contain either the current date or a date 

in the past. 

PEPclassification String This field can be used to indicate the 

type of PEP (for example, whether the 

individual is part of an international 

organization or government, and at what 

level). It can be used to filter watch list 

records and is primarily used by the 

World-Check watch list, but could be 

used by a private watch list if required.  

customString1 to 

customString40 

String Fifty custom fields are provided in the 

private list data interface for individuals. 

Forty of these are intended to hold string 

data, five hold dates, and five numeric 

data.  

customDate1 to 

customDate5 
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Field Name Expected Data Format Notes 

customNumber1 to 

customNumber5 

 The interface file is a comma-separated 

value (.csv) file, and so all fields 

intrinsically contain strings. However, 

during the processing of Private watch 

lists, the custom date and number fields 

are checked to ensure that they include 

appropriate data, and warning messages 

are provided as output if they do not. 

 

13.9.2 Entity Private Watch List Input (PLI) Attributes 

This section lists the PLI fields used for entities. In addition to the prescribed fields, fifty customizable 

input attributes are available for individual private watch lists, out of which forty are string attributes, five 

are date attributes and five are number attributes. They are available for any additional inputs required by 

your private watch list.  

The following table lists the individual PLI fields in order, the data format expected for each field, and 

notes on their use in screening: 

 

Table 45: Entity Private Watch List Input Attributes 

Field Name Expected Data Format Notes 

ListSubKey String This field is used to identify the source 

list of the watch list record (for example, 

Private List, Accounting Private List, 

Financial Private List, and so on). It is 

included in the alert key. 

ListRecordType String [Mandatory attribute]This field is used 

when filtering alerts, to determine 

whether the record is a sanctions or PEP 

record. It must contain a value of SAN, 

PEP, or a combination of these values. If 

you want to include a combination of 

values, the values must be comma-

separated and enclosed by double 

quotation marks. For example: "SAN, 

PEP". 

ListRecordOrigin String This field is used to record the 

provenance of a record when it is part of 

a consolidated list. 

ListRecordId String [Mandatory attribute] This attribute is 

not used as part of the matching 

process, but it must be populated with a 

unique identifier. 
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Field Name Expected Data Format Notes 

RegistrationNumber String This is an optional field that may be used 

to capture entity registration numbers 

for use in the review process. Note that 

entity registration numbers are not used 

for matching in the default screening 

rules. 

EntityName String [Mandatory attribute] The entity 

matching process is based primarily on 

the name supplied for the entity. An 

entity name or original script name must 

be submitted to the screening process 

for screening to proceed. 

NameType String This is an optional field used in the 

review process only. Multiple names may 

exist for the same person. The Name 

Type, therefore, denotes if the name is 

the primary name of the listed party, or 

an additional name (such as an Alias, or 

Alternate Spelling). If two private list 

records were derived from a single 

source with multiple names (such as 

Mrs. Louise Wilson née Hammond being 

split into two records, Louise Wilson and 

Louise Hammond) you may wish to 

denote one as the primary name and 

one as a maiden or alias name. 

NameQuality String This field may be assigned a value of 

Low, Medium, or High to indicate the 

quality of the individual name. High is 

used for Primary names and specified 

good or high-quality aliases. 

PrimaryName String For alias records, this field indicates the 

main name for that record. 
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Field Name Expected Data Format Notes 

OriginalScriptName String [Mandatory attribute] The individual 

matching process is based primarily on 

the name supplied for the individual. 

Either a full name, a pair of given and 

family names, or an original script name 

must be submitted to the screening 

process for screening to proceed. If you 

populate the Original Script Name, then 

you will also need to enable two facets of 

Match processor configuration that are 

disabled by default. The Original Script 

Name Cluster and some or all the Match 

Rules that include Original script name in 

their name. To adapt the Match 

Processor configuration, you will need to 

open the Transaction screening project 

within the Director user interface and 

make the changes to every process used 

during the Transaction Filtering 

installation. 

AliasIsAcronym String If this field is set to Y, this flags an alias 

as an acronym as opposed to a full entity 

name. Leaving the field blank or setting 

it to any other value does not affect 

screening (that is, an alias is a full entity 

name).  

This flag is used during matching. 

VesselIndicator String This field must be set to Y if the entity is 

a vessel (a ship). It must be left empty or 

set to N if the entity is not a vessel. 

VesselInfo String If the entity is a vessel, you can populate 

this field with information about it: for 

example, its call sign, type, tonnage, 

owner, flag, and so on. 

Address1 String These are optional fields that may be 

used in the review process. 
Address2 String 

Address3 String 

Address4 String 

City String [Recommended attribute] City data is 

used to strengthen potential match 

information. 
State String 

Postal Code String 

AddressCountryCode String; ISO 2-character 

country code. 

[Recommended attribute] Address 

country data is used to strengthen 

potential match information. 
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Field Name Expected Data Format Notes 

ResidencyCountryCode String; ISO 2-character 

country code. 

[Recommended attribute] The entity's 

registration country can be used in 

optional country prohibition screening. 

OperatingCountryCodes String; ISO 2-character 

country code. 

[Recommended attribute] Any of the 

entity's operating countries can be used 

in optional country prohibition 

screening. 

ProfileHyperlink String; a hyperlink to an 

Internet or intranet resource 

for the record. 

This field may contain a hyperlink to an 

Internet or intranet resource that can 

provide reviewers with additional 

information about the individual. 

RiskScore Number, between 0 and 100 This field is included where the risk score 

for a customer is calculated externally. 

RiskScorePEP Number, between 0 and 100 A number indicating the relative 

‘riskiness’ of the individual, considered 

as a PEP. The risk score is expressed as 

an integer between 1 and 100, with 

higher numbers indicating a higher risk. 

AddedDate String, representing a 

date, in the format 

'YYYYMMDD' 

These are optional fields for use in the 

review process. 

LastUpdatedDate String, representing a 

date, in the format 

'YYYYMMDD' 

DataConfidenceScore Number, between 

0 and 100 

DataConfidenceComment String 

InactiveFlag String If populated, this optional field must 

contain either Y or N. 

InactiveSinceDate String, representing a 

date, in the format 

'YYYYMMDD' 

If populated, this optional field must 

contain either the current date or a date 

in the past. 

PEPclassification String This field can be used to indicate the 

type of PEP (for example, whether the 

individual is part of an international 

organization or government, and at what 

level). It can be used to filter watch list 

records and is primarily used by the 

World-Check watch list, but could be 

used by a private watch list if required.  

customString1 to 

customString40 

String Fifty custom fields are provided in the 

private list data interface for individuals. 
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Field Name Expected Data Format Notes 

customDate1 to 

customDate5 

String, representing a 

date, in the format 

'YYYYMMDD' 

Forty of these are intended to hold string 

data, five hold dates, and five numeric 

data.  

The interface file is a comma-separated 

value (.csv) file, and so all fields 

intrinsically contain strings. However, 

during the processing of Private watch 

lists, the custom date and number fields 

are checked to ensure that they include 

appropriate data, and warning messages 

are provided as output if they do not. 

customNumber1 to 

customNumber5 

Number 
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14 Appendix B: System Audit Logging Information 

This appendix contains information on the logs related to the Debug and Info log files.  

14.1 Activities for System Audit 

The following table contains information related to the system audit activities: 

 

Table 46: Activities for System Audit 

Activity Identifier Activity Name Activity Sequence 

1 Raw Message Processing 1 

2 Message Parser Processing 2 

3 watch list Processing 3 

4 Alert Manager Processing 4 

5 Hold 5 

6 Assigned 6 

7 Escalated 7 

8 Recommend to Block 8 

9 Block 9 

10 Recommend to Release 10 

11 Release 11 

12 Reject 12 

 

14.2 Steps for System Audit Activities 

The following table contains information related to the steps for the system audit activities: 

 

Table 47: Steps for System Audit Activities 

Step Identifier Activity Name Step Name Step Sequence Status 

1 Raw Message 

Processing 

Record the receipt 

of the raw 

message 

1 Y 

2 Raw Message 

Processing 

Raw Message 

persisted into 

structure table 

2 N 

3 Message Parser 

Processing 

Raw Message 

parsed 

1 N 
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Step Identifier Activity Name Step Name Step Sequence Status 

4 Message Parser 

Processing 

Parsed Raw 

Message 

persisted into 

structure table 

2 N 

5 watch list 

Processing 

Matching data 

prepared 

1 N 

6 watch list 

Processing 

Matching Engine 

Invoked 

2 Y 

7 watch list 

Processing 

Scoring Engine 

Invoked 

3 Y 

8 watch list 

Processing 

Scoring 

performed 

4 Y 

9 watch list 

Processing 

Response 

Received 

5 Y 

10 watch list 

Processing 

Response 

persisted 

6 N 

11 Alert Manager 

Processing 

Transaction Hold 1 N 

12 Alert Manager 

Processing 

Alert Persisted 2 N 

13 Hold Hold Transaction 

Workflow Invoked 

1 Y 

14 Hold Hold Transaction 

Workflow 

completed 

2 Y 

15 Assigned Assigned 

Transaction 

Workflow Invoked 

1 Y 

16 Assigned Assigned 

Transaction 

Workflow 

completed 

2 Y 

17 Escalate Escalated 

Transaction 

Workflow Invoked 

1 Y 

18 Escalate Escalated 

Transaction 

Workflow 

completed 

2 Y 

19 Recommend to 

Block 

NA NA NA 
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Step Identifier Activity Name Step Name Step Sequence Status 

20 Block Blocked 

Transaction 

Workflow Invoked 

1 Y 

21 Block Blocked 

Transaction 

Workflow 

completed 

2 Y 

22 Recommend to 

Release 

   

23 Release Released 

Transaction 

Workflow Invoked 

1 Y 

24 Release Released 

Transaction 

Workflow 

completed 

2 Y 

25 Reject NA NA NA 
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15 Appendix C: Process Modeller Framework (PMF) 
Configurability 

This appendix contains information on the steps required to configure the ready-to-use Process Modeller 

Framework (PMF) workflow. On the Process Modeller page, click the transaction that you want to 

configure and follow the steps in the following sequence. For information on how to access the Process 

Modeller page, see the Process Modeller Menu. 

15.1  Configuring the Human Task in the PMF Page 

To configure all human tasks on the PMF page, follow these steps: 

1. Navigate to the Process Flow subtab in the Process Modeller tab. The PMF page is displayed. 

2. Drag and drop Human Task  on to the PMF page. For information on all components available, 

see the Components for Designing Your Process Flow chapter in the Oracle Financial Services 

Analytical Applications Infrastructure Process Modelling Framework (PMF) Orchestration Guide.  

3. Double-click Human Task .  

4. In the Activity dialog, provide the following information: 

▪ A unique activity name in the Activity Name field. After you provide a name, it appears 

after the icon on the PMF page. 

▪ The activity description in the Activity Description field. 

▪ The current status of the transaction in the Status field. 

▪ The next status of the transaction in the Outcomes field. 

5. Click Transitions  and then click Add. 

▪ In the Add New Transition dialog, provide the following information: 

▪ A unique transition name in the Transition Name field.  

▪ The destination status of the transaction in the Connected To field. 

▪ The execution or decision rule for a status in the Decision Rule field. Here you need to map 

the specific rule to the current status or create the rule according to the business 

requirement. 

▪ The order of the transaction in the Order field. 

You can also configure the fields in the Action and Notifications subtabs. For more information, 

see the Action Tab for Creating Tasks/Notification section in Oracle Financial Services Analytical 

Applications Infrastructure Process Modelling Framework (PMF) Orchestration Guide.  

15.1.1 Mapping the Transaction Statuses and Transaction Outcomes 

After you provide the new transaction status and outcome in step 4, you need to map the values in the 

required tables to update the value on the PMF page. 

To update the status on the PMF page, populate the following status in the Config schema: 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.7.x/8.0.7.0.0/OFSAAI_PMF_Orchestration_Guide_8.0.7.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.7.x/8.0.7.0.0/OFSAAI_PMF_Orchestration_Guide_8.0.7.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.7.x/8.0.7.0.0/OFSAAI_PMF_Orchestration_Guide_8.0.7.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.7.x/8.0.7.0.0/OFSAAI_PMF_Orchestration_Guide_8.0.7.0.0.pdf
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1. Run select * from AAI_WF_STATUS_B t where t.v_app_package_id = 'OFS_SAC' and select 

* from AAI_WF_STATUS_TL where t.v_app_package_id = 'OFS_SAC' queries. 

2. In the AAI_WF_STATUS_B table, populate a unique entry in the v_status_id column for each new 

status and map the same entry in the AAI_WF_STATUS_TL table for a column. For example, 

populate the entry OFS_SAC in the v_app_package_id column. 

3. When you map the new status, it appears on the PMF page.  

▪ Ensure that data is provided in all required columns in the AAI_WF_STATUS_TL table. 

▪ When doing the mapping in any other configuration tables, ensure that you provide the 

same status that is mentioned in the v_status_name column in the AAI_WF_STATUS_TL 

table.  

To update the outcome on the PMF page, populate the following status in the Config schema: 

1. Run the select * from AAI_WF_OUTCOME_B t and where t.v_app_package_id = 'OFS_SAC' 

queries. 

2. In the AAI_WF_OUTCOME_B table, populate a unique outcome ID in the v_outcome_id column for 

each new status and map the same entry in the AAI_WF_OUTCOME_TL table.  

▪ Ensure that data is provided in all required columns in the AAI_WF_OUTCOME_TL table. 

▪ When doing the mapping in any other configuration tables, ensure that you provide the 

same status that is mentioned in the AAI_WF_OUTCOME_TL table. 

▪ After you complete the above steps, refresh the application and web servers. 

15.2 Adding Data Fields for the PMF Status 

To add a new data field for each new status, for example, TF_BLOCKED_NEW, click the Data Fields subtab 

in the Process Modeller page and click Add. For information on the fields, see the Data Fields section in 

the Oracle Financial Services Analytical Applications Infrastructure Process Modelling Framework (PMF) 

Orchestration Guide. 

 

NOTE If the data field name contains more than one word, give an 
underscore (_) between each word. The name will not be valid 
if you provide a space between each word. 

 

You can also edit an existing data field, follow these steps: 

1. Select the radio button of the data field that you want to edit. 

2. Click Edit. 

15.3 Adding Application Rules for the PMF Status 

To add a new application rule for each new status, for example, RB_TO_Block_New, click the Application 

Rule subtab in the Process Modeller page and click Add. For information on the fields, see the 

Application Rules section in the Oracle Financial Services Analytical Applications Infrastructure Process 

Modelling Framework (PMF) Orchestration Guide. 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.7.x/8.0.7.0.0/OFSAAI_PMF_Orchestration_Guide_8.0.7.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.7.x/8.0.7.0.0/OFSAAI_PMF_Orchestration_Guide_8.0.7.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.7.x/8.0.7.0.0/OFSAAI_PMF_Orchestration_Guide_8.0.7.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.7.x/8.0.7.0.0/OFSAAI_PMF_Orchestration_Guide_8.0.7.0.0.pdf
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15.3.1 Mapping Rule Types to Application Rules 

If you select a new rule type for the application rule, you must then map it to the rule.  

To map a rule, run the select * from aai_aom_app_comp_attr_mapping query. 

If a static rule is present with n_static_grp_id = 501, then run the select * from AAI_AOM_STATIC  

query. 

15.3.2 Mapping User Groups to Application Rules 

If you have also mapped a new user group to the rule, then you need to map the entry in the 

DOMAIN_JUR_GRP_MAP table. After you map the user group to the rule, run the select * from 

DOMAIN_JUR_GRP_MAP query to update the DOMAIN_JUR_GRP_MAP table. 

The steps required to create a new user group are available in Creating New User Groups. For more 

information, see the User Administrator section in the Oracle Financial Services Analytical Applications 

Infrastructure User Guide. 

15.4 Configurations Required for the Audit Tables 

Before you update the tables, you must first provide a unique value in the n_activity_id column in the 

SETUP_RT_AUD_ACTIVITY table and then provide the same value in the n_activity_id column in the 

SETUP_RT_AUD_STEPS table.  

After this is done, run the select * from SETUP_RT_AUD_ACTIVITY query to update the 

SETUP_RT_AUD_ACTIVITY table and run the select * from SETUP_RT_AUD_STEPS query to update 

the SETUP_RT_AUD_STEPS table.  

After the tables are updated, provide two entries, 1 and 2, in the n_step_sequence column in the 

SETUP_RT_AUD_STEPS table.  

 

NOTE The value provided in the v_status_name column in the 
AAI_WF_STATUS_TL table must be a combination of one of 
the following values: 

• The value provided in v_sanction_status_name in 
dim_sanctions_status table and the name of the 
transaction workflow invoked for entry 1. 

• The value provided in v_sanction_status_name in 
dim_sanctions_status table and the name of the 
transaction workflow completed for entry 2. 

 

15.5 Configurations Required for the setup_rt_params Table 

To configure the table in the ATOMIC schema, follow these steps: 

1. Provide the function code in the v_attribute_value1 column where v_attribute_name1 = 

'TF_ FUNCTION_CODES'. 

https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
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2.  Provide the status codes according to the v_attribute_name1 value in the 

v_attribute_value1 column where v_attribute_name1 = 

'TF_FUNCTION_AND_STATUS_CODES'. 

3. Provide all status codes in the v_attribute_value1 column against each function code in the 

v_attribute_name1 column. This displays the dynamic status filter. 

4. Provide the code for each status to be displayed to the user for that function code in the 

v_attribute_value1 column. 

5. Provide the code for each status to be displayed to the user in the Transaction Summary window in 

the v_attribute_value2 column. 

6. Provide the code for each action that must be displayed to the user for that transaction in the 

v_attribute_value3 column. 

7. To create an order for the transactions, follow these steps: 

a. Provide TF USERWORKFLOWCLAUSE in the v_param_name column. 

b. Provide TF_ORDERBY_PRECEDENCE in the v_attribute_name1 column. 

c. Provide TF_ORDERBY_FUNCCODE in the v_attribute_name2 column. 

d. Provide the function code for which you want to do the order in the v_attribute_value2 

column. For example, use TFLTANYSE for the analyst user. 

e. Provide TF_ORDERBY_CLAUSES in the v_attribute_name3 column.  

f. Provide the order by query in the v_attribute_value3 column. For a sample value, see the 

value for the TFLTANYSE function code. 

8. Update the fields in the feedback response JSON for blocked and released payments in the 

v_attribute_value1 column in the FEEDBACK_RESPNSE_CONFIGURATION row and restart the 

WebLogic server. 

15.6 Configurations Required for the dim_sanctions_status 
Table 

To configure the table in the ATOMIC schema, follow these steps: 

1. Create a unique value for the new PMF status in the n_sanction_status_code column. This 

value must be the same in the AAI_WF_STATUS_B and AAI_WF_STATUS_TL columns. For more 

information, see Configurations Required for the Audit Tables. 

2. Provide the activity name as mentioned in step 4 of the Configuring the Human Task in the PMF 

Page section in the v_remarks column. 

3. Provide a unique data field value in the v_applicable_params column where 

n_sanction_staus_key = 101 (ApplicationParams) and n_sanction_staus_key = 202 

(PMFParams). 

4. To update the image path for the alert status, update the v_sanction_status_img_path value. 

5. To update the image path for the list of actions, update the v_sanction_dropdown_img_path 

value. 



APPENDIX C: PROCESS MODELLER FRAMEWORK (PMF) CONFIGURABILITY 

CREATING NEW USER GROUPS 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  175 

6. To configure the action status:  

a. Provide the value StatusActon if a status action must be fired. 

b. Provide the value PendingTrxnsCount if the count of pending transactions is required for a 

particular action. 

c. Provide the value PendingTrxnsSuspiciousCountAndStatusActon if the count of pending 

transactions and count of pending suspicious transactions are both required. 

7. In the v_data_field column, give the same data field created in the PMF page data field section. 

8. Update the v_owner_update column in the fsi_rt_alerts table if the owner must be updated.  

9. Provide the audit message in the v_audit_msg column. This value must be the same as the value 

provided in the v_sanction_status_name column. For more information, see Configurations 

Required for the Audit Tables. 

 

NOTE 
For a new status, the v_applicable_params column must be left 

blank. 

 

15.7 Creating New User Groups 

To add a new user group, follow these steps: 

1. Create a function.  

2. Create a role.  

3. Map the function to the role. 

4. Create a user. 

5. Map the user to a user group and a role. 

6. Map the user to a user group and a domain. 

7. Map the user to a user group. 

15.8 Other Configurations 

The user group is now created. After it is created, follow these steps: 

1. Map the group in the domain_jur_grp_map table. 

2. Login to the Config schema. 

3. Run the select * from cssms_folder_function_map query. 

4. Add the new function to the Transaction Filter folder (TransactionFiltering TFLTADMIN). 

5. Run the select t.v_access_code,t.v_menu_id from aai_menu_b t  where 

t.v_menu_id in('OFS_TFLTSCRN','OFS_TFLT') query.  

6. Add the new function in the v_access_code column. 
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7. To map the new function, add an entry in the v_access_code column in the aai_menu_b table by 

running a query with the entry mentioned in the following format: select * from aai_menu_b 

t where t.v_menu_id like '%OFS_TFLT%'; query. 

8. To map the function to a folder, run a query with the function mentioned in the following format: 
select * from cssms_folder_function_map p where p.v_function_code like 

'%TF%'; query. 
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16 Appendix D: Time Zone Configuration 

This appendix contains information on the expected user input to set up the time zone preference for any 

user in the database. You can configure the time zone for each user ID.  

If no time zone is specified for a user, the default time zone is the time zone specified in the user’s 

browser. 

To update the time zone for a user, follow these steps:  

1. Run the following script: 

select * from AAI_USR_PREFERENCE_DETAIL t where t.v_preference_id = 

'TIME_ZONE'; 

2. Update the time zone name in the following V_PREFERENCE_VALUE column: 

 

Table 48: User IDs for Time Zones 

V_USER_ID V_PREFERENCE_ID V_PREFERENCE_VALUE 

Administrator TIME_ZONE Asia/Kolkata 

Analyst  TIME_ZONE Africa/Abidjan 

Supervisor TIME_ZONE Africa/Accra 

 

The following table shows the country code and the respective time zone name. The following 

country codes listed here are only for reference. For each country code, the respective time zone 

name must be used to update the time zone. 

 

Table 49: Country Codes for Time Zones  

Country Code Time Zone Name 

CI Africa/Abidjan 

GH Africa/Accra 

ET Africa/Addis_Ababa 

DZ Africa/Algiers 

ER Africa/Asmara 

ML Africa/Bamako 

CF Africa/Bangui 

GM Africa/Banjul 

GW Africa/Bissau 

MW Africa/Blantyre 

CG Africa/Brazzaville 

BI Africa/Bujumbura 
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Country Code Time Zone Name 

EG Africa/Cairo 

MA Africa/Casablanca 

ES Africa/Ceuta 

GN Africa/Conakry 

SN Africa/Dakar 

TZ Africa/Dar_es_Salaam 

DJ Africa/Djibouti 

CM Africa/Douala 

EH Africa/El_Aaiun 

SL Africa/Freetown 

BW Africa/Gaborone 

ZW Africa/Zimbabwe 

ZA Africa/Johannesburg 

SS Africa/Juba 

UG Africa/Kampala 

SD Africa/Khartoum 

RW Africa/Kigali 

CD Africa/Kinshasa 

NG Africa/Lagos 

GA Africa/Libreville 

TG Africa/Lome 

AO Africa/Luanda 

CD Africa/Lubumbashi 

ZM Africa/Lusaka 

GQ Africa/Malabo 

MZ Africa/Maputo 

LS Africa/Maseru 

SZ Africa/Mbabane 

SO Africa/Mogadishu 

LR Africa/Monrovia 

KE Africa/Nairobi 

TD Africa/Ndjamena 

NE Africa/Niamey 
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Country Code Time Zone Name 

MR Africa/Nouakchott 

BF Africa/Ouagadougou 

BJ Africa/Porto-Novo 

ST Africa/Sao_Tome 

CI Africa/Timbuktu 

LY Africa/Tripoli 

TN Africa/Tunis 

NA Africa/Windhoek 

US America/Adak 

America/Anchorage 

America/Boise 

America/Chicago 

America/Denver 

America/Detroit 

America/Indianapolis 

America/Knox 

America/Marengo 

America/Petersburg 

America/Tell_City 

America/Vevay 

America/Vincennes 

America/Winamac 

America/Juneau 

America/Louisville 

America/Monticello 

America/Los_Angeles 

America/Menominee 

America/Metlakatla 

America/New_York 

America/Nome 

America/Beulah 

America/Center 

America/New_Salem 
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Country Code Time Zone Name 

America/Phoenix 

America/Sitka 

America/Yakutat 

America/Honolulu 

AI America/Anguilla 

AG America/Antigua 

AR America/Buenos_Aires 

America/Catamarca 

America/Cordoba 

America/Jujuy 

America/La_Rioja 

America/Mendoza 

America/Rio_Gallegos 

America/Salta 

America/San_Juan 

America/San_Luis 

America/Tucuman 

America/Ushuaia 

AW America/Aruba 

PY America/Asuncion 

CA America/Atikokan 

America/Blanc-Sablon 

America/Cambridge_Bay 

America/Creston 

America/Dawson 

America/Dawson_Creek 

America/Edmonton 

America/Fort_Nelson 

America/Glace_Bay 

America/Goose_Bay 

America/Halifax 

America/Inuvik 

America/Iqaluit 
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Country Code Time Zone Name 

America/Moncton 

America/Nipigon 

America/Pangnirtung 

America/Rainy_River 

America/Rankin_Inlet 

America/Regina 

America/Resolute 

America/St_Johns 

America/Swift_Current 

America/Thunder_Bay 

America/Toronto 

America/Vancouver 

America/Whitehorse 

America/Winnipeg 

America/Yellowknife 

BR America/Araguaina 

America/Bahia 

America/Belem 

America/Boa_Vista 

America/Campo_Grande 

America/Cuiaba 

America/Eirunepe 

America/Fortaleza 

America/Maceio 

America/Manaus 

America/Noronha 

America/Porto_Velho 

America/Recife 

America/Rio_Branco 

America/Santarem 

America/Sao_Paulo 

MX America/Bahia_Banderas 

America/Cancun 
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Country Code Time Zone Name 

America/Chihuahua 

America/Hermosillo 

America/Matamoros 

America/Mazatlan 

America/Merida 

America/Mexico_City 

America/Monterrey 

America/Ojinaga 

America/Tijuana 

BB America/Barbados 

BZ America/Belize 

CO America/Bogata 

VE America/Caracas 

GF America/Cayenne 

KY America/Cayman 

CR America/Costa_Rica 

CW America/Curacao 

GL America/Danmarkshavn 

America/Godthab 

America/Scoresbysund 

America/Thule 

DM America/Dominica 

SV America/El_Salvador 

TC America/Grand_Turk 

GD America/Grenada 

GP America/Guadeloupe 

GT America/Guatemala 

EC America/Guayaquil 

GY America/Guyana 

CU America/Havana 

JM America/Jamaica 

BQ America/Kralendijk 

BO America/La_Paz 
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Country Code Time Zone Name 

PE America/Lima 

SX America/Lower_Princes 

NI America/Managua 

MF America/Marigot 

MQ America/Martinique 

PM America/Miquelon 

UY America/Montevideo 

MS America/Montserrat 

BS America/Nassau 

PA America/Panama 

SR America/Paramaribo 

TT America/Port_of_Spain 

HT America/Port-au-Prince 

PR America/Puerto_Rico 

CL America/Punta_Arenas 

America/Santiago 

America/Easter 

DO America/Santo_Domingo 

BL America/St_Barthelemy 

KN America/St_Kitts 

LC America/St_ Lucia 

VI America/St_Thomas 

VC America/St_Vincent 

HN America/Tegucigalpa 

VG America/Tortola 

AQ Antarctica/Casey 

Antarctica/Davis 

Antarctica/DumontDurville 

Antarctica/Mawson 

Antarctica/McMurdo 

Antarctica/Palmer 

Antarctica/Rothera 

Antarctica/Syowa 
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Country Code Time Zone Name 

Antarctica/Troll 

Antarctica/Vostok 

SJ Arctic/Longyearbyen 

YE Asia/Aden 

KZ Asia/Almaty 

Asia/Aqtau 

Asia/Aqtobe 

Asia/Atyrau 

Asia/Oral 

Asia/Qyzylorda 

JO Asia/Amman 

TM Asia/Ashgabat 

IQ Asia/Baghdad 

BH Asia/Bahrain 

AZ Asia/Baku 

TH Asia/Bangkok 

RU Asia/Anadyr 

Asia/Barnaul 

Asia/Chita 

Asia/Irkutsk 

Asia/Kamchatka 

Asia/Khandyga 

Asia/Krasnoyarsk 

Asia/Magadan 

Asia/Novokuznetsk 

Asia/Novosibirsk 

Asia/Omsk 

Asia/Sakhalin 

Asia/Srednekolymsk 

Asia/Tomsk 

Asia/Ust-Nera 

Asia/Vladivostok 

Asia/Yakutsk 
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Country Code Time Zone Name 

Asia/Yekaterinburg 

Europe/Astrakhan 

Europe/Kaliningrad 

Europe/Kirov 

Europe/Moscow 

Europe/Samara 

Europe/Saratov 

Europe/Ulyanovsk 

Europe/Volgograd 

LB Asia/Beirut 

KG Asia/Bishkek 

BN Asia/Brunei 

MN Asia/Choibalsan 

Asia/Hovd 

Asia/Ulaanbaatar 

LK Asia/Colombo 

SY Asia/Damascus 

BD Asia/Dhaka 

TL Asia/Dili 

AE Asia/Dubai 

TJ Asia/Dushanbe 

CY Asia/Famagusta 

PS Asia/Gaza 

VN Asia/Ho_Chi_Minh 

HK Asia/Hong_Kong 

ID Asia/Jakarta 

Asia/Jayapura 

Asia/Makassar 

Asia/Pontianak 

IL Asia/Jerusalem 

AF Asia/Kabul 

PK Asia/Karachi 

NP Asia/Kathmandu 
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Country Code Time Zone Name 

IN Asia/Kolkata 

MY Asia/Kuala_Lumpur 

Asia/Kuching 

KW Asia/Kuwait 

MO Asia/Macau 

PH Asia/Manila 

OM Asia/Muscat 

KH Asia/Phnom_Penh 

KP Asia/Pyongyang 

QA Asia/Qatar 

MM Asia/Rangoon 

Asia/Yangon 

SA Asia/Riyadh 

UZ Asia/Samarkand 

Asia/Tashkent 

KR Asia/Seoul 

CN Asia/Shanghai 

Asia/Urumqi 

SG Asia/Singapore 

TW Asia/Taipei 

GE Asia/Tbilisi 

IR Asia/Tehran 

BT Asia/Thimphu 

JP Asia/Tokyo 

LA Asia/Vientiane 

AM Asia/Yerevan 

PT Atlantic/Azores 

Atlantic/Madeira 

BM Atlantic/Bermuda 

ES Atlantic/Canary 

CV Atlantic/Cape_Verde 

FO Atlantic/Faroe 

IS Atlantic/Reykjavik 
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Country Code Time Zone Name 

GS Atlantic/South_Georgia 

SH Atlantic/St_Helena 

FK Atlantic/Stanley 

AU Australia/Adelaide 

Australia/Brisbane 

Australia/Broken_Hill 

Australia/Canberra 

Australia/Currie 

Australia/Darwin 

Australia/Eucla 

Australia/Hobart 

Australia/Lindeman 

Australia/Lord_Howe 

Australia/Melbourne 

Australia/Perth 

Australia/Sydney 

Australia/Yancowinna 

NL Europe/Amsterdam 

AD Europe/Andorra 

GR Europe/Athens 

GB Europe/Belfast 

RS Europe/Belgrade 

DE Europe/Berlin 

SK Europe/Bratislava 

BE Europe/Brussels 

RO Europe/Bucharest 

HU Europe/Budapest 

DE Europe/Busingen 

MD Europe/Chisinau 

DK Europe/Copenhagen 

IE Europe/Dublin 

GI Europe/Gibraltar 

GG Europe/Guernsey 
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Country Code Time Zone Name 

FI Europe/Helsinki 

IM Europe/Isle_of_Man 

TR Europe/Istanbul 

JE Europe/Jersey 

UA Europe/Kiev 

PT Europe/Lisbon 

SI Europe/Ljubljana 

GB Europe/London 

LU Europe/Luxembourg 

ES Europe/Madrid 

MT Europe/Malta 

AX Europe/Mariehamn 

BY Europe/Minsk 

MC Europe/Monaco 

CY Europe/Nicosia 

NO Europe/Oslo 

FR Europe/Paris 

ME Europe/Podgorica 

CZ Europe/Prague 

LV Europe/Riga 

IT Europe/Rome 

SM Europe/San_Marino 

BA Europe/Sarajevo 

UA Europe/Simferopol 

Europe/Uzhgorod 

MK Europe/Skopje 

BG Europe/Sofia 

SE Europe/Stockholm 

EE Europe/Tallinn 

AL Europe/Tirane 

MD Europe/Tiraspol 

LI Europe/Vaduz 

VA Europe/Vatican 
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Country Code Time Zone Name 

AT Europe/Vienna 

LT Europe/Vilnius 

PL Europe/Warsaw 

HR Europe/Zagreb 

CH Europe/Zurich 

MG Indian/Antananarivo 

IO Indian/Chagos 

CX Indian/Christmas 

CC Indian/Cocos 

KM Indian/Comoro 

TF Indian/Kerguelen 

SC Indian/Mahe 

MV Indian/Maldives 

MU Indian/Mauritius 

YT Indian/Mayotte 

RE Indian/Reunion 

WS Pacific/Apia 

NZ Pacific/Auckland 

NZ Pacific/Chatham 

PG Pacific/Bougainville 

FM Pacific/Chuuk 

CL Pacific/Easter 

VU Pacific/Efate 

TK Pacific/Fakaofo 

FJ Pacific/Fiji 

TV Pacific/Funafuti 

EC Pacific/Galapagos 

PF Pacific/Gambier 

PF Pacific/Marquesas 

PF Pacific/Tahiti 

SB Pacific/Guadalcanal 

GU Pacific/Guam 

US Pacific/Honolulu 
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Country Code Time Zone Name 

KI Pacific/Enderbury 

KI Pacific/Kiritimati 

KI Pacific/Tarawa 

FM Pacific/Kosrae 

MH Pacific/Majuro 

UM Pacific/Midway 

UM Pacific/Wake 

NR Pacific/Nauru 

NU Pacific/Niue 

NF Pacific/Norfolk 

NC Pacific/Noumea 

AS Pacific/Pago_Pago 

PW Pacific/Palau 

PN Pacific/Pitcairn 

FM Pacific/Pohnpei 

PG Pacific/Port_Moresby 

CK Pacific/Rarotonga 

MP Pacific/Saipan 

Pacific/Samoa 

TO Pacific/Tongatapu 

WF Pacific/Wallis 
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17 Appendix E: Delta Watch List Configurations 
 

NOTE These configurations are performed when you do not want to 
download the full watch list, and only want to download the 
delta watch list. This helps to reduce the download time and is 
not part of the screening process. 

 

Transaction Filtering recommends that you always use the full watch list during the screening process. 

Due to the clustering strategy which is implemented in the screening process, you do not need to 

download the delta watch list. There are certain cases in which you are required to download the delta 

watch list files, for example, if the full watch list files are not yet available for download or if you want to 

save time. 

Customers who download the delta watch list files must first download the full watch list files and then 

download the delta watch list files. The delta watch list is then merged into the full watch list before 

screening. 

The following image shows the information flow for the delta watch list: 

 

Figure 97: Flow for Delta Watch List 

 
 

When you download the full watch list, data is stored in the FSI_WATCHLIST_INDIVIDUAL and 

FSI_WATCHLIST_ENTITIES tables. When you download the delta watch list, data is first stored in the 

FSI_WATCHLIST_DELTA_INDIVIDUAL and FSI_WATCHLIST_DELTA_ENTITIES tables. Then, based on 

the value in the ACTION Flag tag in the delta watch list, it merges with the full watch list. The ACTION flag 

key is a non-editable value, and can be one of the following values: 

• new: If the value is new, it means that these records are new and are added to the full watch list 

when the delta files are merged with the full watch list. 
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• chg: If the value is chg, it means that these records are modified and are added to the full watch list 

when the delta files are merged with the full watch list. 

• del: If the value is del, it means that these records are no longer active and are removed from the 

full watch list when the delta files are merged with the full watch list. 

 

NOTE You must always run the full watch list files before you run the 
delta watch list files. The full watch list files must be 
downloaded if, for example, the download of the delta watch 
list files has failed for multiple days. You can also run the full 
watch list once every week to ensure that the complete data 
has been processed. 

 

The following watchlist management jobs are used for the full list and the delta list: 

⎯ Analyze Reference Data Quality 

⎯ Download, Prepare, Filter, and Export All Lists 

⎯ Generate StopPhrases 

▪ The following watchlist management job is used for the full list: 

⎯ Load List data from Stg to Processed table 

▪ The following Transaction Filtering job is used for the full list and the delta list: 

⎯ Main 

Before you run the delta watchlist files, ensure that you run the full watchlist files. You can run the delta 

watch list files if, for example, the delta downloads have failed for multiple days or the filter criteria are 

changed. You can also run the delta watch list once every week to ensure that the complete data has been 

processed. 

17.1.1 Configurations for the Full and Delta Watch Lists 

The following configurations must be done for both full and delta watch list updates in the watchlist-

management.properties run profile. The run profile is available in the 

<domain_name>/edq/oedq.local.home/runprofiles/ directory when you log in to the WinSCP 

server. 

• Set phase.Initialise\ staged\ data.enabled = N to disable the .jmp file updates. 

• Set phase.Initialise\ staged\ data\ DB.enabled = Y to initialize the database. 

• Set phase.Initilize\ Prepared\ List\ Data.enabled = N to disable the .jmp file 

updates. 

• Set phase.Initilize\ Prepared\ List\ Data\ DB.enabled = Y to prepare the database. 

17.1.2 Running the Full Watch list 

To run the full watch list, follow these steps: 

1. Set the following properties in the watchlist-management.properties file: 
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▪ phase.DJW\ -\ Download.enabled = Y. 

▪ phase.DJW\ -\ Download\ Delta.enabled = N. 

▪ phase.DJW\ -\ Stage\ reference\ lists.enabled = Y. 

▪ phase.*.export.*.ind_table_name = FSI_WATCHLIST_INDIVIDUAL.  

▪ phase.*.export.*.entities_table_name = FSI_WATCHLIST_ENTITIES. 

▪ phase.Import1_Full_DB.enabled = Y 

▪ phase.Import2_Full_DB.enabled = Y 

▪ phase.Import3_Full_DB.enabled = Y 

2. Set the following properties in the transaction-screening.properties file: 

▪ phase.DJW\ -\ Load\ without\ filtering.enabled = N 

▪ phase.DJW\ -\ Load\ without\ filtering\ DB.enabled = Y 

▪ phase.DJW\ -\ Load\ with\ filtering\ (Part\ 1).enabled = N 

▪ phase.DJW\ -\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled = Y 

▪ phase.DJW\ -\ Load\ with\ filtering\ (Part\ 2).enabled = Y 

3. Set the following properties in the transaction-screening-batch.properties file: 

▪ phase.DJW\ -\ Load\ without\ filtering.enabled = N 

▪ phase.DJW\ -\ Load\ without\ filtering\ DB.enabled = Y 

▪ phase.DJW\ -\ Load\ with\ filtering\ (Part\ 1).enabled = N 

▪ phase.DJW\ -\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled = Y 

▪ phase.DJW\ -\ Load\ with\ filtering\ (Part\ 2).enabled = Y 

17.1.3 Running the Delta Watch List 

To run the delta watch list, set the following properties in the watchlist-management.properties 

file: 

▪ phase.DJW\ -\ Download.enabled = N. 

▪ phase.DJW\ -\ Download\ Delta.enabled = Y. 

▪ phase.DJW\ -\ Stage\ reference\ lists.enabled = Y. 

▪ Set phase.*.export.*.ind_table_name = FSI_WATCHLIST_DELTA_INDIVIDUAL. 

▪ Set phase.*.export.*.entities_table_name = 

FSI_WATCHLIST_DELTA_ENTITIES. 

▪ phase.Import1_Full_DB.enabled = N 

▪ phase.Import2_Full_DB.enabled = N 

▪ phase.Import3_Full_DB.enabled = N 

▪ phase.Import1_Delta_DB.enabled = Y 

▪ phase.Import2_Delta_DB.enabled = Y 



APPENDIX E: DELTA WATCH LIST CONFIGURATIONS 

DELTA WATCH LIST CONFIGURATIONS FOR THE WORLD-CHECK WATCH LIST 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  194 

▪ phase.Import3_Delta_DB.enabled = Y 

17.1.4 Merging the Delta Watch List to the Full Watch List 

To merge the delta watch list with the full watch list, set the following properties in the watchlist-

management.properties file: 

• phase.Delta\ Merge.enabled = Y. 

• phase.Linked\ Profiles.enabled = Y. 

•  

17.2 Delta Watch List Configurations for the World-Check 
Watch List 

 

NOTE These configurations are performed when you do not want to 
download the full watch list, and only want to download the 
delta watch list. This helps to reduce the download time and is 
not part of the screening process. 

 

Customer Screening recommends that you always use the full watch list during the screening process. 

Due to the clustering strategy, which is implemented in the screening process, you must not download the 

delta watch list. There are certain cases in which you must download the delta watch list files, for example, 

if the full watch list files are not yet available for download or if you want to save time. 

Customers who download the delta watch list files must first download the full watch list files and then 

download the delta watch list files. The delta watch list is then merged into the full watch list before 

screening. 

The following image shows the information flow for the delta watch list: 

 

Figure 98: Flow for Delta Watch List 
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When you download the full watch list, data is stored in the FSI_WC_WATCHLIST_INDIVIDUALS and 

FSI_WC_WATCHLIST_ENTITIES tables. When you download the delta watch list, data is first stored in the 

FSI_WC_WATCHLIST_DELTA_IND and FSI_WC_WATCHLIST_DELTA_ENT tables. Then the data is merged 

into the main table. For more information, see Merging the Delta Watch List to the Full Watch List. 

 

NOTE You must always run the full watch list files before you run the 
delta watch list files. The full watch list files must be 
downloaded if, for example, the download of the delta watch 
list files has failed for multiple days. You can also run the full 
watch list once every week to ensure that the complete data 
has been processed. 

 

17.2.1 Configurations for the Full and Delta Watch Lists 

The following configurations must be done for both full and delta watch list updates in the watchlist-

management.properties run profile. The run profile is available in the 

<domain_name>/edq/oedq.local.home/runprofiles/ directory when you log in to the WinSCP 

server. 

• Set phase.Initialise\ staged\ data.enabled = N to disable the .jmp file updates. 

• Set phase.Initialise\ staged\ data\ DB.enabled = Y to initialize the database. 

• Set phase.Initilize\ Prepared\ List\ Data.enabled = N to disable the .jmp file 

updates. 

• Set phase.Initilize\ Prepared\ List\ Data\ DB.enabled = Y to prepare the database. 

• Set phase.All\ List\ Entity\ and\ Individual\ reference\ data.enabled = N. 

• Set phase.All\ List\ Entity\ and\ Individual\ reference\ data\ DB.enabled = 

Y. 

• Set phase.DQ-Watchlist\ BIC\ Extraction\ JSON\ Preparation.enabled = N. 

• Set phase.DQ-Watchlist\ BIC\ Extraction\ JSON\ Preparation\ DB.enabled = Y. 

17.2.2 Running the Full Watch list 

To run the full watch list, follow these steps: 

1. Set the following properties in the watchlist-management - TF.properties file: 

▪ phase.WC\ -\ Download.enabled = Y. 

▪ phase.WC\ -\ Download\ Delta.enabled = N. 

▪ phase.WC\ -\ Stage\ reference\ lists.enabled = Y. 

▪ phase.*.export.*.wc_ind_table_name=FSI_WC_WATCHLIST_INDIVIDUAL 

▪ phase.*.export.*.wc_entities_table_name=FSI_WC_WATCHLIST_ENTITIES 

▪ phase.Import1_Full_DB.enabled = Y 



APPENDIX E: DELTA WATCH LIST CONFIGURATIONS 

DELTA WATCH LIST CONFIGURATIONS FOR THE WORLD-CHECK WATCH LIST 

OFS TRANSACTION FILTERING ADMINISTRATION GUIDE  |  196 

▪ phase.Import2_Full_DB.enabled = Y 

▪ phase.Import3_Full_DB.enabled = Y 

To run the full watch list without filtering, set the following properties: 

▪ phase.WC\ -\ Prepare\ without\ filtering.enabled = N 

▪ phase.WC\ -\ Prepare\ without\ filtering\ Full\ DB.enabled = Y 

To run the full watch list with filtering, set the following properties: 

▪ phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 1).enabled = N 

▪ phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 2).enabled = N 

▪ phase.WC\ -\ Prepare\ with\ filtering\ Full\ DB.enabled = Y 

To run the full watch list without filtering, set the following properties: 

▪ phase.WC\ -\ Load\ without\ filtering.enabled = N 

▪ phase.WC\ -\ Load\ without\ filtering\ DB.enabled = Y 

To run the full watch list with filtering, set the following properties: 

▪ phase.WC\ -\ Load\ with\ filtering\ (Part\ 1).enabled = N 

▪ phase.WC\ -\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled = Y 

▪ phase.WC\ -\ Load\ with\ filtering\ (Part\ 2).enabled = Y 

2. Set the following properties in the transaction-screening.properties file: 

▪ phase.WC\ -\ Load\ without\ filtering.enabled = N 

▪ phase.WC\ -\ Load\ without\ filtering\ DB.enabled = Y 

▪ phase.WC\ -\ Load\ with\ filtering\ (Part\ 1).enabled = N 

▪ phase.WC\ -\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled = Y 

▪ phase.WC\ -\ Load\ with\ filtering\ (Part\ 2).enabled = Y 

3. Set the following properties in the transaction-screening-batch.properties file: 

▪ phase.WC\ -\ Load\ without\ filtering.enabled = N 

▪ phase.WC \ -\ Load\ without\ filtering\ DB.enabled = Y 

▪ phase.WC \ -\ Load\ with\ filtering\ (Part\ 1).enabled = N 

▪ phase.WC \ -\ Load\ with\ filtering\ (Part\ 1)\ DB.enabled = Y 

▪ phase.WC \ -\ Load\ with\ filtering\ (Part\ 2).enabled = Y 

17.2.3 Running the Delta Watch List 

To run the delta watch list, follow these steps: 

1. Set the following properties in the watchlist-management - TF.properties file: 

▪ phase.WC\ -\ Download.enabled = N. 

▪ phase.WC\ -\ Download\ Delta.enabled = Y. 

▪ phase.WC\ -\ Stage\ reference\ lists.enabled = Y. 
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▪ phase.*.export.*.wc_ind_table_name=FSI_WC_WATCHLIST_DELTA_IND 

▪ phase.*.export.*.wc_entities_table_name=FSI_WC_WATCHLIST_DELTA_ENT 

▪ phase.Import1_Full_DB.enabled = N 

▪ phase.Import2_Full_DB.enabled = N 

▪ phase.Import3_Full_DB.enabled = N 

▪ phase.Import1_Delta_DB.enabled = Y 

▪ phase.Import2_Delta_DB.enabled = Y 

▪ phase.Import3_Delta_DB.enabled = Y 

2. To run the delta watch list without filtering, set the following properties: 

▪ phase.WC\ -\ Prepare\ without\ filtering.enabled = N 

▪ set phase.WC\ -\ Prepare\ without\ filtering\ Delta\ DB.enabled = Y 

To run the delta watch list with filtering, set the following properties: 

▪ phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 1).enabled = N 

▪ phase.WC\ -\ Prepare\ with\ filtering\ (Part\ 2).enabled = N 

▪ phase.WC\ -\ Prepare\ with\ filtering\ Delta\ DB.enabled = Y 

17.2.4 Merging the Delta Watch List to the Full Watch List 

To merge the delta watch list with the full watch list, set the following properties in the watchlist-

management.properties file: 

• phase.WC\Delta\ Merge.enabled = Y. 

• phase.WC\Linked\ Profiles.enabled = Y. 

•  
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18 Appendix F: Message Categories and Message Types 

A user of the Transaction Filtering application can use the following message categories:  

• SWIFT Message Types 

• ISO20022 Message Types 

• Fedwire Message Types 

• US NACHA Message Types 

Each message category has different message types defined. The following tables list the message categories 

and associated message types. 

For the SWIFT message category, the message types numbered 1 to 8 are the ready-to-use message types 

that you can use after you log in. The other message types must be imported manually using the SWIFT 

migration utility. For information on the steps, see Running the SWIFT Migration Utility. 

 

   Table 50: SWIFT Message Types 

1 MT101 2 MT103 3 MT110 4 MT202 

5 MT202COV 6 MT700 7 MT701 8 MT707 

9 MT103STP 10 MT105 11 MT111 12 MT112 

13 MT190 14 MT191 15 MT192 16 MT195 

17 MT196 18 MT198 19 MT199 20 MT210 

21 MT290 22 MT291 23 MT292 24 MT295 

25 MT296 26 MT298 27 MT299 28 MT300 

29 MT399 30 MT400 31 MT410 32 MT412 

33 MT455 34 MT490 35 MT491 36 MT492 

37 MT495 38 MT496 39 MT498 40 MT499 

41 MT536 42 MT590 43 MT591 44 MT599 

45 MT606 46 MT607 47 MT671 48 MT699 

49 MT711 50 MT720 51 MT721 52 MT730 

53 MT734 54 MT742 55 MT747 56 MT750 

57 MT752 58 MT754 59 MT756 60 MT760 

61 MT767 62 MT768 63 MT769 64 MT790 

65 MT791 66 MT795 67 MT796 68 MT798 

69 MT799 70 MT802 71 MT895 72 MT896 
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73 MT899 74 MT910 75 MT950 76 MT995 

77 MT996 78 MT998 79 MT999 80 MT107 

81 MT204 82 MT416 83 MT420 84 MT430 

85 MT516 86 MT526 87 MT581 88 MT592 

89 MT608 90 MT705 91 MT710 92 MT792 

93 MT801 94 MT900 95 MT320 96 MT604 

97 MT605 98 MT732 99 MT740 100 MT940 

101 MT942 102 MT985 103 MT986 104 MT890 

105 MT895 106 MT896 107 MT899 108 MT900 

109 MT910 110 MT940 111 MT942 112 MT950 

113 MT985 114 MT986 115 MT995 116 MT996 

117 MT998 118 MT999 119 MT102 120 MT104 

121 MT200 122 MT203 123 MT456 124 MT708 

125 MT321 126 MT540 127 MT541 128 MT542 

129 MT543 130 MT544 131 MT305 132 MT396 

133 MT568 134 MT596 135 MT696 136 MT304 

137 MT350 138 MT362 139 MT566   

 

For the ISO20022 message category, the following message types are the ready-to-use message types that 

you can use after you log in. 

 

   Table 51: ISO20022 Message Types 

1 Pain.001.001.08 2 Pacs.008.001.07 3 pacs.008.001.08 4 pacs.009.001.08 

5 pacs.004.001.09 6 pacs.010.001.03 7 camt.050.001.05 8 Pain.001.001.09 

   

For the Fedwire message category, the following message types are the ready-to-use message types that you 

can use after you log in.  

 

 Table 52: Fedwire Message Types 

1 FDCTR1000 2 FDBTR1002 3 FDCTR1002 4 FDCTR1008 

5 FDCTR1600 6 FDCTR1602 7 FDBTR1600 8 FDBTR1000 
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9 FDBTR1008 10 FDBTR1602 11 FDCTP1000 12 FDCTP1002 

13 FDCTP1008 14 FDCTP1600 15 FDCTP1602 16 FDCKS1600 

17 FDCKS1602 18 FDDEP1600 19 FDDEP1602 20 FDFFR1600 

21 FDFFR1602 22 FDFFS1600 23 FDFFS1602 24 FDDRC1031 

25 FDDRW1032 26 FDSVC1090 27 FDDRB1631 28 FDDRW1632 

29 FDSVC1690 30 FDSVC1590 31 FDBTR1500 32 FDDRC1531 

33 FDDRW1532       

   

For the US NACHA message category, the following message types are the ready-to-use message types that 

you can use after you log in. 

    

Table 53: US NACHA Message Types 

1 IAT 2 CTX 3 BOC 4 RCK 

5 POP 6 WEB 7 CCD 8 TEL 

9 PPD 10 ARC 11 CIE   
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19 Appendix G: JMS Cluster Environment Creation 
JMS servers act as management containers for the queues and topics in JMS modules that are targeted 
to them. JMS cluster servers in a domain work together to provide a more scalable and reliable 
application platform than a single server. A cluster appears to its clients as a single server, but it is a 
group of servers acting as one. 

 

19.1 JMS Server Creation 

To create the JMS server and file store, follow these steps: 

1. Log in to Weblogic Console. 

2. From the Domain Structure Select Services, select JMS Servers from Messaging drop-down and 

click New in the JMS Servers table. 

Figure 97: Weblogic Console Page 

 

3. In the JMS Server Properties page, enter the JMS server name in the Name field and click Next. 

Figure 98: JMS Server Properties Page 

 

 

 

 

 

 

 
4. In the Select Persistent Store page, select Create a New Store from Persistent Store Field to 

specify a persistent store for the new JMS server. 
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Figure 99: Select Persistent Store page 

 

5. In the Select a store type page, select File Store from Type Field and click Next. 

Figure 100: Select a store type page 

 

6. In the File Store Properties page, enter the new file store name in the Name field and click 
Next. 

Figure 101: File Store Properties page 
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7. In the JMS File Store Targets page, select a target as one of the named server from Target Field 

drop down and Click Finish. 

 

Figure 102: JMS File Store Targets page 

 

 

NOTE You will receive a message on successful activation and file store 
creation. 

8. Select the same target name from the JMS File Store Targets page in the Target field drop down 
in the Select targets page and click Finish to create the JMS server and its respective file store. 

Figure 103: Select targets page 

 

NOTE Only applications deployed to the selected servers or clusters 
can use the JMS file store. 

When you target all or part of the cluster, the Administration 

Console initiates a two-phase deployment. Two-phase deploy- 

ment ensures that if the deployment fails for one active server, it 

fails for all active servers. 
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19.2 JMS Module Creation 

JMS system resources are configured and stored as modules similar to standard Java EE modules. Such 
resources include queues, topics, connection factories, templates, destination keys, quota, distributed 
queues, distributed topics, and JMS store-and-forward (SAF) parameters. You can administratively 
configure and manage JMS system modules as global system resources. 

To Create the JMS Module, follow these steps: 

9. Log in to Weblogic Console. 

10. From Domain Structure Select Services, select JMS Modules from Messaging drop down and click 

New in the JMS Modules table. 

Figure 104: Weblogic Console Page 

 

11. In the Create JMS System Module page, enter the JMS Module name as RTI in the Name field 
and click Next. 

Figure 105: Create JMS System Module Page 
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12. Select Servers or Clusters on which you deploy the JMS system module from the Targets Field. 

The cluster name that was created in step 6.1.8 will be listed under IPECluster. 

 

Figure 106: Create JMS System Module 

 

13. To add resources to the JMS system module and to create JMS modules check the box in the 

Create JMS System Module page and click Finish. 

 

NOTE You can configure the targets later if required. 

NOTE You will receive message on successful creation of the JWS 
module. 
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Figure 107: Create JMS System Module 

 

 

19.3 Sub-Deployment Creation 

A sub-deployment is a mechanism by which JMS module resources such as queues, topics, and 
connection factories are grouped and targeted to a server resource such as JMS servers, server 
instances or cluster. 

To create the Sub-Deployment follow these steps: 

14. Log in to Weblogic Console. 

15. From Domain Structure Select Services and select JMS Modules from Messaging drop-
down. The Summary of JMS Module page is displayed. 

16. Select RTI from JMS Modules table. The Settings for RTI page is displayed. 

17. Select subdeployments from the tabs. 

18. Enter the sub-deployment name as RTI Deploy in subdeployment table and click Next. 

Figure 108: Settings for RTI 
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19. Select the JMS servers created previously from the JMS Servers list from the Settings for RTI 

Deploy page and click Save. The RTI sub-deployment is created. 

 

Figure 109: Settings for RTI Deploy Page 

 

 

 

19.4 Distributed Queues Creation 

Depending on the type of resources selected you are prompted to enter the basic information for 
creating the resources. For target resources like stand-alone queues and topics, connection factories, 
distributed queues and topics, foreign servers, and JMS SAF destinations you can proceed to target 
pages for selecting appropriate server targets. You can associate target resources with sub- 
deployments, which is an advanced mechanism for grouping JMS module resources and the members 
to server resources. To create the Distribute Queues, follow these steps: 

 

NOTE Queues must be created as per the IPE Configuration guide with the same 
naming convention. 

20. Log in to Weblogic Console. 

21. From Domain Structure Select Services and select JMS Modules from Messaging drop- 
down. The Summary of JMS Module page is displayed. 

22. Select RTI from JMS Modules table. The Settings for RTI page is displayed. 

23. Click New and select Distribute Queue from Create a New a JMS System Module Resource 

page. 

NOTE You can configure the targets later if required. 
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Figure 110: Create a New JMS System Module Resource page 

 

24. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE 
configuration guide and click Next. 

Figure 111:  JMS Distributed Destination Properties page 

 

25. Select Advanced Targeting. 
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Figure 112: Create a New JMS System Module Resource page 

 

26. Select RTISubdeploy from the subdeployment field drop down list and select the JMS servers 

created. Click Finish. The distributed queue is successfully created. 

 

Figure 113: Create a New JMS System Module Resource page 

 

NOTE You will receive message on successful creation of the JWS 
distributed queue. 
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19.5 Distributed Topic Creation 

To create the Distribute Topic, follow these steps: 

 

NOTE Topics must be created as per the IPE Configuration guide with the same 
naming convention. 

27. Log in to Weblogic Console. 

28. From Domain Structure Select Services and select JMS Modules from Messaging drop-
down. The Summary of JMS Module page is displayed. 

29. Select RTI from JMS Modules table. The Settings for RTI page is displayed. 

30. Click New and select Distribute Topic from Create a New a JMS System Module Resource 

page. 

Figure 114: Create a New JMS System Module Resource page 

 

31. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE 
configuration guide and click Next. 
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Figure 115:  JMS Distributed Destination Properties page 

 

 

32. Select Advanced Targeting. 

Figure 116: Create a New JMS System Module Resource page 

 

 

33. Select RTISubdeploy from the subdeployment field drop down list and select the JMS servers 

created. Click Finish. The distributed topic is successfully created. 

 

NOTE You will receive message on successful creation of the JWS 
distributed topic. 
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Figure 117: Create a New JMS System Module Resource page 

 

 

 

19.6 Connection Factory Creation 

To create the Connection Factory, follow these steps: 

 

NOTE Connections must be created as per the IPE Configuration guide with the 
same naming convention. 

34. Log in to Weblogic Console. 

35. From Domain Structure Select Services and select JMS Modules from Messaging drop-
down. The Summary of JMS Module page is displayed. 

36. Select RTI from JMS Modules table. The Settings for RTI page is displayed. 

37. Click New and select Connection Factory from Create a New a JMS System Module Resource 

page. 
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Figure 118: Create a New JMS System Module Resource page 

 

 

38. Enter the name and JDNI name in Name and JNDI Name Fields respectively as per the IPE 
configuration guide and click Next. 

Figure 119: Connection Factory Properties page 

 

 

39. Select Advanced Targeting. 
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Figure 120: Create a New JMS System Module Resource page 

 

 

40. Select the JMS Servers created and Click Finish. The Connection Factory is successfully created. 

 

 

NOTE You will receive message on successful creation of the JWS 
Connection Factory. 
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Send Us Your Comments 

Oracle welcomes your comments and suggestions on the quality and usefulness of this publication. Your 

input is an important part of the information used for revision. 

• Did you find any errors? 

• Is the information clearly presented? 

• Do you need more information? If so, where? 

• Are the examples correct? Do you need more examples? 

• What features did you like most about this manual? 

If you find any errors or have any other suggestions for improvement, indicate the title and part number 

of the documentation along with the chapter/section/page number (if available) and contact Oracle 

Support. 

Before sending us your comments, you might like to ensure that you have the latest version of the 

document wherein any of your concerns have already been addressed. You can access the My Oracle 

Support site which has all the revised/recently released documents. 



 

 

 

 


